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1. Descriptions on esCalc 

1.1 An Introduction to esCalc Function 

esCalc is a data calculation utility capable of various tabular data analyses and calculations 

for: 

 Spreadsheet making 

 Analysis and structuring calculation of tabular data 

 Analyze and calculate various kinds of derived data, such as year-on-year growth, balance 

calculation, and share distribution. 

 Conduct various transformations on data in the table, such as sorting, filtering, grouping, 

multi-level merge, and multi-level join. 

1.2 esCalc Installation and Running 

After getting installer package, execute the installer, and install it step by step according to 

tips: 

1) Run installer 

2) According to the tips, click the Next Step in order, and accept license agreement 

3) Select the installation path and click Install. 

4) Complete the installation.  

If you are relatively familiar with the running environment of Java, and JDK 1.5 version 

above is already installed in the local, it is also advisable to select the esCalc install package that 

does not automatically install JDK for the installation. In the installation, it is necessary to fill in 

the directory where JDK of the native machine is located. 

1.3 Interface Layout and Calculation Cellset File Creation 

Run the main program of esCalc, and click the creation button  to create the 

calculation cellset file. To create the calculation cellset file, you can also click item New in File 

of the menu bar or use shortcut key [Ctrl+N]. 
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In the window on the left, the area on the right is the Cellset section, and in the section is the 

active calculation cellset file. The area on the left is the Hierarchy section, which displays the 

level structure of the calculation cellset file. In the window on the right, the area in the upper part 

is the Cell Property section where you can view or set various properties of the cells. The area in 

the lower part is the Selected Cells Statistic section which can automatically conduct statistics on 

selected cells, including total, mean value, counting, and you can also add custom statistic 

expression in this section. 

In the upmost part of esCalc interface is the menu bar, toolbar and edit bar. 

 

In the menu bar, you can select the corresponding menu item in various menu groups and 

execute various operations. In the toolbar, you can directly click button to execute some common 

operations. In the edit bar, you can view or modify the cell value or expression of the cell selected 

in the calculation cellset. 

2. Basic Operation and Sequence 

2.1 Data Type of esCalc 

In esCalc, there are the following several types of data: 

 Number   including integer, real number, and real numbers expressed in scientific 

notation 

– 54, 43.31, -4.45E13, and 3% 

 Boolean  including true/false 

– true, false 

 String  Use double quotation marks to include it when using expression, where, 

escape character uses \, and escape code adopts the rule of JAVA. Do not use quotation marks 

Hierarchy 

section 
Cellset section 

Cell Property section 

Selected Cells Statistic section 

Menu bar 

Tool bar 

Edit bar 
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when directly defining string constant. 

– abcd 

– ="Georgia\tDelaware" 

When using expression to define string, the escape rule is the same as that of JAVA. Please 

refer to the reference manual. 

 Date/time written into the forms of yyyy-mm-dd and hh:mm:ss 

– 2010-1-3, 23 : 04 : 23 

It is advisable to click menu item Option in Tool in the menu bar, and in Environment tab, 

set up time/date data format, and character code. 

 

 

2.2 Defining Cell Value Directly 

In esCalc, cell value can be defined directly in the cell. Such cell is called constant cell. 

When the type of data in the cells is defined as Default, the data in the cells is resolved as 

various data types, and the unrecognized cell strings are interpreted as string. 

0 1  A B C D E 

1-  1 54 43.31 -4.45E3 3%  

 1 2 abcd raqsoft    

2  3 2010-1-3 23:04:23    

 

In the cells above, the cell values in cells A1, B1, C1, and D1 are all interpreted as real 

number, where C1 is the real number using the format of scientific notation, and D1 is percentage. 

The cell values in A2 and B2 are interpreted as string. The cell value in A3 is interpreted as date, 

and the cell value in B3 is interpreted as time. 
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– Attention: The writing of 3% is valid when defining cell value directly, but it is changed 

to 0.03 after it is input. The use of "%" as percent is allowed only in constant cell, and it 

cannot be used in any expression. 

 

In the cell, it is also possible to use some constant reserved words, and pay attention to the 

fact that the case is sensitive! 

 null   null value, the cell value of the empty cell is also represented by the null. 

 true   True 

 false   Fasle 

 

The processing of the data or expression in the cell has nothing to do with the setting of 

calculation cellset level. The remaining examples in this chapter shall no long demonstrate 

calculation cellset level. 

String constant cell 

String constant cell is the cell whose cell string is beginning with the single quotation mark '. 

This mark indicates it is a constant cell whose cell value is string, and the cell value is the string 

consisting of string after single quotation mark. At this time, all characters after the single 

quotation mark are resolved as string, and it is unnecessary to add characters such as quotation 

mark and escape character. 

– 'abc\d  string abc\d 

– '1234.5  string 1234.5 

 A B C D E 

1 'C:\files\gex '=,>,<,+... '1234.5 1234.5  

 

When the string in the string constant cell is input, the cell value automatically calculates 

the actual cell value and displays it in the cell. That is to say, the ' before the string is eliminated, 

but, the cell expression strings displayed in the edit bar on the upper part and in the Cell 

Property section on the right are still the actually set cell strings beginning with '. 

In the example above, A1, B1 and C1 are all string constant cells. By using string constant 

cell, it is very convenient to define string containing special character or beginning with equality 

sign, and string consisting of numbers. The cell values in D1 and C1 are displayed the same in 

their appearances, but the value in C1 is string, while the value in D1 is of real number type. 

2.3 Expressions in esCalc 

If the cell string in the cell begins with "=", the string after the equality sign is resolved as 

expression, and the cell value in the cell is just the calculation result of this expression. Such cell 

is called calculation cell, and cell expression in the cell is called formula.  

– ="Hello"+" world" 

– =1+4*3-6 
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 A B C D E 

1 ="A"+" dog" =1+4*3-6    

The calculation cell is indicated with a cyan small triangle in the lower part on the right. 

When the   expression is input, it will be calculated and the result will be displayed in the cell. 

After expressions are input, the cell values of A1 and B1 are displayed as the calculation results of 

expressions:  

 A B C D E 

1 A dog 7    

When calculation cell is selected, the cell value is displayed in the cellset, namely, the 

calculation result. The edit bar in the upper part displays the formula of the calculation cell. 

Both the cell value and formula of the calculation can be modified. Select the cell, and then 

click in the cell, or click in the edit bar, you can edit the cell value and the formula respectively. 

You can also check or modify the formula and cell value of the cell in the Cell Property section 

on the right side. 

2.4 Cell Reference 

After the cell in the calculation cellset is defined as a constant cell or a calculation cell, there 

is a cell value in the cell. Just like using parameter, by using the cell name directly in the 

expression, the value of this cell can be referenced. 

– =A1*5 

– =A1/B1+3*B1 

 A B C D E 

1 4 2    

2 =A1*5 =A1/B1+3*B1    

 

After being input, the expressions in A2 and B2 can conduct calculation, and the result is as 

follows: 

 A B C D E 

1 4 2    

2 20 8.0    

 

2.5 Instant Calculation Cell and Related Calculation Cell 

In the Section 2.3 Expression in esCalc, we have described the situation of using expression 

in calculation cell. Here let us get to know the detailed method of using the calculation cell in 

esCalc. 

2.5.1 Instant Calculation Cell and Related calculation cell 

If esCalc is in auto calculate mode, when the formula is written into the cell, the cell instantly 

calculates out this cell value, so this kind of calculation cell is called instant calculation cell. The 
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instant calculation cell only calculates once and obtains the cell value when the expression is input, 

and after this, unless the expression is modified, otherwise it does not calculate again. If the cell 

value involved in the calculation is modified, the cell value of the instant calculation cell does not 

change. 

Corresponding to the instant calculation cell, there is another kind of calculation cell that is 

called related calculation cell, and its difference lies in the fact that the formula begins with two 

equality signs ==. That is to say, the formula in the related calculation cell begins with one = more 

than the instant calculation cell does. In addition to conducting calculations after the formula is 

input or modified, the related calculation cell also conducts linked processing when the referenced 

cell's value is modified, and calculates again. 

 A B C D E 

1 4 2    

2 =A1+3*B1 ==A1+3*B1    

A2 is an instant calculation cell and B2 is a related calculation cell. When the cell is a related 

calculation cell, a small blue triangle appears at the right lower corner of the cell. When the 

formulae in A2 and B2 are set up, the cell values in the two cells are both calculated out and 

displayed in the cells: 

 A B C D E 

1 4 2    

2 10 10    

At this time, if the cell value in A1 or B1 is changed, the cell values of A2 and B2 generate 

different results: 

 A B C D E 

1 5 4    

2 10 17    

Only the value in related calculation cell B2 changes with the change of the cell value of the 

referenced cell, the cell value in instant calculation cell A2 still remains the original value. 

The cell value of the related calculation cell is automatically calculated and modification is 

unnecessary under normal conditions. Once the cell value of the cell is modified, this cell 

automatically changes into an instant calculation cell. 

2.5.2 Setting up Auto Calculate Mode 

In esCalc, click Tool > Option in the menu bar to set up automatic calculation cellset or not 

in the option setting window.  
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If auto calculate property is selected, when calculation cellset is edited in esCalc, the instant 

calculation cell will automatically complete the calculation after the formula is set up or modified, 

and the related calculation cell calculates automatically when the formula is set up or modified, 

and the related cell is modified. 

If auto calculate property is not selected, when calculation cellset is edited in esCalc, the 

instant calculation cell and the related calculation cell do not conduct calculation automatically, 

and both conduct calculations when calculation is performed. To perform calculation, click Data > 

Recalculate cellset in the menu bar, or press shortcut key F9. Unless the expression is modified, 

otherwise the instant calculation cell calculates only once while the related calculation cell 

recalculates every time when calculation is performed. 

2.6 Cell Property in esCalc 

Cell in the calculation cellset has a lot of properties, and you can view and set them up in the 

Cell Property section on the right side. 
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Cell property mainly includes three sections: cell value setting, cell appearance, paragraph 

setting. In cell value setting section, you can view and modify properties such as cell expression, 

cell value, data type, display format, hyperlink, and validation expression. In cell appearance 

section, you can view and modify properties such as cell foreground color, background color, font 

name, font color, font size, and font style. In paragraph setting section, you can view and modify 

properties of paragraphs in the cell such as whether to automatically wrap text, horizontal 

alignment, vertical alignment, and indent. 

2.7 Getting to Know Sequence 

2.7.1 What is sequence? 

The ordered set consisting of some data is called sequence, and the data forming the 

sequence is called its members. The sequence is equivalent to array in high-level language, but 

data types of its members are not required to be the same. 

No. 1 2 3 4 5 … 

Member 

     

… 

The members in the sequence are ordered, and it is possible to find a certain member 

according to its sequence number. Pay attention to the fact that sequence number of a sequence 

starts from 1. 

2.7.2 Generate a sequence 

 Constant sequence 

Including members with [  ] can express constant sequence. In defining constant sequence 

directly, when there is string member in the sequence, do not write double quotation marks, and 

Integer 

1 

Boolean 

true 

Charact

"abc" 

Floating 

1.1234 

Date 

2010-4-12 
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esCalc will process it after the completion of the input. 

– [1,3,4] 

– [a,b,c] 

– [s,2011-3-14,54] 

 Using expression to define sequence 

The format in using the expression to define sequence directly is similar to that of constant 

sequence, and in the expression, you can reference the cell and use colon to express a stretch of   

cells. When getting the values of a stretch of cells, esCalc will follow the sequence rule of first the 

row then the column. 

– =[1,A4,B1:B4,C1:C3] 

0 1  A B C D E 

1-  1 1 2 3   

 1 2 4 5 6   

 2 3 7 8 9   

 3 4 [a,b,c] [s,2011-03-14,54]   

2  5 =[1,A4,B1:B4,C1:C3] 

 

After the expression in A5 cell is calculated, the cell value is: 

[1,[a,b,c],2,5,8,[s,2011-03-14,54],3,6,9].  

The processing of the data or expression in the cell has nothing to do with the setting of 

calculation cellset level. The remaining examples in this chapter shall no long demonstrate 

calculation cellset level, and no long mark the calculation cell. 

 Empty Sequence 

The sequence that has no member is called Empty Sequence, which can be defined directly 

with []. 

 A B C D E 

1 []     

 2.8 Commonly Used Converge Computation of Sequence 

In esCalc, for n sequence A, the following several converge computation functions are often 

used to calculate the total number, summation and mean value. 

 A.count() 

 Calculate the number of non-null members in A, and is different from A.len().  

 A.sum() 

Sum up all members in A.  

 A.avg() 

Calculate the mean value of members in A, and do not count members whose value is null in 

the calculation.  

 A.min() 
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Calculate minimum value. 

 A.max() 

Calculate maximum value.  

 A B C D E 

1 [null,4,6,,2,4,,5]    

2 =A1.count() =A1.sum() =A1.avg() =A1.min() =A1.max() 

The expression in A2 calculates the non-null members of sequence A1, and the cell value is 5 

after the calculation. 

The expression in B2 returns the sum of the members in sequence A1, and the cell value is 21 

after the calculation. 

The expression in C2 calculates the mean value of the members in sequence A1, and the cell 

value is 4.2 after the calculation. It can be seen from the result that avg function does not count 

null value in the sequence when calculating the mean value of the sequence. 

The expression in D2 calculates the minimum value of the members in sequence A1, and the 

cell value is 2 after the calculation. It can be seen from the result that min function does not count 

null value in the sequence when calculating the minimum value of the sequence. 

The expression in E2 calculates the maximum value of the members in sequence A1, and the 

cell value is 6 after the calculation. Max function does not count null value in the sequence either 

when calculating the mean value of the sequence.  

For detailed use of sequence, see 10 Advanced Application of Sequence. 

 3. Structure of Calculation cellset 

The data stored in the calculation cellset of esCalc is not a simple 2-dimensional table, and 

instead it is correlated with hierarchical structure. 

3.1 Row Sequence Number and Level 

In esCalc calculation cellset, each row has a sequence number and level, and you can find 

these properties in hierarchy section.  

Open calculation cellset esCalc03_1.gex as follows:  
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0 1 2  A B C D E 

1-   1 Employee     

 1  2 Department Finance    

 2-  3 Female     

  1 4 Ashley Wilson NY 11000   

 3-  5 Male     

  1 6 Daniel Davis FL 10000   

 4  7 Count 2 Sum 21000  

 1  8 Department R&D    

 2  9 Female     

 3-  10 Male     

  1 11 Justin Smith TX 7000   

  1 12 Jacob Davis TX 16000   

 4  13 Count 2 Sum 23000  

2   14 Count 4 Sum 44000  

 

In this calculation cellset, you can see that each row has a number in the hierarchy section, 

and this number is the sequence number of this row. For example, the sequence number of Row 2 

and Row 6 is 1, and the sequence number of Row 9 is 2, and so on. 

 

In a cellset, the column where the sequence number of each row is located in the hierarchy 

section is the level of this row. The first row on the top of the hierarchy section marks the level 

number of each level. In the example above, the sequence numbers of Row 2 and Row 9 are in 

Column 2 of the hierarchy section, and the level is 1, the sequence number of Row 6 is in Column 

3 of the hierarchy section, and the level is 2. In the calculation cellset, the level of Row 1 is 

forever 0, and the sequence number is always 1. 

 

3.2 Master Row, Band and Slave Row 

In the calculation cellset, the row whose sequence number is 1 is called master row. 

The area from a master row of k level till meeting the first master row whose level is also k, 

or any row whose level is smaller than k is called band. Master row of k level which is the first 

row in the band is also called band master row, and level k of the band master row is just the 

level of this band. Obviously, in the band, there is only one k level master row. 

In a band whose level is k, sometimes there are multiple rows whose level is k, all rows in 

band whose level is k are all called slave row in the band, and the master row in the band is also 

one of the slave rows.  

Reopen calculation cellset esCalc03_1.gex, and let us get to know the master row, band and 

slave row.  
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0 1 2  A B C D E 

1-   1 Employee     

 1  2 Department Finance    

 2-  3 Female     

  1 4 Ashley Wilson NY 11000   

 3-  5 Male     

  1 6 Daniel Davis FL 10000   

 4  7 Count 2 Sum 21000  

 1  8 Department R&D    

 2  9 Female     

 3-  10 Male     

  1 11 Justin Smith TX 7000   

  1 12 Jacob Davis TX 16000   

 4  13 Count 2 Sum 23000  

2   14 Count 4 Sum 44000  

 

In this calculation cellset, the master rows whose sequence number is 1 are Rows 1, 2, 4, 6, 8, 

11, and 12. Where, the level of Row 1 is 0, the level of Row 2, and 8 is 1, and the level of Rows 4, 

6, 11, and 12 is 2. 

Let us have a look at the concept of band: Row 2 is the master row whose level is 1, search 

downward from it till Row 8, which is also the master row whose level is 1. Before it, the area 

from Row 2 to Row 7 is a band, namely, the area marked by the red box, and the level of this band 

is 1. Row 8 is also a master row whose level is 1, search downward from it, and Row 14 is the row 

whose level is 0. Pay attention to the fact that Row 14 is not a master row, and before it, the area 

from Row 8 to Row 13 is also a band whose level is 1, which is marked with a blue box. 

Additionally, Rows 4, 6, 11, and 12 themselves can also be seen as a band that has only one row 

and whose level is 2. In fact, any calculation cellset can be seen, on the whole, as a band whose 

level is 0. 

Within the band within the red box, Rows 2, 3, 5, and 7 are just slave rows in this band. In 

the same way, in the band within the blue box, Rows 8, 9, 10, and 13 are just slave rows in the 

band. 

3.3 Parent row, Sub row and Descendent Row 

In the calculation cellset, the first row of k-1 level on the upper part of k level row is called 

the parent row of k level row. Obviously, row at level 0 has no parent row, and other rows all 

have a parent row. Similar to this, rows at level k+1 under and adjacent to k level row are all sub 

rows of k level row, and a row in the calculation cellset may not necessary have a sub row. Under 

k level row, rows whose consecutive level is bigger than k is called the descendent rows of k level 

row. 

Re-open calculation cellset esCalc03_1.gex, and let us get to know the parent row, sub row 

and descendent row.  
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0 1 2  A B C D E 

1-   1 Employee     

 1  2 Department Finance    

 2-  3 Female     

  1 4 Ashley Wilson NY 11000   

 3-  5 Male     

  1 6 Daniel Davis FL 10000   

 4  7 Count 2 Sum 21000  

 1  8 Department R&D    

 2  9 Female     

 3-  10 Male     

  1 11 Justin Smith TX 7000   

  1 12 Jacob Davis TX 16000   

 4  13 Count 2 Sum 23000  

2   14 Count 4 Sum 44000  

The parent row of Row 4 is Row 3, the parent row of Row 6 is Row 5, the parent row of 

Rows 11 and 12 is Row 10, and the parent row of Rows 2, 3, 5, 7, 8, 9, 10, and 13 is Row 1. Pay 

attention to the fact that a parent row is not necessarily a master row and can also be a slave row. 

In fact, the sub row corresponds to the parent row. The sub row of Row 3 is Row 4, the sub 

row of Row 5 is Row 6, the sub row of Row 10 is Rows 11, and 12, and the sub row of Row 1 is 

Rows 2, 3, 5, 7, 8, 9, 10, and 13. It can be seen that a sub row can also be a master row or a slave 

row. A row in the calculation cellset may not necessarily have a sub row. For example, Row 9 does 

not have any sub row. 

Now let us have a look at descendent row. The descendent row of Row 3 is Row 4, the 

descendent row of Row 5 is Row 6, the descendent rows of Row 10 are Rows 11, and 12. The 

descendent rows of Row 1 are Row 2 to Row 13, so it can seen that in the calculation cellset, the 

descendent rows of a certain row not only include all its sub rows but also include the descendent 

rows of all sub rows. 

3.4 Homostructure and Homo 

In the calculation cellset, two rows have the same number of slave rows of sub rows, and 

these sub rows also correspondingly meet such homostructure conditions, the two rows are said to 

be isomorphic, or they area called homostructure rows.  

In the calculation cellset, two rows have the same level and sequence number, and their 

parent rows meet such homo conditions, the two rows are said to be homo, or they are called 

homorows. 

Open calculation cellset esCalc03_2.gex, and let us get to know the concepts of 

homostructure and homo through this calculation cellset:  
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0 1 2 3  A B C D E 

1-    1 Movie 

2-    2 2011 Grosses     

 1   3 PARAMOUNT  Total Gross 863,421,774 

 2-   4 Ranking PG-13  Ranking Total 739,944,167 

  1-  5 Paramount    

   1 6 Transformers: Dark of the Moon  352,390,543 

  2  7    Total 352,390,543 

  1-  8 Paramount & Dreamworks    

   1 9 Mission: Impossible - Ghost Protocol  206,523,000 

   1 10 Thor  181,030,624 

  2  11    Total 387,553,624 

 3-   12 Ranking PG  Ranking Total 123,477,607 

  1  13 Rango  123,477,607 

 1   14 SONY / COLUMBIA  Total Gross 222,975,001 

 2   15 Ranking PG-13  Ranking Total  

 3-   16 Ranking PG  Ranking Total 222,975,001 

  1  17 The Smurfs  142,614,158 

  1  18 Zookeeper  80,360,843 

3-    19 2012 Grosses     

 1   20 Beauty and the Beast (3D)   

 2   21 Distributor BUENA VISTA    

 3   22 Ranking G    

 1   23 The Devil Inside   

 2   24 Distributor PARAMOUNT    

 3   25 Ranking R    

Let us get to know what homostructure is. In this example, the number of the slave rows of 

the sub rows of Row 12 and Row 16 is both 1, so they are isomorphic. Two isomorphic rows are 

required to have the same number of slave rows of their sub rows, but are not required to have the 

same number of sub rows.  

Isomorphic rows do not necessarily have the same level. For example, for Row 5 and Row 12 

though their hierarchies are respectively 2 and 1, they are isomorphic. 

For Row 4 and Row 12, the number of slave rows of their sub rows is different, so they are 

not isomorphic. 

Now let us have a look at Row 2 and Row 19, the number of slave rows of their sub rows is 

both 3, but none of the sub rows of Row 19 has sub row. The number of slave row of the sub 

rows is 0, they and the sub row of Row 2 do not meet the homostructure condition, so Row 2 and 

Row 19 are not isomorphic. 

 

Now let us have a look at the concept of homo. For Rows 7 and 11, their levels are both 2, 
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their sequence numbers are both 2, and their parent rows are the same, which is Row 4, so Rows 7 

and 11 are homo. 

 

For rows 13, 17, and 18, their levels are both 2, their sequence numbers are 1; their parent 

rows are respectively Row 12 and Row 16, and the levels of these two rows are both 1, their 

sequence numbers are both 3, and their parent rows are the same, which is Row 2, and meet the 

homo conditions. So, Row 12 and Row 16 are homorows, and Row 13, 17, and 18 are homo. In 

the same way, we can confirm Rows 6, 9, and 10 are also homo. 

 

Now look at Row 12 and Row 22, their levels are both 1, their sequence numbers are both 3, 

but their parent rows are respectively Row 2 and Row 19. For Row 2 and Row 19, their levels are 

0, but their sequence numbers are different, which are respectively 2 and 3. So Row 2 and Row 19 

are not homo and Row 12 and Row 22 are not homo either. 

There is no repeated sequence number in Level 0, so it is impossible for any row in Level 0 

to have a homorow.  

A homorow must be homostructure, and in executing operations such as adding/deleting sub 

row or adding/deleting slave row, all homorows are executed synchronously. Even if sub rows of a 

certain row in the homorow are all deleted, the structure of sub row is preserved.  

3.5 Homoband 

The bands of homo master rows are called homobands. 
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0 1 2 3  A B C D E 

1-    1 Movie 

2-    2 2011 Grosses     

 1   3 PARAMOUNT  Total Gross 863,421,774 

 2-   4 Ranking PG-13  Ranking Total 739,944,167 

  1-  5 Paramount    

   1 6 Transformers: Dark of the Moon  352,390,543 

  2  7    Total 352,390,543 

  1-  8 Paramount & Dreamworks    

   1 9 Mission: Impossible - Ghost Protocol  206,523,000 

   1 10 Thor  181,030,624 

  2  11    Total 387,553,624 

 3-   12 Ranking PG  Ranking Total 123,477,607 

  1  13 Rango  123,477,607 

 1   14 SONY / COLUMBIA  Total Gross 222,975,001 

 2   15 Ranking PG-13  Ranking Total  

 3-   16 Ranking PG  Ranking Total 222,975,001 

  1  17 The Smurfs  142,614,158 

  1  18 Zookeeper  80,360,843 

3-    19 2012 Grosses     

 1   20 Beauty and the Beast (3D)   

 2   21 Distributor BUENA VISTA    

 3   22 Ranking G    

 1   23 The Devil Inside   

 2   24 Distributor PARAMOUNT    

 3   25 Ranking R    

 

We use the calculation cellset example seen in Section 3.4 Homostructure and Homo to get 

to know homoband. Homo master row needs to constitute homorow and must be the master row 

whose  sequence number is 1. The homo master row in this example includes the following 

several groups: Rows 3, and 14, Rows 20, and 23, Rows 5, and 8, Rows 13, 17, and 18, and Rows 

6, 9, and 10. So, the bands respectively taking Rows 3, and 14 as band master row are homobands 

(marked in red box) whose level is 1. The bands respectively taking Rows 20, and 23 as band 

master row are homobands (marked in blue box) whose level is also 1. The bands respectively 

taking Rows 5, and 8 as band master row are homobands (marked in orange box) whose level is 2.  

 

None of Rows 13, 17, and 18 has sub row and they can be seen as a single-row homoband 

whose level is 2. Similar to this, Rows 6, 9, and 10 can be seen as a single-row homoband whose 

level is 3. 
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3.6 Row and Level Where Cell is Located 

The row where the cell is located refers to the row occupied by the cell. If the cell is a 

merged cell and crosses multiple rows, then row is subject to the first row. 

The level of a cell is the level of the row where the cell is located. 

Open calculation cellset esCalc03_3.gex, and let us get to know the row where the cell is 

located and the level of the cell through this calculation cellset example:  

0 1 2  A B C D E 

1-   1 Tennis Semifinals Result 

 1  2 Robert Foster vs. Ryan Norris  

 2-  3  Foster Norris  

1:3 

  1 4 1 7 6 7:5 

  1 5 2 2 6  

  1 6 3 6 7 5:7 

  1 7 4 4 6  

 1  8 Nicholas Davis vs. Andy Moore  

 2-  9  Davis Moore  

3:2 

  1 10 1 6 3  

  1 11 2 3 6  

  1 12 3 6 7 4:7 

  1 13 4 6 1  

  1 14 5 7 5  

 

If the cell is not a merged cell, it is very easy to determine the row and level where the cell is 

located. Cell B5, for example, is located in Row 5, and the level of B5 is just the level of Row 5: 

Level 2. 

If the cell is a merged cell, but is located in the same row, it is also very easy to determine the 

row and level where the cell is located. For example, the merged cell consisting of the four cells 

A8:D8, the row where this merged cell is located is Row 8, and the level of this merged cell is the 

level of Row 8: Level 1. 

If the cell is the merged cell that crosses multiple rows, the row where the cell is located is 

subject to the first row of the merged cell, and the level of the merged cell is also determined by 

this row.  The merged cell consisting of the five cells E3: E7 is an example in case. The row 

where this merged cell is located is just the first row where it is located: Row 3, and its level is just 

the level of the row where it is located: Level 1. 

3.7 Merged Cell  

In esCalc, it is allowed to use merged cell, and the row where the merged cell is located is 

subject to the first row. 

In the merged cell, the cell that is located in its first row and first column is called the first 

cell of the merged cell. A merged cell can be expressed with its first cell. 
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In setting merged cell, it is necessary to select one block of cells, then click button  in 

the toolbar, or click Edit > Merge in the menu bar, and you can set up merged cell, Click it again 

and then you can dismantle the merged cell. 

In Section 3.6 Row and Level Where Cell is located, we have seen the use of merged cell in 

esCalc, below we still use the example in the preceding subchapter and get to know the use of 

merged cell in esCalc and the requirement for merged cell. 

0 1 2  A B C D E 

1-   1 Tennis Semifinals Result 

 1  2 Robert Foster vs. Ryan Norris  

 2-  3  Foster Norris  

1:3 

  1 4 1 7 6 7:5 

  1 5 2 2 6  

  1 6 3 6 7 5:7 

  1 7 4 4 6  

 1  8 Nicholas Davis vs. Andy Moore  

 2-  9  Davis Moore  

3:2 

  1 10 1 6 3  

  1 11 2 3 6  

  1 12 3 6 7 4:7 

  1 13 4 6 1  

  1 14 5 7 5  

 

In esCalc, it is impossible to combine at discretion a block of adjacent cells into a merged cell. 

Merged cell in the calculation cellset is limited by structure, and it must meet two conditions: 

firstly, the merged cell must be contained in the band of the row where it is located; and 

secondly, all the homocells of any cell in the merged cell in this band must also be in this 

merged cell.  

Such requirement has not any influence on the merged cells that are completely located in 

the same row, such as the merged cells A1, A2, and A8.  

For merged cell located in multiple rows, we take Merged Cell E3 as example to understand 

the requirements for merged cell. 

Let us look at the first requirement. The row where Merged Cell E3 is located is Row 3, the 

band where Row 3 is located is the band whose master row is Row 2, from Row 2 to Row 7. So, 

Merged Cell E3 must be contained in the area from Row 2 to Row 7. Therefore, if try to combine 

together cells from E3 to E8, as E8 exceeds the band where Row 3 is located, it is impossible to 

merge them. If try to combine together the cells from E2 to E7, as the row where E2 is located 

Row 2, and the band where Row 2 is located is also from Row 2 to Row 7, such merge operation 

is allowed. 

Now look at the second requirement. In the band where Merged Cell E3 is located, namely, 

from Row 2 to Row 7, four rows (Rows 4, 5, 6, and 7) are homorows, and in these four rows, as 
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long as one row is contained in the merged cell, all four homorows are contained in the merged 

cell. That is to say, the four rows 4, 5, 6, and 7 are homorows, either none of them is in the merged 

cell, or all of them are in the merged cell. For example, merged cell E3 in the example contains E3: 

E7, and also contains the four homorows 4, 5, 6, and 7 at the same time. Similar to this, if try to 

combine A3 to A7 is also allowable. If you try to combine the two cells E1 and E2, as the four 

homocells 4, 5, 6, and 7 are not in the merged cell, it is allowed. If you try to combine the three 

cells E3, E4, and E5, as Rows 4, and 5 are included in the merged cell, but Rows 6 and 7 of their 

homorows are not included in the merged cell, it is illegal to combine them. 

If you try to combine the four cells E4, E5, E6, and E7, what is the result? The row where the 

merged cell is located at this time is Row 4 instead of Row 3 or Row 2, and the band where Row 4 

is located is the Level 2 band consisting of only the single Row 4, so, the three cells, E5, E6, and 

E7 all go beyond the scope of the band, and it is impossible to combine them. 

In esCalc, the set up of merged cell is the same in the homobands. When merged cell is set up 

in a certain band, merged cell is also set up automatically and synchronously in all the homobands 

of this band. 

3.8 Homocell 

Cells that are located in homorows and on the same column are called homocell. Homocell 

default uses the same expression and property, and in setting cell property and formula in esCalc, 

the properties and expressions in all homocells are all modified at the same time.  

In homoband, cell that is the same level as band level must have homocell. 

Open calculation cellset esCalc03_4.gex, and let us get to learn the concept of homocell 

through this calculation cellset example:  

0 1 2  A B C D E F 

1   1 Gymnastics 

2-   2 Name Vault UnevenBars BalanceBeam Floor Total 

 1-  3 Group A 

  1 4 Silva 14.175 14.175 14.175 14.35 56.875 

  1 5 Pavlova 15.275 14.525 15.975 15.05 60.825 

  1 6 Kaslin 15.35 14.275 14.425 13.95 58.0 

 2  7  44.8 42.975 44.575 43.35 175.7 

 1-  8 Group B 

  1 9 Downie 15.025 15.625 14.7 14.1 59.45 

  1 10 Bonora 14.85 14.625 15.1 14.375 58.95 

 2  11  29.875 30.25 29.8 28.475 118.4 

3   12 Sum 74.675 73.225 74.375 71.825 294.1 

 

In this calculation cellset example, Rows 3, and 8 are homorows, Rows 4, 5, 6, 9, and 10 are 

homorows, Rows 7, and 11 are homorows. In homorows, the cells located on the same column are 

homocells. For example, the rows where cells B4, B5, B6, B9, and B10 are located are homorow, 

and they are all on the Column 2, so they are homocells. For another example, the rows where the 
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two merged cells A3 and A8 are located are also homorows, and they are both on column 1, so 

they are also homocell. 

 

Another example, for the example in Section 3.7 Merged cell, Row 3 and Row 9 where 

Merged Cells E3 and E9 are located are homorow, and they are both on column 5, so they are also 

homocells.  

 

In esCalc, homocells by default have the same cell properties such as foreground color, 

background color, font name, font size, font style, font color, and display format. When these 

properties in a certain cell are modified, the corresponding properties of all the cells are modified 

at the same time. 

The cell values of homocells can be different respectively, but if expression is used in 

homocell, expressions in all homocells are also modified at the same time similar to property. The 

expressions in the homocells are not completely the same and they automatically adjust according 

to the positions where they are located. For example, in the example above, the formula 

calculating the total score in F4 is =B4 + C4 + D4 + E4, and when the formula in F4 is input, all 

its homocells, namely, expressions in F5, F6, F9, and F10 are also set up, and adjust automatically 

according to the positions where they are located. In the formula in F4, the cell called in this row 

is changed into the cell in the corresponding homorow. The formula in F6 is =B6 + C6 + D6 + E6, 

and the formula in F9 is =B9 + C9 + D9 + E9. 

It is necessary to pay attention to the fact that only formulae in homocells are automatically 

set up and adjust in setting. For example, B7 and C7 are not homocell, so they are not set up 

synchronously and they cannot adjust automatically. 

 

At this time, if a certain property in the homocell is modified, such as the background color 

of A6, the background color in its homocells A4, A5, A9, and A10 also changes together with it. 

Similar to this, if modify the formula in F10 as = int (B10 + C10 + D10 + E10), the formula in its 

homocells F4, F5, F6, and F9 also changes with it, and automatically adjusts at the same time. 

After the modification, the calculation cellset is as shown below: 
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0 1 2  A B C D E F 

1   1 Gymnastics 

2-   2 Name Vault UnevenBars BalanceBeam Floor Total 

 1-  3 Group A 

  1 4 Silva 14.175 14.175 14.175 14.35 56 

  1 5 Pavlova 15.275 14.525 15.975 15.05 60 

  1 6 Kaslin 15.35 14.275 14.425 13.95 58 

 2  7  44.8 42.975 44.575 43.35 175.7 

 1-  8 Group B 

  1 9 Downie 15.025 15.625 14.7 14.1 59 

  1 10 Bonora 14.85 14.625 15.1 14.375 58 

 2  11  29.875 30.25 29.8 28.475 118.4 

3   12 Sum 74.675 73.225 74.375 71.825 294.1 

3.9 Master Cell 

In the band, a certain cell on the slave row can be set up as master cell. The master cell is 

distinctive in the band, and the master cells in the homobands must be homocells. In esCalc, if 

master cell is set up on a certain slave row, all its homocells are automatically set up as master cell 

synchronously. 

If you want to set a certain cell as master cell, or to cancel a certain master cell setup, right 

click on the cell, and just click Set/Cancel master cell button under option Cell on the right-click 

menu.  

  

As mentioned in Section 3.8 Homocell, we have modified the homocells of the calculation 
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cellset. Alternatively, we can also directly open calculation cellset esCalc03_5.gex, and then set 

cells A3 and F6 as master cells. After the setup, the result is as follows: 

0 1 2  A B C D E F 

1   1 Gymnastics 

2-   2 Name Vault UnevenBars BalanceBeam Floor Total 

 1-  3 Group A 

  1 4 Silva 14.175 14.175 14.175 14.35 56 

  1 5 Pavlova 15.275 14.525 15.975 15.05 60 

  1 6 Kaslin 15.35 14.275 14.425 13.95 58 

 2  7  44.8 42.975 44.575 43.35 175.7 

 1-  8 Group B 

  1 9 Downie 15.025 15.625 14.7 14.1 59 

  1 10 Bonora 14.85 14.625 15.1 14.375 58 

 2  11  29.875 30.25 29.8 28.475 118.4 

3   12 Sum 74.675 73.225 74.375 71.825 294.1 

When a certain cell is set as master cell, a small triangle appears at the left upper corner of 

the cell and serves as a mark, and the color of the small triangle is different according to the 

different colors of the cell. It can be found, when a certain cell is set as the master cell, and all its 

homocells are also set as master cell. For example, A8 is also set as master cell together with A3, 

and F4, F5, F9, and F10 are all set as master cell together with F6. 

 

The master cell is distinctive within the band where the slave row is located, that is to say, 

there is only one master cell in the same row. 

If you try to set A5 as master cell, the result after the setup is as follows: 

0 1 2  A B C D E F 

1   1 Gymnastics 

2-   2 Name Vault UnevenBars BalanceBeam Floor Total 

 1-  3 Group A 

  1 4 Silva 14.175 14.175 14.175 14.35 56 

  1 5 Pavlova 15.275 14.525 15.975 15.05 60 

  1 6 Kaslin 15.35 14.275 14.425 13.95 58 

 2  7  44.8 42.975 44.575 43.35 175.7 

 1-  8 Group B 

  1 9 Downie 15.025 15.625 14.7 14.1 59 

  1 10 Bonora 14.85 14.625 15.1 14.375 58 

 2  11  29.875 30.25 29.8 28.475 118.4 

3   12 Sum 74.675 73.225 74.375 71.825 294.1 

As we can see, in Rows 4, 5, 6, 9, and 10 of the homorows, Homocells A4, A5, A6, A9, and 

A10 are set as new master cells, and new master cells replace old master cells. 
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When related data operations such as alignment, grouping, joining, and union are conducted 

in the cellset, it is necessary to use master cell, on which detailed descriptions will given in the 

corresponding subchapter of Section 8. Data Operations.  

4. Functions Relating to Structure 

4.1 Automatic Adjustment of Expression 

In esCalc, if formula is set up in the cell, formula is set up in all the homocells of this cell at 

the same time, and adjusted automatically. If using an expression in a certain property of the cell, 

the same procedure will also be conducted. 

Below we open calculation cellset esCalc04_1.gex to get to know how esCalc conducts 

automatic paste adjustment on the expression. 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6 28 Sat. 29 20  

  1-  7 week 5     

   1 8 29 Sun. 30 18  

   1 9 30 Mon. 24 16  

   1 10 31 Tues. 25 12  

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 11  

   1 14 2 Thur. 38 16  

3    15      

The above calculation cellset conducts statistics on the maximum temperature and minimum 

temperature of each day within a period in a certain area and demonstrates them by levels 

according to different months and weeks. 

Now if formula = C5 - D5 is written into E5 cell to calculate the temperature difference of 

each day, the formula is also set up in its homocells E6, E8, E9, E10, E13, and E14, and adjusted 

automatically. The calculation result is as follows:  
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21 7 

   1 6 28 Sat. 29 20 9 

  1-  7 week 5     

   1 8 29 Sun. 30 18 12 

   1 9 30 Mon. 24 16 8 

   1 10 31 Tues. 25 12 13 

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 11 24 

   1 14 2 Thur. 38 16 22 

3    15      

 

Click these cells that own formula, and in the cell property list on the right side, you can see 

the result after adjustment of the formula in each cell. For example, in E6, the formula is = C6-D6, 

in E9, the formula is = C9-D9, and in E13, the formula is = C13-D13. As we can see, in the 

formula, if the cell in the same row is referenced, the formula of its homocell, is adjusted 

accordingly to reference the cell within the respective row they are located. 

 

If the formula written in E6 is modified as = C6-C5, to calculate the difference value of the 

maximum temperature compare with the preceding day, what is the result? 

The expression in the homocells of E6 also adjusts automatically, and after calculation, the 

result is as follows:  
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21 28 

   1 6 28 Sat. 29 20 1 

  1-  7 week 5     

   1 8 29 Sun. 30 18 1 

   1 9 30 Mon. 24 16 -6 

   1 10 31 Tues. 25 12 1 

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 11 10 

   1 14 2 Thur. 38 16 3 

3    15      

Click to enter each calculation cell, and check their formulae. It can be found that, cell C5 

in the preceding homorow of E6 is referenced in the formula of E6. So, this cell referenced in 

the expression of its homocells is correspondingly changed into the cell in their respective 

preceding homorow. For example, the formula in E9 is = C9 - C8, and the formula in E13 is = 

C13-C10, and so on. What calls for attention is that, the formula in E5 is = C5 - #REF!. This is 

because Row 5 is the first row of its all homorows, and it is impossible to find the corresponding 

“preceding homorow”, so it is impossible to find the corresponding cell. When cell cannot be 

found, the cell value is processed according to null value or 0. 

If the formula written in E5 is modified as = left (A1, 4) + right (A4, 2), what is the result? 

After calculation, the result is as follows: 



 
 

27 

 

RAQSOFT 
Innovation Makes Progress http://www.raqsoft.com 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21 Temp 4 

   1 6 28 Sat. 29 20 Temp 4 

  1-  7 week 5     

   1 8 29 Sun. 30 18 Temp 5 

   1 9 30 Mon. 24 16 Temp 5 

   1 10 31 Tues. 25 12 Temp 5 

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 11 Temp 1 

   1 14 2 Thur. 38 16 Temp 1 

3    15      

By viewing the formula in the homocells of E5, you can find, in the formula, cells of various 

master rows referenced, such as A4, will be automatically adjusted to the corresponding cells in 

respective master rows at the corresponding levels of various homocells. If the level of the cell 

referenced is 0, such as A1, it does not change. For example, in A6, the formula is = left (A1, 4) + 

right (A4, 2), in A9, the formula is = left (A1, 4) + right (A7, 2), and in A13, the formula is = left 

(A1, 4) + right (A12, 2), and so on. 

4.2 [a:b] and {a:b} 

[a: b] and {a:b} are both functions commonly used to generate a cell sequence, where 

parameters a and b are both cell names. 

 [a:b] 

Cell value sequence from a to b. 

 {a:b} 

Cell value sequence that is from a to b and is homo with a . 

 

Using [a:b] to generate a cell sequence has nothing to do with the hierarchy structure of the 

cellset. It is a different matter, {a:b} only returns a sequence of values from homocells of a. In 

other words, this procedure is to select the homocells of a from a cell sequence based on [a: b], 

and construct a sequence of the cell values. 

Open calculation cellset esCalc04_2.gex and let us have a look at these two functions through 

this calculation cellset example: 
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0 1 2  A B C D 

1-   1 Turnover 

 1-  2 Quarter 1 

 

 

  1 3 January 13400.50  

  1 4 February 13425.00  

  1 5 March 12800.00  

 1-  6 Quarter 2 

 

 

  1 7 April 15333.40  

  1 8 May 11800.80  

2   9 Count   

3   10 =[A5:B7] 

4   11 ={A5:B7} 

 

After the calculation is done, the cell value in A10 is sequence ["March", 12800,"Quarter 2", 

null," April", 15333.4]. Through the calculation result, it can be seen that the returned cell value 

sequence contains all the cells within the area from A5 to B7, which form a sequence according to 

the order of row first and column second. The cell values of merged cell only exist in the first cell. 

For example, the cell value in A6 is "Quarter 2", but B6 is not the first cell of the merged cell, and 

the cell value is null. 

The cell value in A11 is sequence ["March", "April"], so it can be seen that within the 

designated area, only the cell values of A5 and its homocells: A5 and A7 are selected out to form 

sequence. 

4.3 Row Number and Homocell Sequence Number 

 row() 

Return the row number of the current row. 

We use the calculation cellset example in Section 4.2 [a: b] and {a: b}, add the formula = 

row() in D2 and D3, and after it is input, the same formula is set up in all the homocells of D2 and 

D3. At the same time, change the formula in A10 and A11 into = row(), and the result is as 

follows:  
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0 1 2  A B C D 

1-   1 Turnover 

 1-  2 Quarter 1 

 

2 

  1 3 January 13400.50 3 

  1 4 February 13425.00 4 

  1 5 March 12800.00 5 

 1-  6 Quarter 2 

 

6 

  1 7 April 15333.40 7 

  1 8 May 11800.80 8 

2   9 Count   

3   10 10 

4   11 11 

From the results in various calculation cells, it can be seen that, in using row () function, you 

can return the row number where the cell is located, and is not related to cell level, and column 

where the cell is located. 

 ord(A, L) 

Homocell sequence number of A within the scope of Level L and L is only a level. 

In order to get to know this function, we modify the above calculation cellset, delete the 

formula of the cells in Column D, and add a vacant slave row. Set the formula = ord (A7, A2) in 

A10, set formula = ord (A7, A1) in A11, and set formula = ord (A7) in A12, and then add formula 

= ord (D3) in D3 and the result is as follows: 

0 1 2  A B C D 

1-   1 Turnover 

 1-  2 Quarter 1 

 

 

  1 3 January 13400.50 1 

  1 4 February 13425.00 2 

  1 5 March 12800.00 3 

 1-  6 Quarter 2 

 

 

  1 7 April 15333.40 1 

  1 8 May 11800.80 2 

2   9 Count   

3   10 1 

4   11 4 

5   12 4 

Let us analyze the calculation process of the formula = ord (A7, A2) in A10. The level of Cell 

A2 is 1. When doing the calculation, firstly find the band master row where Cell A7 is located and 

whose level is 1, namely, Row 6, and then calculate out the homocell sequence number of the row 

where A7 is located in this band. Within the band where Row 6 is the master row, the homocells of 

A7 are A7 and A8, and the homocell sequence number of A7 in it is 1, so the calculation result in 

A10 is 1. 
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Then look at the formula = ord (A7, A1) in A11. The level of Cell A1 is 0, the band master 

row where A7 is located and whose level is 0 is Row 1. Within the band where Row 1 is master 

row, the homocells of A7 are A3, A4, A5, A7, A8, and the homocell sequence number of A7 in it is 

4, so the calculation result in A11 is 4. 

 

Then look at the formula = ord (A7) in A12. When L in function parameter is omitted, the 

calculation is done according to the level of the current cell. The level of A12 is the same as that of 

A1, which is 0, so the calculation result in A12 is the same as that in A11, which is also 4. In the 

function, A cannot be omitted. 

 

Finally look at D3 and the situation in its homocells. The formula in D3 is = ord (D3), when 

the formula in D3 is set up, the formulae in its homocells D4, D5, D7, and D8 are also 

automatically set up, and adjust automatically. For example, in D4, the formula = ord (D4), and in 

D8, the formula is ord (D8)…. When A in ord (A,L) function is in the current row and L is omitted, 

L is not set as the level of the current row, instead it is set as the parent row of the current row, 

which is different from the case in A12. That is to say, when A is in the current row, ord (A) is the 

homocell sequence number of the current cell in the parent row band. The parent row of D3, D4, 

and D5 is Row 2, and their homocell sequence number are respectively 1, 2, and 3 while the 

parent row of D7 and D8 is Row 6, and their homocell sequence numbers are 1, and 2. 

 

What calls for attention is that, in the calculation, L is not necessarily within the band where 

A is located (such as the expression in A10), and in the calculation of ord (A, L) function, 

calculation is done according to the level of L only. 

In the calculation of ord (A, L) function, A must have the parent row that equals the level of L. 

when L is the same as A level, it is impossible to calculate out the result, and error occurs.  

 num (A, L) 

It is the number of homobands of A with the scope of Level L, and L is only level.  

In order to get to know this function, we modify the above calculation cellset. In A10, set the 

formula = num (A7, A2), in A11, set formula = num (A7, A1), in A12, set formula = num (A6), 

and in D3, add formula = num (D3), so the result is as follows:  
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0 1 2  A B C D 

1-   1 Turnover 

 1-  2 Quarter 1 

 

 

  1 3 January 13400.50 3 

  1 4 February 13425.00 3 

  1 5 March 12800.00 3 

 1-  6 Quarter 2 

 

 

  1 7 April 15333.40 2 

  1 8 May 11800.80 2 

2   9 Count   

3   10 2 

4   11 5 

5   12 2 

 

Let us analyze the calculation process of the formula = num (A7, A2) in A10. The level of 

Cell A2 is 1, and when we do the calculation, firstly find the band master row where Cell A7 is 

located and whose level is 1, namely, Row 6, and then calculate out the number of homobands of 

the row where A7 is located in this band, namely, number of the homocells of A7. Within the band 

where Row 6 is the master row, the homocells of A7 are A7 and A8, and the total is 2, so the 

calculation result in A10 is 2. 

 

Then look at the formula = num (A7, A1) in A11. The level of Cell A1 is 0, the band master 

row where A7 is located and whose level is 0 is Row 1. Within the band where Row 1 is master 

row, the homocells of A7 are A3, A4, A5, A7, A8, and the total is 5, so the calculation result in 

A11 is 5.  

 

Then look at the formula = num (A6) in A12. When L in function parameter is omitted, the 

calculation is done according to the level of the current cell. The level of A12 is 0, the 0 level 

master row of A6 is Row 1. In the band of Row1, the homocells of A6 are A2 and A6, with a total 

of 2, so the calculation result in A12 is 2. In the function, A cannot be omitted. 

 

Similar to the case in ord (A, L) function, in num (A, L) when A is in the current row and L is 

omitted, L is not set as the level of current row, instead it is set as the parent row of the current row. 

That is to say, when A is in the current row, num (A) is the total number of the homocells of the 

current cell in the parent row band. The parent row of D3, D4, and D5 is Row 2, and the total 

number of their homocells is 3, while the parent row of D7 and D8 is Row 6, and the total number 

of their homocells is 2.  

 

In doing the calculation, in the same way, L is not required to be in the band where A is 

located, and in the calculation of num (A,L) function, calculation is done only according to the 

level of L. In the calculation of num (A, L) function, A must have the parent row that equals the 

level of L. When L is the same as A level, it is impossible to calculate out the result, and error 
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occurs. 

4.4 Abbreviation of Homocell Sequence Number 

 # 

It is equivalent to ord (current cell), namely, the homocell sequence number of the current 

cell in parent row band. 

 ## 

It is equivalent to num (current cell), namely, the homocell number of the current cell in 

parent row band.  

We use the calculation cellset example in Section 4.3 Row Number and Homocell 

SequenceNumber, set up formula =# in D2, and D3, append a new column, then set up formula 

=## in E2, and E3, or directly open calculation cellset esCalc04_3.gex to get to know these two 

functions. The calculation result is as follows: 

0 1 2  A B C D E 

1-   1 Turnover  

 1-  2 Quarter 1 

 

1 2 

  1 3 January 13400.50 1 3 

  1 4 February 13425.00 2 3 

  1 5 March 12800.00 3 3 

 1-  6 Quarter 2 

 

2 2 

  1 7 April 15333.40 1 2 

  1 8 May 11800.80 2 2 

2   9 Count    

3   10   

4   11   

5   12   

 

After the formula is set up in D2, D3, E2, and E3, the formula is also automatically set up in 

their homocells. In D2: D8 area, the formulae of all cells are all = #, return the homocell sequence 

numbers of their homocells in their respective parent row bands. In E2: E8 area, the formulae of 

all the cells are all =##, return the number of their homocells in their respective parent row bands. 

 L# 

It is equivalent to ord (current cell, L), namely, the homocell sequence number of the current 

cell within the scope of Level L. 

 L## 

It is equivalent to num (current cell, L), namely, the number of the homobands of the current 

cell within the scope of Level L. 

We still use the above calculation cellset example to get to know these two functions. 

Set up formula = A1# in D2, and D3, and set up formula = A1## in E2 and E3, and the 

calculation result is as follows: 
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0 1 2  A B C D E 

1-   1 Turnover  

 1-  2 Quarter 1 

 

1 2 

  1 3 January 13400.50 1 5 

  1 4 February 13425.00 2 5 

  1 5 March 12800.00 3 5 

 1-  6 Quarter 2 

 

2 2 

  1 7 April 15333.40 4 5 

  1 8 May 11800.80 5 5 

2   9 Count    

3   10   

4   11   

5   12   

After the formula is set up in D2, D3, E2, and E3, the formula is also automatically set up in 

their homocells. A1 is the 0-level row, in D2: D8 area, the formulae of all the cells are all = A1#, 

return homocell sequence numbers of their homocells in the 0-level band. In E2: E8 area, the 

formulae of all the cells are all = A1##, return the number of their homocells in the 0-level band. 

4.5 Using Level to Restrict Cell  

 A [L] 

It is A within the scope of L of the current cell, return null while out of range, and L is only 

level.  

 A 

It is equivalent to A [full-cellset], which is the usual cell reference, and directly returns cell 

value. 

 

Use A to reference the cell, and it is sure to return the referenced cell value. Use level to 

restrict the cell, use the reference in A [L] type, you can restrict the scope of A, and if A is not 

within the scope of Level L of the current cell, it will out of range, and returns null. 

Open calculation cellset esCalc04_4.gex, and through this calculation cellset example, and let 

us get to know the difference between usual cell call and using level to locate cell. 
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0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1-  3 California     

  1 4  1990 29760021   

  1 5  2000 33871648   

  1 6  2010 37253956   

 1-  7 Texas     

  1 8  1990 16986510   

  1 9  2000 20851820   

  1 10  2010 25145561   

 1-  11 New York     

  1 12  1990 17990455   

  1 13  2000 18976457   

  1 14  2010 19378102   

 

Listed in the calculation cellset are the populations of various states in recent three population 

censuses in 1990, 2000, and 2010, and now we want to calculate the number of growth as 

compared with the preceding data. To conduct comparison, set up formula = C14-C13 in D14, and 

set up formula = C14 - C13 [A11] in E14, after the calculation, the result is as follows: 

0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1-  3 California     

  1 4  1990 29760021 29760021 29760021 

  1 5  2000 33871648 4111627 4111627 

  1 6  2010 37253956 3382308 3382308 

 1-  7 Texas     

  1 8  1990 16986510 -20267446 16986510 

  1 9  2000 20851820 3865310 3865310 

  1 10  2010 25145561 4293741 4293741 

 1-  11 New York     

  1 12  1990 17990455 -7155106 17990455 

  1 13  2000 18976457 986002 986002 

  1 14  2010 19378102 401645 401645 

 

As Rows 4, 5, 6, 8, 9, 10, 12, 13, and 14 are all homorows, after the formula is set up in D14 

and E14, the formula is also automatically set up in their homocells and adjusts automatically. For 

example, in D13, the formula = C13 - C12, in E13, the formula = C13 - C12 [A11]; in D12, the 
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formula = C12-C10, in E12, the formula = C12 - C10 [A11]; in D8, the formula = C8 - C6, in E8, 

the formula = C8 - C6 [A7]; in D4, the formula = C4 - #REF!, in E4, the formula = C4 - 

#REF![A3], and so on. 

 

Let us look at Row 8, originally we prepare to calculate the population growth of Texas in 

1990. But in D8, the formula = C8 - C6, so it can be seen that, when expression adjusts, it merely 

calculates difference value with the “preceding population data”, namely, data C6 in the preceding 

homorow, even if this data does not belong to Texas. In this way, it becomes a comparison with 

the population data of California in 2010, and error occurs. While in E8, the formula = C8 - C6 

[A7], restrict the cell by level, restrict the data scope within the band where Row A7 is located. In 

this way, we define the data in the expression must be the data of Texas, avoiding the error 

appearing in adjusting. 

Restrict the cell by level, and we can get the right result in Column E. 

Use A [L], use level to restrict the cell, and we can process calculations such as comparing 

with the data of the preceding period. 

4.6 Homocell Set 

The set consisting of all the homocells of a designated cell within a certain area is called a 

homocell set.  

 L{A} 

It is the homocell set of A within the scope of Cell L.  

 

Open calculation cellset esCalc04_5.gex. This calculation cellset lists the information of 

some states and cities. Let us get to know the homocell set through this example: 

0 1 2 3  A B C D E 

1-    1 States and Cities 

 1-   2 A     

  1-  3  Alaska    

   1 4   Anchorage   

  1-  5  Arizona    

   1 6   Phoenix   

   1 7   Tucson   

 1-   8 C     

  1-  9  California    

   1 10   Los Angeles   

   1 11   San Diego   

   1 12   San Jose   

2    13 =B5{C4} =B9{C4} 

3    14 =A2{C10} 

 

After the calculation, A13's cell value is ["Phoenix","Tucson"], D13's cell value is ["Los 
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Angeles", "San Diego", "San Jose"], A14's cell value is ["Anchorage", "Phoenix" and "Tucson"]. 

Take the calculation in A14 as an example, the band where A2 is located includes the region from 

Row 2 to Row 7, and within this scope, the homocells of C10 are C4, C6, and C7, so the 

calculation result in A14 is the sequence consisting of the cell values of these three cells. In 

calculating homocell set L {A}, A can designate any homocell, which is not necessary within the 

scope of L. 

In function L {A}, L can be omitted. When L is omitted, the higher level between the level of 

the parent row of the current cell and the level of the parent row of A is automatically obtained. In 

the above cellset, if the formula = {C4} is set in D4, and the formula = {B3} is set in E4, the result 

after the calculation is as follows: 

0 1 2 3  A B C D E 

1-    1 States and Cities 

 1-   2 A     

  1-  3  Alaska    

   1 4   Anchorage ["Anchorage"] ["Alaska","Arizona"] 

  1-  5  Arizona    

   1 6   Phoenix ["Phoenix","Tucson"] ["Alaska","Arizona"] 

   1 7   Tucson ["Phoenix","Tucson"] ["Alaska","Arizona"] 

 1-   8 C     

  1-  9  California    

   1 10   Los Angeles ["Anchorage","Phoenix","Tucson"] ["California"] 

   1 11   San Diego ["Anchorage","Phoenix","Tucson"] ["California"] 

   1 12   San Jose ["Anchorage","Phoenix","Tucson"] ["California"] 

2    13 ["Phoenix","Tucson"] ["Los Angeles","San Diego","San Jose"] 

3    14 ["Anchorage","Phoenix","Tucson"] 

 

In the formulae of D4 and its homocell, the referenced cell equals its level, such as = {C4}, 

so L automatically obtains the parent row of the current cell, therefore, the calculation results in 

D4, D6, D7, D10, D11, and D12 are all the “cities of this state”. The referenced cells of the 

formulae in E4 and its homocell are in its parent row, such as = {B3}, therefore L obtains the 

parent row of cell A in the formula, and the calculation results in E4 and its homocell are “all the 

states under the list of the current letter”. 

 

In esCalc, it is also possible to obtain a certain homocell from the homocell set according to 

the offset of the homocell sequence number. 

 L[A;x] 

Within the scope of Cell L and in the homocell set of A, select the homocell whose homocell 

sequence number differs from that of the current cell by x. 

Open calculation cellset esCalc04_6.gex. Through the calculation cellset, we get to know the 

use of L [A; x]. Recorded in the cellset are the quarterly incomes of 2010 and 2011. Set the 

formula = A2 [B3;-1] in C3, set the formula = B3-A2 [B3;-1] in D3, and set the formula = 
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A1[A2;-1] [B3;0] in E3. After the calculation, the result is as follows: 

0 1 2  A B C D E 

1-   1 Quarterly Income 

 1-  2 2010    

  1 3 Quarter 1 50  50  

  1 4 Quarter 2 200 50 150  

  1 5 Quarter 3 400 200 200  

  1 6 Quarter 4 700 400 300  

 1-  7 2011    

  1 8 Quarter 1 800  800 50 

  1 9 Quarter 2 950 800 150 200 

  1 10 Quarter 3 1000 950 50 400 

  1 11 Quarter 4 1250 1000 250 700 

The formula = A2 [B3:-1] in C3 means, in the band of the same A2, the value of the homocell 

preceding B3, expresses the income of last quarter this year. The formula in D3 calculates the 

increment of the income this quarter over the preceding quarter of the same year.  

 

Now let us look at the formula = A1 [A2:-1] [B3:0] in E3. The first half part A1 [A2:-1] 

obtains the preceding homocell of the current A2, namely, the preceding year, and the later half 

part obtains from the band of the preceding year the homocell whose sequence number is the same 

as that of the current B3 homocell. The formula in D3 in this example expresses the income this 

quarter of the preceding year. Through the writing similar to the formula in D3, you can locate cell 

according the sequence numbers of multi-level homocells. 

 

In esCalc, you can also obtain the set within a certain scope in the homocell according to the 

offset of homocell sequence number. 

 L{A;a:b} 

Within the scope of Cell L and in the homocell set of A, it is a sequence that consists of all 

homocells of A from [A; a] to L [A; b]. If a is omitted, it starts from the first homocell of A within 

the scope of L, and if b is omitted, it ends at the last homocell of A within the scope of L.  

We modify calculation cellset used just now. Set the formula = A2{B3;:0}.sum() in C3, set 

the formula = A2{B3;:-1}.sum() in D3, and set the formula = A1{B3;1}.count() in E3. After the 

calculation, the result is as follows: 
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0 1 2  A B C D E 

1-   1 Quarterly Income 

 1-  2 2010    

  1 3 Quarter 1 50 50  7 

  1 4 Quarter 2 200 250 50 6 

  1 5 Quarter 3 400 650 250 5 

  1 6 Quarter 4 700 1350 650 4 

 1-  7 2011    

  1 8 Quarter 1 800 800  3 

  1 9 Quarter 2 950 1750 800 2 

  1 10 Quarter 3 1000 2750 1750 1 

  1 11 Quarter 4 1250 4000 2750 0 

The accumulated income within this year is calculated in C3, the accumulated income by the 

end of the preceding quarter of this year is calculated in D3, and the total number of the remaining 

homocells is calculated in E3. 

Use these two functions L [A; x], and L {A; a: b}, we can conveniently calculate the 

year-on-year growth, and calculate accumulated data. 

 

By using various sequence-functions on homocell set, you can complete various kinds of 

statistics calculation, such as A.sum (), A.avg (), A.max (), and so on. 

4.7 Page Setup and Calculation after Page Break 

In esCalc, after the calculation cellset file is calculated, you can conduct page break operation 

to facilitate print output.  

4.7.1 Print and Page Setup 

The calculation cellset in esCalc can conduct print output. In the menu bar, click File > Print, 

or use shortcut key Ctrl+P, the print preview window will pop up. When printing is conducted, 

the calculation cellset conducts page break. 

In the menu bar, click File > Page Setup, the Page setup window will pop up: 
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On Page page, you can conduct paper setup, margin setup, print zoom setup and print 

position setup. 

In page setup, you can select page type, or select Custom type to set page width and height 

(unit: mm) manually, and you can also select page direction as horizontal or vertical. 

 

 

On Page break setup page, you can select header row/column and footer row/column that 

will appear repeatedly while conducting page break. Header row can only the continuous 0-level 

row from the first row and footer row can only be the continuous 0-level row from the last row. 

 

When conducting page break, esCalc automatically calculates the numbers of rows and 



 
 

40 

 

RAQSOFT 
Innovation Makes Progress http://www.raqsoft.com 

columns each page can contain according to the page setup. When conducting page break, the 

rows and columns in the header area setup repeat on each page. In page break, vertical page break 

is conducted first and then horizontal page break is conducted. 

4.7.2 Pagination after Row and Pagination after Column 

In esCalc, besides automatically conducting page break according to page setup, you can also 

set up pagination after row or pagination after column. 

If pagination after row is set up in a certain row in the cellset, vertical page break is 

conducted mandatorily from behind this row. If pagination after column is set up in a certain 

column in the cellset, horizontal page break is conducted mandatorily from behind this column. 

When setting up pagination after row or pagination after column, in the rowcell where the 

row number is located and the colcell where the column number is located, right click, and in the 

pop-up menu, select Property to edit row property or column property: 
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In the pop-up row property or column property setup panel, just select Pagination after row 

or Pagination after column: 

 

 

4.7.3 Calculation after Page Break 

To facilitate the processing in page break, esCalc also provides several functions to conduct 

calculation after page break. 

 pgno() 

The current page number. 

 pgall() 

The total page.  

 pgcell(C) 

The homocell set of C on this page. 

It is mentioned in Section 2.5 Instant Calculation Cell and Related Calculation Cell that, 

under auto calculate mode, instant calculation cell will automatically conduct calculation when 
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expression is input, and then no longer conducts calculation again. These functions above that 

need calculating after page break make error appear in the calculation result. Therefore, function 

of calculation after page break is usually used in related calculation cell. 

5. Editing Band Structure 

In esCalc, band is the basic structure of cellset, and the editing operation on the band is also 

the basic operation in esCalc. To edit band, it is necessary to determine the band structure in the 

first place. 

5.1 Band Structure 

The band consists of the master row, slave row and their sub rows, and editing its structure 

means various kinds of operations on the master row, slave row and sub row. 

In esCalc, a newly created calculation cellset is shown in the figure below: 

 

In the new calculation cellset, Row 1 and Row 3 are 0-level rows, and Row 2 is 1-level row, 

the sub row of Row 1. 

If you want to edit the structure of the band of a certain row in the calculation cellset, right 

click on any cell or the rowcell of this row, in Structure item of the right-click menu, you can 

select various kinds of operations on band structure. 
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You can also select the cell, and then click Structure option in the menu bar, and select the 

operation. 

As homorow must be of the homostructure, in changing the structure of a certain row, if this 

row has homorows, all of its homorows execute the same change together. 

5.2 Append Sub Row 

To add a sub row for the current row, if the current row already owns sub row, the original 

sub row goes down for one level and changes into the sub row of the newly added sub row. 

On the right-click menu, click Structure > Append Sub Row, you can add sub row.  

Open the calculation cellset esCalc05_1.gex, cellset as follows: 

0 1 2  A B C D E 

1   1 Temperature in F (2012) 

2-   2 Date Day of Week Max Temp. Min Temp.  

 1-  3 January     

  1 4 week 4     

  1 5 week 5     

 1-  6 February     

  1 7 week 1     

3   8      

 

If Row 4 is selected to execute adding sub row, besides adding a sub row after Row 4, a new 

sub row is also added to its homorows, Row 5 and Row 7. After execution, the result is as follows:  

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5      

  1-  6 week 5     

   1 7      

 1-   8 February     

  1-  9 week 1     

   1 10      

3    11      

From the result, it can be seen that all the cells in the added sub row are the initial vacant 

cells.  

 

In the initial cellset of this subchapter, if Row 3 is selected to execute the operation of adding 

sub row, the result is as follows:  
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4      

   1 5 week 4     

   1 6 week 5     

 1-   7 February     

  1-  8      

   1 9 week 1     

3    10      

 

From the result, it can be seen that, as Row 3 and its homorow, Row 6 originally own sub row, 

and after the operation of adding sub row is executed, their original sub row levels go down one 

level and become the sub row of the newly added sub row. 

5.3 Dismantle Master Row 

Delete the master row that has no more slave row but has sub row, and the sub row of the 

current row will upgrade to become the sub row of its parent row. 

Click Structure > Dismantle master row on the right-click menu, and you can dismantle 

master row. 

Re-open calculation cellset esCalc05_1.gex, and the cellset is as follows: 

0 1 2  A B C D E 

1   1 Temperature in F (2012) 

2-   2 Date Day of Week Max Temp. Min Temp.  

 1-  3 January     

  1 4 week 4     

  1 5 week 5     

 1-  6 February     

  1 7 week 1     

3   8      

 

Only when a certain row can execute the operation of dismantling master row, is it allowed to 

select option Dismantle master row on the right-click menu. In order to be able to dismantle 

master row, this row is required to be a master row and have sub row and parent row. For example, 

in the above cellset, Rows 1, 3, 4, 5, 6, and 7 are master rows, but Row 1 has no parent row, Rows 

4, 5, and 7 has not sub row, so only Row 3 and Row 6 can execute the operation of dismantling 

sub row.  

For example, select Row 3 to execute dismantling master row and the result is as follows:  
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0 1  A B C D E 

1  1 Temperature in F (2012) 

2-  2 Date Day of Week Max Temp. Min Temp.  

 1 3 week 4     

 1 4 week 5     

 1 5 week 1     

3  6      

It can be seen that Row 3 and Row 6 of its homorow in the original cellset are both removed, 

and their sub row level goes up for one level and becomes the sub row of Row 2 of their master 

row. 

5.4 Add and Remove Slave Row 

5.4.1 Insert Slave Row 

Add the slave row of the current row before the current row. 

On the right-click menu, click Structure > Insert slave row, you can insert slave row. 

Open calculation cellset esCalc05_2.gex, and the cellset is as follows: 

0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1-  3 California     

  1 4  1990 29760021   

  1 5  2000 33871648   

  1 6  2010 37253956   

 1-  7 Texas     

  1 8  1990 16986510   

  1 9  2000 20851820   

  1 10  2010 25145561   

If we select Row 7 and insert slave row, the result is as follows:   
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0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1  3      

 2-  4 California     

  1 5  1990 29760021   

  1 6  2000 33871648   

  1 7  2010 37253956   

 1  8      

 2-  9 Texas     

  1 10  1990 16986510   

  1 11  2000 20851820   

  1 12  2010 25145561   

It can be seen that a new slave row is inserted before Row 7 and Row 3 of its homorow in the 

original cellset. The slave row has the same level as the original Row 3 and Row 7, and cells in the 

same column have the same appearance attributes such as the same foreground color and 

background color. 

When we select multiple continuous slave rows on the same level (master row is also a kind 

of slave row), and then execute the operation of inserting slave row, it will inserts multiple slave 

rows according to the number of selected rows.  

5.4.2 Append Slave Row 

Add the slave row of the current row after the current row and before all descendent rows of 

the current row, all descendent rows of the current row change into the descendent rows of the 

new slave row.  

On the right-click menu, click Structure > Append slave row, you can append slave row. 

Re-open calculation cellset esCalc05_2.gex, select Row 7 and add slave row. After the 

execution, the result is as follows:  
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0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1  3 California     

 2-  4      

  1 5  1990 29760021   

  1 6  2000 33871648   

  1 7  2010 37253956   

 1  8 Texas     

 2-  9      

  1 10  1990 16986510   

  1 11  2000 20851820   

  1 12  2010 25145561   

It can be seen that a new slave row is inserted after Row 7 and Row 3 of its homorow in the 

original cellset. The slave row has the same level as the original Row 3 and Row 7, and cells in the 

same column have the same appearance attributes such as the same foreground color and 

background color. Different from executing the operation of inserting slave row, all the respective 

sub rows of the original Row 3 and Row 6 are all moved to the new slave row. 

When we select multiple continuous slave rows on the same level (master row is also a kind 

of slave row), and then execute the operation of appending slave row, multiple slave rows will be 

added according to the number of selected rows. 

5.4.3 Remove Slave Row 

Delete the slave row, including its descendent row. If the master row is deleted, the next slave 

row replaces it and becomes the master row. 

On the right-click menu, click Structure > Remove slave row, you can remove slave row. 

Use the example finish executing the operation of appending slave row in Section 5.4.2 

Append Slave Row, or directly open calculation cellset esCalc05_3.gex. We select Row 3 to 

execute the operation of removing slave row, and after the execution, the result is as follows: 

0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1-  3      

  1 4  1990 29760021   

  1 5  2000 33871648   

  1 6  2010 37253956   

 1-  7      

  1 8  1990 16986510   

  1 9  2000 20851820   

  1 10  2010 25145561   

It can be seen that Row 3 and its homorow, Row 8 are both deleted, as they are master rows, 



 
 

48 

 

RAQSOFT 
Innovation Makes Progress http://www.raqsoft.com 

the slave rows after them will replace them and become master rows. In fact, if a certain slave row 

is deleted, then in the band where it is located and at the same level with it, the sequence numbers 

of slave rows after it all move up in order. For example, in this example, the sequence numbers of 

the original Row 4 and Row 9 have gone up from 2 to 1. 

Re-open calculation cellset esCalc05_3.gex. If we select Row 4 instead of Row 3 to execute 

the operation of removing slave row, after the execution, the result is as follows: 

0 1  A B C D E 

1  1 population statistics 

2-  2 State Year Population   

 1 3 California     

 1 4 Texas     

It can be seen that, when Row 4 and its homorow Row 9 are deleted, as they are parent rows, 

their sub rows are deleted too. 

Re-open calculation cellset esCalc05_3.gex. If we select Row 6 instead of Row 4 or Row 3 to 

execute the operation of removing slave row, after the execution, the result is as follows: 

0 1  A B C D E 

1  1 population statistics 

2-  2 State Year Population   

 1 3 California     

 2 4      

 1 5 Texas     

 2 6      

It can be seen from the result that in the original cellset, Row 6 and its homorows Rows 5, 7, 

10, 11, and 12 are all deleted. As these rows are all master rows, but have no more slave row, all 

the sub rows of their parent rows are deleted. 

In executing the operation of removing slave row, if multiple slave rows (perhaps including 

master rows or their descendent rows) are selected in the same band, multiple slave rows are 

deleted at the same time. 

5.4.4 Duplicate Slave Row 

Duplicate the current row and its descendent row, and add them before the current row as the 

slave rows of the current row. 

On the right-click menu, click Structure > Dup slave row, you can duplicate slave row. 

We open calculation cellset esCalc05_2.gex, and the cellset is as follows: 



 
 

49 

 

RAQSOFT 
Innovation Makes Progress http://www.raqsoft.com 

0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1-  3 California     

  1 4  1990 29760021   

  1 5  2000 33871648   

  1 6  2010 37253956   

 1-  7 Texas     

  1 8  1990 16986510   

  1 9  2000 20851820   

  1 10  2010 25145561   

If we select Row 7 and duplicate slave row, the result is as follows:   

0 1 2  A B C D E 

1   1 population statistics 

2-   2 State Year Population   

 1-  3 California     

  1 4  1990 29760021   

  1 5  2000 33871648   

  1 6  2010 37253956   

 2-  7 California     

  1 8  1990 29760021   

  1 9  2000 33871648   

  1 10  2010 37253956   

 1-  11 Texas     

  1 12  1990 16986510   

  1 13  2000 20851820   

  1 14  2010 25145561   

 2-  15 Texas     

  1 16  1990 16986510   

  1 17  2000 20851820   

  1 18  2010 25145561   

It can be seen that Row 7 in the original cellset and its homorow Row 3 are duplicated as the 

new slave rows. When it is duplicated, their sub rows are also duplicated together. 

5.5 Move the Slave Row 

5.5.1 Move Slave Row up 

Move up slave row with its descendent rows, but cannot cross the band of its parent row. 

On the right-click menu, click Structure > Move slave row up, you can move slave row up.  

Open calculation cellset esCalc03_1.gex, cellset is as follows:  
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0 1 2  A B C D E 

1-   1 Employee     

 1  2 Department Finance    

 2-  3 Female     

  1 4 Ashley Wilson NY 11000   

 3-  5 Male     

  1 6 Daniel Davis FL 10000   

 4  7 Count 2 Sum 21000  

 1  8 Department R&D    

 2  9 Female     

 3-  10 Male     

  1 11 Justin Smith TX 7000   

  1 12 Jacob Davis TX 16000   

 4  13 Count 2 Sum 23000  

2   14 Count 4 Sum 44000  

If we select Row 5 to execute the operation of moving slave row up, the result is as follows:   

0 1 2  A B C D E 

1-   1 Employee     

 1  2 Department Finance    

 2-  3 Male     

  1 4 Daniel Davis FL 10000   

 3-  5 Female     

  1 6 Ashley Wilson NY 11000   

 4  7 Count 2 Sum 21000  

 1  8 Department R&D    

 2-  9 Male     

  1 10 Justin Smith TX 7000   

  1 11 Jacob Davis TX 16000   

 3  12 Female     

 4  13 Count 2 Sum 23000  

2   14 Count 4 Sum 44000  

It can be seen from the result that Row 5 and its sub row are moved one position up within 

the band, and the sequence number changes from 3 to 2. At the same time, its homorow Row 10 

and its sub row are also moved one position up within the band. After executing the operation of 

moving slave row up, the sequence number of the slave row becomes smaller, so a master row 

cannot execute the operation of moving slave row up. 

5.5.2 Move Slave Row down 

Move down slave row with its descendent rows but cannot cross the band of its parent row. 

On the right-click menu, click Structure > Move slave row down, you can move slave row 
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down. 

We re-open calculation cellset esCalc03_1.gex, select Row 2 to move slave row down, and 

after the execution, the result is as follows: 

0 1 2  A B C D E 

1-   1 Employee     

 1-  2 Female     

  1 3 Ashley Wilson NY 11000   

 2  4 Department Finance    

 3-  5 Male     

  1 6 Daniel Davis FL 10000   

 4  7 Count 2 Sum 21000  

 1  8 Female     

 2  9 Department R&D    

 3-  10 Male     

  1 11 Justin Smith TX 7000   

  1 12 Jacob Davis TX 16000   

 4  13 Count 2 Sum 23000  

2   14 Count 4 Sum 44000  

 

It can be seen from the result that Row 2 and its homorow are moved one position down in 

their respective bands, the sequence number changes from 1 to 2. After executing the operation of 

moving slave row down, the sequence number of the slave row becomes big, so the last slave row 

in the band cannot execute the operation of moving the slave row down.  

If we select Row 3 instead of Row 2 to move the slave row down, we get the result that is 

completely the same as the result of executing the operation of selecting Row 5 to move slave row 

up in Section 5.5.1 Move Slave Row up.  

5.6 Row Operation  

In cellset, click the rowcell of the row, you can select the whole row. If we right click on the 

rowcell of the row, you can execute various operations on the row on the right-click menu, as 

shown in the figure below: 
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To edit row property, you can also click Edit > Row & Column in the menu bar after 

selecting the row, and select the operations in it. 

5.6.1 Hiding Slave Row 

Hide some slave rows. 

Right click on the rowcell of the row, and select Hide on the right-click menu, you can hide 

the selected slave row. 

Open calculation cellset esCalc05_4.gex, is as follows:  

0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

 1-  3 Quarter 1     

  1 4  January 4000 3400 600 

  1 5  February 4000 5270 -670 

  1 6  March 4000 3250 80 

 2  7 Quarterly total 12000 11920  

 1-  8 Quarter 2     

  1 9  April 5000 5050 30 

  1 10  May 5000 4880 150 

 2  11 Quarterly total 10000 9930  

3   12 Total 22000 21850  

Recorded in this calculation cellset are the purchase volume and the sales volume of a certain 
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product in the first five months. The formula in C7 is == {C4}.sum (), and the functions of C7 and 

C11 are to conduct statistics on the total purchase volume of the current quarter.  The formula in 

D7 is == {D4}.sum (), D7 and D11 are used to calculate the total sales volume of the current 

quarter. The formula in C12 is == {C4}.sum(), which calculates the total purchase volume; the 

formula in D12 is == {D4}.sum(), which calculates the total sales volume. The formula in E10 is 

== E9 + C10 - D10, and E10 and its homocells are used to calculate the surplus of inventory each 

month. 

In this cellset, select Row 7, and click Hide on the right-click menu to execute the operation 

of hiding slave row. The result is as follows:  

0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

 1-  3 Quarter 1     

  1 4  January 4000 3400 600 

  1 5  February 4000 5270 -670 

  1 6  March 4000 3250 80 

 1-  8 Quarter 2     

  1 9  April 5000 5050 30 

  1 10  May 5000 4880 150 

3   12 Total 22000 21850  

It can be found from the result that Row 7 and Row 11 and hidden. When the slave row is 

hidden, all the homorows of the selected row are hidden at the same time, the slave row itself does 

not disappear, and the row numbers of various rows remain unchanged. 

If Row 8 is selected at this time to hide the slave row, the result is as follows:  

0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

  1 4  January 4000 3400 600 

  1 5  February 4000 5270 -670 

  1 6  March 4000 3250 80 

  1 9  April 5000 5050 30 

  1 10  May 5000 4880 150 

3   12 Total 22000 21850  

It can be found that Row 3 and its homorow Row 8 are hidden, but all their descendent rows 

remain their original status and are not hidden.  

Then Row 4 is selected to hide the slave row, he result is as follows:  
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0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

3   12 Total 22000 21850  

It can be found that Row 4 and its homorows Rows 5, 6, 9, and 10 are hidden. After the slave 

row is hidden, it is hidden in demonstration, print or export, but the data in it still exists and can be 

referenced in the expression. 

5.6.2 Show Hidden Row 

Show hidden slave rows.  

Select several rows in continuous position and right click. On the right-click menu, select 

Show, you can show all hidden slave rows within the scope of selected row numbers. 

Based on the final cellset after hiding the slave row in Section 5.6.1 Hiding Slave Row, we 

can demonstrate the procedure to show the hidden rows. Alternatively, we can also directly open 

calculation cellset esCalc05_5.gex, and at the same time, select Row 2 and Row 12 to execute the 

operation of showing hidden row, the result is as follows: 

0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

 1-  3 Quarter 1     

  1 4  January 4000 3400 600 

  1 5  February 4000 5270 -670 

  1 6  March 4000 3250 80 

 2  7 Quarterly total 12000 11920  

 1-  8 Quarter 2     

  1 9  April 5000 5050 30 

  1 10  May 5000 4880 150 

 2  11 Quarterly total 10000 9930  

3   12 Total 22000 21850  

It can be seen that all rows between Row 2 and Row 12 are shown. In executing the operation 

of showing slave row, if a certain row is shown, its homorow will also be shown. 

5.6.3 Row Property 

Set up row property, including row height and whether to break page after the row. 

Just as what is mentioned in Section 4.7.2 Pagination after Row and Pagination after 

Column. In setting up row property, firstly select the row, and select Property on the right-click 

menu. You can view or modify row property in the pop-up row property panel. 

When the row property of a certain row is modified, the row property of all its homorows is 

modified together. 

5.6.4 Row Height Autosize 

Automatically set the row height of the selected row to enable the row height of this row to 

just contain the words in this row. 
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Select the row and right click. Select Autosize on the right-click menu. You can set the row 

height of the current row as the most suitable value. 

When the row height of the currently selected row changes, all its homorows are also 

modified at the same time, and the row height is set as the most suitable row height of the current 

row. If the cells in the selected row are all vacant cells, after the execution of the operation on 

suitable row height, the row height remains unchanged as its original value, and will not set up as 

0. 

5.7 Copying and Pasting Cell 

Select continuous cell at the same level in the same band, you can copy expression and 

property of the current cell, and then paste them to the target cell. 

In pasting, the cell’s appearance attributes such as foreground color, background color, 

alignment and font are also pasted together. 

If there is an expression in a cell, it will adjust automatically according to the position, where 

the cell is located, and the meaning that the cell implies, in the expression when copying the cell. 

For example, open the esCalc sheet esCalc05_6.gex, as shown below: 

0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

 1-  3 Quarter 1     

  1 4  January 4000 3400 600 

  1 5  February 4000 5270 -670 

  1 6  March 4000 3250 80 

 2  7 Quarterly total 12000   

 1-  8 Quarter 2     

  1 9  April 5000 5050 30 

  1 10  May 5000 4880 150 

 2  11 Quarterly total 10000   

3   12 Total    

Where, the formula in C7 is =={C4}.sum(), i.e. to calculate the sum of C4 and all its 

homocells on the same column, here is the total replenishment quantity of Quarter 1. The 

expression field in its homocell C11 automatically adjusts to =={C9}.sum(), used for calculating 

the total replenishment quantity of Quarter 2. 

If you choose C7, press Ctrl+C to copy, and choose D11, press Ctrl+V to paste, then the 

cellset is shown as below: 
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0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

 1-  3 Quarter 1     

  1 4  January 4000 3400 600 

  1 5  February 4000 5270 -670 

  1 6  March 4000 3250 80 

 2  7 Quarterly total 12000 11920  

 1-  8 Quarter 2     

  1 9  April 5000 5050 30 

  1 10  May 5000 4880 150 

 2  11 Quarterly total 10000 9930  

3   12 Total    

First, you can see that the appearance attributes is copied to D11, where the expression is 

=={D9}.sum(). C4 in original expression is modified into D9 which is located on the same 

column and in the same section with the target cellset after pasting. As you see, when you copy 

and paste an expression, the cell referenced in the expression will make adjustment: In the 

direction of the column, it changes with different positions of original and target cellsets; in the 

direction of the row, the cell will make automatic adjustment as similar to the expression in the 

homocells. 

 

If you copy cell C7, and paste it to C12 and D12, then the cellset is shown as below:  

0 1 2  A B C D E 

1   1 Sales Information 

2-   2 Quarter Month Replenishment sell Stock 

 1-  3 Quarter 1     

  1 4  January 4000 3400 600 

  1 5  February 4000 5270 -670 

  1 6  March 4000 3250 80 

 2  7 Quarterly total 12000 11920  

 1-  8 Quarter 2     

  1 9  April 5000 5050 30 

  1 10  May 5000 4880 150 

 2  11 Quarterly total 10000 9930  

3   12 Total 22000 21850  

The expression is =={C4}.sum() in C12, and =={D4}.sum() in D12.  

5.8 Column Operation  

In the cellset, click the colcell of the column, and you can select the whole column. If we 
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right click on the colcell of the column, on the right-click menu, you can select various kinds of 

operations on the column, as shown in the figure below: 

 

5.8.1 Column Insertion and Deletion  

 Delete Column 

To delete column in the calculation cellset, you only need to click the colcell of the column 

to select the whole column, and then select Remove column on the right-click menu, or in the 

menu bar, click Structure > Remove column, then you can delete the selected column. When 

multiple columns are selected, they are deleted at the same time. 

 Insert Column 

To insert column in the calculation cellset, you only need to click the colcell of the column to 

select the whole column, and then in right-click menu, select Insert column, or click Structure > 

Insert column in the menu bar, then you can insert a column before the selected column, the 

property of cells in various rows in the new column is the same as that of the selected column. 

When multiple columns are selected, multiple columns are inserted at the same time.  

 Append Column 

To append column in the calculation cellset, click the colcell of the column to select the 

whole column, and then select Append column on the right-click menu, or click Structure > 

Append column in the menu bar, then you can append a new column after all columns. The 

property of cells of various rows in the new column is the same as that of selected column. When 

multiple columns are selected, multiple columns are appended at the same time. 

5.8.2 Hiding/Displaying Column 

  Hide/Display Column 

In the calculation cellset, you can select some columns to hide. Click the colcell of the 

column to select the whole column, and then select Hide on the right-click menu. 

Similar to hidden slave row, hidden column is not displayed in demonstrating, printing or 
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exporting, but it can be referenced in calculation. 

Select several columns in continuous positions and right click. On the right-click menu, 

select Show, you can show all hidden columns within the scope of selected column numbers. 

5.8.3 Column Property 

Set up column property, including column width and whether to break page after column. 

As already mentioned in Section 4.7.2 Pagination after Row and Pagination after Column, 

in setting up column property, firstly select column, and select Property on the right-click menu, 

you can view or modify column property in the pop-up column property. 

5.8.4 Column Width Autosize 

Automatically set the column width of the selected column to enable the column width of this 

column to just contain the widest word in this column. 

Select and right click on the column. Select Autosize on the right-click menu, then you can 

set the width of the current column as the most suitable value. 

If the cells in the selected column are all vacant cells, after the execution operation of suitable 

column width, the column width remains unchanged as the original value and will not set as 0. 

5.9 Import and Export 

5.9.1 Importing File with Common Format 

In esCalc, you can use data in text file and Excel file. In the menu bar, click File > Open file 

in other format, then you can select file with multiple formats to conduct import. 

Below text file is used to give a simple description: 

 

If we select Text with header, the first row in the text will be placed as the header in 0-level   

row, and serves as the master row of other homorows. 

The opened cellset is as follows: 

0 1  A B C D 

1-  1 ID Name Gender Age 

 1 2 1 Emily F 17 

 1 3 2 Elizabeth F 16 

 1 4 3 Sean M 17 

 1 5 4 Lauren F 15 

 

If we select Text without header, all rows in the text will be placed in the homorows, and 

the opened cellset is as follows: 
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0 1  A B C D 

1-  1     

 1 2 ID Name Gender Age 

 1 3 1 Emily F 17 

 1 4 2 Elizabeth F 16 

 1 5 3 Sean M 17 

 1 6 4 Lauren F 15 

5.9.2 Exporting as a file with common format 

Cellset data in esCalc can be output as a file with other format, such as text file, Excel file, 

and Html file.  

In the menu bar, click File > Save as other format, you can select exporting cellset data. 

When cellset file is exported, all level information in the cellset will be lost, and export is 

conducted only according to cell position. Each column data is separated with Tab and each row 

data is separated with CR. 

 

6. Edit Band 

6.1 Band 

In esCalc, when the structure of band is set, in order to fill the data to the band, you will need 

to edit the data in the band. 

If you want to add, delete, or perform other operations on the data in a certain band, then you 

can right click on any cell or the rowcell of a band row or master row of the band. On the 

right-click menu, select the Band menu item to select various operations on the data of the band. 
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You can also select the corresponding cells and click the Data option on the menu bar to 

select the operation you want.  

The structure of band will not be changed when operating on the data in the band. If no sub 

row is added in the structure of a certain row, then you are unable to append the band directly. 

The sub-row structure of the parent row will still remain even if you delete all sub-bands of a 

parent row. 

6.2 Add Sub-band 

Add a blank sub-band for a slave row.  

On the right-click menu, click Band –> Add sub band to add the sub-band. 

Open the calculation cellset esCalc06_1.gex and the cellset is as follows: 
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0 1 2 3  A B C D E 

1-    1 States and Cities 

 1-   2 A     

  1-  3  Alaska    

   1 4   Anchorage   

  1  5  Arizona    

 1-   6 C     

  1-  7  California    

   1 8   Los Angeles   

   1 9   San Diego   

   1 10   San Jose   

 1   11 D     

2    12      

If no sub row exists in the structure of a specific row, then you are unable to add the sub band. 

Take the row 4, 8, 9, 10, and 12 for example, to add sub band for these rows, you must edit the 

structure of these rows first and then append the sub row.  

If selecting the row 5 and the row 3, then append the sub band respectively. The result is as 

shown below after appending the sub band: 

0 1 2 3  A B C D E 

1-    1 States and Cities 

 1-   2 A     

  1-  3  Alaska    

   1 4      

   1 5   Anchorage   

  1-  6  Arizona    

   1 7      

 1-   8 C     

  1-  9  California    

   1 10   Los Angeles   

   1 11   San Diego   

   1 12   San Jose   

 1   13 D     

2    14      

 

In the former cellset, the row 5 is Arizona State, and the row 3 is the Alaska state. From the 

result, we can see that blank city bands are added for these two states. In the beginning, there is no 

city band in the Arizona State band, so a sub row band will be added. Regarding the Alaska state, 

there is already 1 city band, and a sub row band will be added before the existing band. In the 

newly-added row of the band, the foreground and background colors and other appearance 

attributes of each cell will be determined by the structure setting of band. 
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One thing to note is that no bands under the Arizona State though, the structure of sub band 

remains in its band structure.  

In the calculation cellset esCalc06_1.gex, if you select the row 11 and add the sub band, then 

result will be as shown below: 

0 1 2 3  A B C D E 

1-    1 States and Cities 

 1-   2 A     

  1-  3  Alaska    

   1 4   Anchorage   

  1  5  Arizona    

 1-    C     

  1-    California    

   1 8   Los Angeles   

   1 9   San Diego   

   1 10   San Jose   

 1-   11 D     

  1-  12      

   1 13      

2    14      

 

From the result, we may find that the row 11 is initial letter of D, and no state band exists 

under it at all. A new state band will be appended under it after appending the sub band. Because 

some sub rows of cities exist in the state band in the band structure, a new band of city will also be 

added for the new band of state when adding the state band. 

6.3 Add and delete bands 

6.3.1 Insert band 

Before the current band, append its blank homoband.  

On the right-click menu, click Band > Insert band to insert new band. 

Open the calculation cellset esCalc06_2.gex, as shown below: 
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0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1-  6 R&D  

  1 7 7 Alexis Smith California Female  

  1 8 8 Megan Wilson New York Female  

  1 9 9 Victoria Davis Tennessee Female  

 1-  10 Sales  

  1 11 19 Samantha Williams Alabama Female  

3   12      

If selecting the row 7 and row 5 respectively, then insert band. The result will be as follows 

once the result is added: 

0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5      

  1 6 6 Matthew Johnson Washington Male  

 1-  7 R&D  

  1 8      

  1 9 7 Alexis Smith California Female  

  1 10 8 Megan Wilson New York Female  

  1 11 9 Victoria Davis Tennessee Female  

 1-  12 Sales  

  1 13 19 Samantha Williams Alabama Female  

3   14      

As we can see from the above result, one new homoband is inserted before the row 7 and the 

row 5 respectively of the former cellset. 

Open the esCalc06_2.gex again. If selecting the row 6 and inserting the band, then the result 

will be as follows:  
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0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1-  6   

  1 7      

 1-  8 R&D  

  1 9 7 Alexis Smith California Female  

  1 10 8 Megan Wilson New York Female  

  1 11 9 Victoria Davis Tennessee Female  

 1-  12 Sales  

  1 13 19 Samantha Williams Alabama Female  

3   14      

From the result, we can see that the row 6 of the original cellset is a department band. Once 

inserted a band, a new department band will be inserted before it. Because the sub row of 

employee band is still stored in the structure of department band, a new employee band will be 

added for the new department band according to the band structure when adding the department 

band.  

If selecting multiple continuous bands at the same level and then inserting bands, multiple 

blank bands will be inserted according to the total number of selected bands. 

To insert a band, you can use shortcut key Ctrl+Enter. 

6.3.2 Append band 

Add the blank homobands of the current bands behind the current bands. 

On the right-click menu, click Band > Append band to append band. 

Open the calculation cellset esCalc06_2.gex again, select the row 9 and row 3 respectively, 

and append the band. Once executed, the result will be as follows: 
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0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1-  6   

  1 7      

 1-  8 R&D  

  1 9 7 Alexis Smith California Female  

  1 10 8 Megan Wilson New York Female  

  1 11 9 Victoria Davis Tennessee Female  

  1 12      

 1-  13 Sales  

  1 14 19 Samantha Williams Alabama Female  

3   15      

We can see from the result that a blank band of employee is added after the row 9 of the 

original calculation cellset. A new band of department is added following the band in which the 

row 3 of original calculation cellset is located, and a blank band of employee is added under the 

new department according to the structure of department band. The effect of appending band is 

similar to that of inserting band. The only difference is that the newly added sub band is following 

the current band if appending bands. 

When several continuous bands at the same level are selected at the same time, and append 

the bands, then several blank bands will be added according to the total number of selected bands. 

You can append the bands with the shortcut key Alt+Enter. 

6.3.3 Duplicate band 

Duplicate the selected band and insert. 

On the right-click menu, click Band > Dup band to duplicate the band. 

Reopen the calculation cellset esCalc06_2.gex, select the row 9 and row 3 respectively, and 

copy the band. The result is as shown below once executed:  
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0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1-  6 Finance  

  1 7 1 Rebecca Moore Arizona Female  

   8 6 Matthew Johnson Washington Male  

 1-  9 R&D  

  1 10 7 Alexis Smith California Female  

  1 11 8 Megan Wilson New York Female  

  1 12 9 Victoria Davis Tennessee Female  

  1 13 9 Victoria Davis Tennessee Female  

 1-  14 Sales  

  1 15 19 Samantha Williams Alabama Female  

3   16      

From the above result, we can see that the employee band at row 9 in the original calculation 

cellset is duplicated once and added to the band where it is located. The department band at the 

row 3 of the original calculation cellset is wholly copied and added to the band where it is located; 

When duplicating the bands, not only the bands are duplicated, but also the current bands will 

wholly duplicated. If there are sub-bands in the current band, then these sub-bands will be 

duplicated too. 

If selecting several continuous bands in a same band to duplicate band, then all selected 

bands will be duplicated. 

6.3.4 Remove band 

Remove the selected bands.  

On the right-click menu, click Band > Remove band to remove any band. 

Let’s check the calculation cellset esCalc06_2.gex: 
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0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1-  6 R&D  

  1 7 7 Alexis Smith California Female  

  1 8 8 Megan Wilson New York Female  

  1 9 9 Victoria Davis Tennessee Female  

 1-  10 Sales  

  1 11 19 Samantha Williams Alabama Female  

3   12      

In the cellset, select the row 6 and remove the band. The result is as shown below: 

0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1-  6 Sales  

  1 7 19 Samantha Williams Alabama Female  

3   8      

 

From the result, we can see that the R&D department band in the row 6 with all employee 

sub bands of former calculation cellset will be removed. 

Now, select the row 7 to remove the band. The result is as shown below: 

0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1  6 Sales  

3   7      

From the result, as we can see that the selected employee bands are removed. In this case, in 

the Sales department, not a single record exists, but the band is structured as ever before. Deleting 

band has no impact on it. 

If selecting several continuous bands in a same parent-band, and remove bands, then all 
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selected bands will be removed. 

The band can be removed with the shortcut key Shift+Delete.  

6.4 Move Band 

6.4.1 Move band up 

Move the selected bands upward and allow them to across the band of its parent row. 

On the right-click menu, click Band > Move band up to move the band upward. 

Open the calculation cellset esCalc06_3.gex and the cellset is as shown below: 

0 1 2  A B C D E 

1   1 Athletes 

2-   2 ID Name Country Weight  

 1-  3 Heavyweight  

  1 4 111 Andrew Helm AUS 80.5  

  1 5 124 Larsen Johnson USA 89.7  

 1-  6 Middleweight  

  1 7 356 Wu Ye CHN 78.9  

 1-  8 Lightweight  

  1 9 86 Alessio Pellegrini ITA 60.0  

3   10      

Select the row 5 and row 9 respectively, and move the band upward. The result is as shown 

below: 

0 1 2  A B C D E 

1   1 Athletes 

2-   2 ID Name Country Weight  

 1-  3 Heavyweight  

  1 4 124 Larsen Johnson USA 89.7  

  1 5 111 Andrew Helm AUS 80.5  

 1-  6 Middleweight  

  1 7 356 Wu Ye CHN 78.9  

  1 8 86 Alessio Pellegrini ITA 60.0  

 1  9 Lightweight  

3   10      

As we can see from the above result, the record at the row 5 in the former cellset moved 

upward by one position. Since the Athletes band of row 9 is the first record under the 

Lightweight, the band moving up will cross the band of parent row to the Middleweight scope. 

When moving the band upward, the band can only move within its homorows. If records are 

already at the upmost position of the homorows, for example the row 4 band in the former cellset, 

then you can't move the band upward. 

Then, select the row 6 and move the band upward. The result will be as shown below: 
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0 1 2  A B C D E 

1   1 Athletes 

2-   2 ID Name Country Weight  

 1-  3 Middleweight  

  1 4 356 Wu Ye CHN 78.9  

  1 5 86 Alessio Pellegrini ITA 60.0  

 1-  6 Heavyweight  

  1 7 124 Larsen Johnson USA 89.7  

  1 8 111 Andrew Helm AUS 80.5  

 1  9 Lightweight  

3   10      

As we can see from the above cellset, the Middleweight band in the row 6 moves upward 

along with its descendent rows to the position before the Heavyweight band. 

If several continuous bands in a same band are selected and then moved band up, then all 

selected bands will be moved upward.  

You can move the band up with the shortcut key Alt+Up. 

6.4.2 Move band down 

Move the selected band downward, and allow them to across the band of its parent row. 

On the right-click menu, click Band > Move band down to move the band downward. 

Open the calculation cellset esCalc06_3.gex again. Select the 4
th

 row and the 7
th

 row, and 

move the band downward. Once executed, the result is as shown below: 

0 1 2  A B C D E 

1   1 Athletes 

2-   2 ID Name Country Weight  

 1-  3 Heavyweight  

  1 4 124 Larsen Johnson USA 89.7  

  1 5 111 Andrew Helm AUS 80.5  

 1  6 Middleweight  

 1-  7 Lightweight  

  1 8 356 Wu Ye CHN 78.9  

  1 9 86 Alessio Pellegrini ITA 60.0  

3   10      

As we can see from the above table, moving band downward is opposite to the moving-up. 

The selected band will be moved downward by one position. If the selected band is the last band 

in the band of parent row, moving band downward will cross the band of parent row. The band 

will only move among its homorows. If any band is already located at the bottom of homobands, 

for example the band of row 9 in the cellset, then the band moving-downward operation is failed.  

At this time, select row 3 again, and move the band downward. The result will be as shown 

below: 
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0 1 2  A B C D E 

1   1 Athletes 

2-   2 ID Name Country Weight  

 1  3 Middleweight  

 1-  4 Heavyweight  

  1 5 124 Larsen Johnson USA 89.7  

  1 6 111 Andrew Helm AUS 80.5  

 1-  7 Lightweight  

  1 8 356 Wu Ye CHN 78.9  

  1 9 86 Alessio Pellegrini ITA 60.0  

3   10      

As we can see from the results, the Heavyweight band in the row 3, along with the sub rows 

belong to this band, will move downward to the position behind the Middleweight band.  

If selecting and moving multiple sub bands from a same band, then all these selected bands 

will be moved downward. 

You can move the band down with the shortcut key Alt+Down. 

6.5 Merge Band 

Merge the sub bands of several bands in continuous positions and only keep one parent band. 

On the menu bar, click Data > Merge band to merge the bands. 

Reopen the calculation cellset esCalc06_2.gex, and the cellset is as shown below: 

0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

 1-  6 R&D  

  1 7 7 Alexis Smith California Female  

  1 8 8 Megan Wilson New York Female  

  1 9 9 Victoria Davis Tennessee Female  

 1-  10 Sales  

  1 11 19 Samantha Williams Alabama Female  

3   12      

Select the row 3 ~ row 11. On the menu panel, click Data > Merge band to merge the bands. 

Once executed, the result is as shown below: 
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0 1 2  A B C D E 

1   1 Employees 

2-   2 EId Name State Gender  

 1-  3 Finance  

  1 4 1 Rebecca Moore Arizona Female  

  1 5 6 Matthew Johnson Washington Male  

  1 6 7 Alexis Smith California Female  

  1 7 8 Megan Wilson New York Female  

  1 8 9 Victoria Davis Tennessee Female  

  1 9 19 Samantha Williams Alabama Female  

3   10      

As we can see from the result, the sub bands in the selected bands are merged to the first 

parent band, and the tailing parent bands is deleted.  

Open the calculation cellset esCalc06_1.gex again, and the cellset is as shown below: 

0 1 2 3  A B C D E 

1-    1 States and Cities 

 1-   2 A     

  1-  3  Alaska    

   1 4   Anchorage   

  1  5  Arizona    

 1-   6 C     

  1-  7  California    

   1 8   Los Angeles   

   1 9   San Diego   

   1 10   San Jose   

 1   11 D     

2    12      

Select row 2 to row 6 to merge the bands and the result is as shown below: 
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0 1 2 3  A B C D E 

1-    1 States and Cities 

 1-   2 A     

  1-  3  Alaska    

   1 4   Anchorage   

  1  5  Arizona    

  1-  6  California    

   1 7   Los Angeles   

   1 8   San Diego   

   1 9   San Jose   

 1   10 D     

2    11      

As we can see from the result, all bands under the lists of letter A and C are merged and 

included to the parent band of letter A, and the parent band of the letter C is removed. The band of 

letter D isn’t affected since it is not selected. In every state band, the city sub band will still be 

kept in the respective band of state.  

6.6 Hide Band 

6.6.1 Hide band 

Hide the selected band. 

On the right-click menu, click Band > Hide band to hide band. 

Open the calculation cellset esCalc06_4.gex, and the cellset is as shown below: 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6 28 Sat. 29 20  

  2  7 Max & Min 29 20  

  1-  8 week 5     

   1 9 29 Sun. 30 18  

   1 10 30 Mon. 24 16  

   1 11 31 Tues. 25 12  

  2  12 Max & Min 30 12  

In this calculation cellset, the C7, D7, and their homocells are all related calculation cells.  

The formula in C7 is =={C5}.max(). C7 and its homocell C12 are used to make statistics on the 

maximum temperature of the respective week. The formula in D7 is =={D5}.min(). D7 and its 

homocell D12 are used to make statistics on the minimum temperature of the respective week. 
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Now, select row 6 and row 9 respectively to hide the band. The result is as shown below: 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

  2  7 Max & Min 29 20  

  1-  8 week 5     

   1 10 30 Mon. 24 16  

   1 11 31 Tues. 25 12  

  2  12 Max & Min 30 12  

As we can see from the result, the row 6 and row 9 are hidden. Differing with the deleted 

bands, the hidden bands just disappear but not get lost. Therefore, the result of C7, D7, C12, and 

D12 calculation will not be affected.  

Then, select the row 4 and hide the band. The result will be as shown below: 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  8 week 5     

   1 10 30 Mon. 24 16  

   1 11 31 Tues. 25 12  

  2  12 Max & Min 30 12  

As we can see from the result, the band where the row 4 resides, together with its descendent 

rows and slave row, is hidden. 

For the multiple continuous bands in a same band, you can select and hide them at the same 

time. 

6.6.2 Display bands 

Display the hidden band in the band where the selected rows reside. 

On the right-click menu, click the Band > Show band to display the band. 

Let’s have a look on the final cellset with hidden band as described in the Section 6.6.1 Hide 

Band again, or open the calculation cellset of esCalc06_5.gex directly, select row 8, and perform 

the show band action. The result will be as shown below: 
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  8 week 5     

   1 9 29 Sun. 30 18  

   1 10 30 Mon. 24 16  

   1 11 31 Tues. 25 12  

  2  12 Max & Min 30 12  

As we can see from the result, the once hidden band is displayed in the band in which the row 

8 is located. 

Then select the row 3 and display the band. The result is as shown below: 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6 28 Sat. 29 20  

  2  7 Max & Min 29 20  

  1-  8 week 5     

   1 9 29 Sun. 30 18  

   1 10 30 Mon. 24 16  

   1 11 31 Tues. 25 12  

  2  12 Max & Min 30 12  

From the above, we can see that all bands in the band of row 3 and the whole band where 

these bands reside are displayed. 

If selecting multiple rows in the cellset, then bands in all selected rows and the band where 

the rows reside will be displayed when displaying bands. 

 

7. Cell Edit 

7.1 Cell Edit 

In esCalc, after selecting the cells, you can select various operations from the Cell item on 

the right-click menu: 
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7.1.1 Clear cell contents 

  Clear cell value 

Select cell and right click. On the right-click menu, click Cell > Clear value to set the cell 

value of selected cell to null. 

When clearing cell value, the cell value in the constant cell will be emptied. The instant 

calculation cell value will be set to null, not allowing for further calculation unless you change the 

formula. Related calculation cell will be converted to the instant calculation cell, and the cell value 

will be set to null, not allowing for further calculation unless you change the formula. 

To clear the cell value, you can also press delete button after selecting cells. 

 Clear formula 

Select cell and right click. On the right-click menu, click Cell > Clear formula to clear the 

formula of selected cells. 

For formula clearing, you will get different operation result according to different settings. 

You can click Tool > Option on the menu bar. In the option settings window, you can set whether 

to clear cell value when clearing formula. If selected this option, the cell value will be cleared 

when clearing the formula. Otherwise, the current cell value will be kept to only clear the formula. 
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To clear up the expression, you can also select cells and press down Alt+delete. 

 Clear Homocell Value 

Select the cell, and then click Cell > Clear Homocell Value in the context menu, you can 

clear all homocell values of the selected cell. 

To clear the homocell value, you can also press Ctrl+Alt+D simultaneously after the cell is 

selected.  

7.1.2 Set master cell 

 Set master cell 

Select a cell and right click. On the right-click menu, click Cell > Set/Cancel master cell to 

set the cell as the master cell or remove the settings of master cell. 

For details on setting the master cell, please refer to the Section 3.9 Master Cell. 

7.1.3 Delete/insert cell 

 Insert cell before 

Insert a blank cell at the place where the selected cell is located, and move all right cells in 

the current row rightward a cell. All homocells of the current row will also undergo the same 

operation. If the last cell of a certain row among these homorows is with a value, then a blank 

column will be added to the end of this cellset, and then move the respective cell rightward. Once 

cell is selected, on the right-click menu, you can click Cell > Insert cell before to insert cell 

before. 

You can also hold down Ctrl-Insert key to insert cell before the selected cell. 

 Insert cell behind 

Insert a blank cell to the right of the selected cell, and move all right cells in the current row 

rightward a cell one by one from the cell on its right. All homorows of the current row will also 

undergo the same operation. If the last cell of a certain row among these homocells is with a value, 

then a blank column will be added at the end of the cellset, and then move the respective cell 

rightward. Once cell is selected, on the right-click menu, you can click Cell > Insert cell behind 
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to insert cell behind. 

You can also hold down Alt-Insert key to insert cell behind the selected cell. 

 Delete current cell 

Once the cell is selected, you can click Cell > Remove active cell on the right-click menu to 

remove the selected cell along with its homocells. The cells on the right will move leftward to fill 

up the position. A blank cell will be appended at the end of the current row and its homorows. The 

cell out of the homorows will not be affected. After deleting the current cell, the number of 

columns in the calculation cellset will not be affected. 

To delete the current cell, you can also select the cell and press down the Ctrl-Delete. 

 Remove left cell 

Once the cell is selected, you can click Cell > Remove left cell on the right-click menu to 

remove the cell on the left of the current cell and its homocells. The current cell and the cells on 

the right of it will be moved leftward to fill the blank, and a blank cell will be added to the end of 

the current row and its homorows. The cells in the non-homorows will not be affected. After 

deleting the cell on the left, the number of columns in the calculation cellset will not be affected. 

To remove left cell, you can select the cell and press down Ctrl-Backspace. 

Then, let’s have a look on calculation cellset esCalc06_4.gex:  

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6 28 Sat. 29 20  

  2  7 Max & Min 29 20  

  1-  8 week 5     

   1 9 29 Sun. 30 18  

   1 10 30 Mon. 24 16  

   1 11 31 Tues. 25 12  

  2  12 Max & Min 30 12  

Select C5 and insert cells before executing. The result is as shown below:  
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri.  28 21 

   1 6 28 Sat.  29 20 

  2  7 Max & Min 29 20  

  1-  8 week 5     

   1 9 29 Sun.  30 18 

   1 10 30 Mon.  24 16 

   1 11 31 Tues.  25 12 

  2  12 Max & Min 30 12  

As we can see from the result, the cell C5 and the cells on the right is moved to the right, a 

blank cell is inserted in the original position of C5. The same operation is performed on all 

homorows of the row 5. Then, select D6, and delete the current cell. The result is as shown below: 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri.  21  

   1 6 28 Sat.  20  

  2  7 Max & Min 29 20  

  1-  8 week 5     

   1 9 29 Sun.  18  

   1 10 30 Mon.  16  

   1 11 31 Tues.  12  

  2  12 Max & Min 30 12  

As we can see from the result, the cell D6 is deleted, the cells on its right side are moved to 

the left one by one, and a blank cell is appended at the end of the current row. The same operation 

is applied to all homorows of the row 6. One thing to note is that the marks on the bottom right 

corner of the cell C7 and C12 have become a red little triangle mark. This is to indicate the cells 

being referenced in the formulae of these two cells are deleted, and thus an error occurs. 

Then, select D7, and delete the left cell. The result is as shown below: 
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri.  21  

   1 6 28 Sat.  20  

  2  7 Max & Min 20   

  1-  8 week 5     

   1 9 29 Sun.  18  

   1 10 30 Mon.  16  

   1 11 31 Tues.  12  

  2  12 Max & Min 12   

From the above table, we can see that the cells on the left of D7 and its homocell D12 are 

deleted, both homocells and the cells on the right of them are moved to the left one by one, and 

blank cells are appended at the end of the rows. 

Select A5, and insert cell behind, and the result is as shown below: 

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27  Fri.  21 

   1 6 28  Sat.  20 

  2  7 Max & Min 20   

  1-  8 week 5     

   1 9 29  Sun.  18 

   1 10 30  Mon.  16 

   1 11 31  Tues.  12 

  2  12 Max & Min 12   

From the above table, we can see that a blank cell is appended after A5 and its homocells. 

The cells after these homocells are moved to the right one by one.  

When deleting/inserting cells, you can select multiple cells in continuous positions. In this 

case, the deleting/inserting cells will all be performed in the selected rows and its homo-ones. 

However, if you select multiple columns when inserting cells, only the cells in the leftest column 

will be selected effectively.   

7.2 Copy and paste homocells  

In esCalc, in order to facilitate data copying and pasting in the cellset, some operations 
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specific to the homocells are provided.  

 

 Select homocell 

Select several cells in the slave rows at the same level of a same band. Then, on the 

right-click menu, click Select homocell to select all homocells of the specified cells in the current 

work scope along the given direction for selection. In addition, you can clear the cell value and 

perform other operations on the selected cells. When selecting the homocell, there are three 

optional modes, namely, All selected, Upward, and Downward. 

 Copy homocell 

Select several cells in a same band of the slave rows at the same level, and right click. On the 

right-click menu, click Homocell copy to copy all homocells of the specified cell in the current 

work scope. You can also copy the data from the homocell and paste them to other positions in the 

cellset, or another calculation cellset, or a text file. 

 Paste homocell  

Select a cell and right click. On the right-click menu, click Homocell paste to paste the 

copied data to the cells from the specified cell one by one. If there are multiple data rows, then the 

data will be pasted to all latter homorows of the current row in the specified order. If the number 

of homorows is not enough to hold the data, then new homobands will be added automatically in 

the last parent band according to the number of data rows. For the homocell pasting, this is 

independent of the work scope. If the number of columns in the cellset is not enough to hold the 

multiple data columns to paste, then a window will prompt you to choose whether add column or 

not.  

Open the calculation cellset esCalc07_1.gex as shown below:  
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0 1 2  A B C D E 

1-   1      

 1-  2 Week 1     

  1 3 Sunday  a   

  1 4 Monday  b   

  1 5 Tuesday  c   

  1 6 Wednesday  d   

 1-  7 Week 2     

  1 8 Sunday  e   

 1-  9 Week 3     

  1 10 Sunday  f   

Select cell A4, and perform the Select Homocell action, then the below option window will 

appear: 

 

Select All Select and click OK, then the color of A3, A4, A5, A6, A8, and A10 cells will 

change, indicating that all homocells of A4 are selected. Select Upward, then both A3 and A4 

cells will be selected. The color of both cells (i.e. the active cell and its homocells above) will 

change. Select Downward, then the 5 cells of A4, A5, A6, A8, and A10 (i.e. the active cell and all 

its homocells below) will be selected, and their color will change. 

Then, hold down Ctrl key and select the cell A4 and C4 to perform the homocell copying. 

Once copied, you will see that the color of cells from A3 to A6, A8, A10, and C3 to C6, C8, C10 

has changed. Color changing is to indicate that values in these cells have been copied. Click D4 to 

perform the homocell pasting, then the result will be as shown below: 
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0 1 2  A B C D E 

1-   1      

 1-  2 Week 1     

  1 3 Sunday  a   

  1 4 Monday  b Sunday a 

  1 5 Tuesday  c Monday b 

  1 6 Wednesday  d Tuesday c 

 1-  7 Week 2     

  1 8 Sunday  e Wednesday d 

 1-  9 Week 3     

  1 10 Sunday  f Sunday e 

   11    Sunday f 

A homoband is added to the last parent band Week3 automatically because you’ve copied 6 

pieces of data and only 5 homobands are available since the row 4. 

As we can see from the result, when pasting the homocells, only the cell value is pasted 

instead of the cell properties.  

Then, select C5 and E5 and right click. On the right-click menu, you can select homocell, and 

find that only the homocells from C3 to C6, C8, C10, and E3 to E6, E8, E10 are selected. Press 

Delete key to clear the cell value, and the result is as shown below:  

0 1 2  A B C D E 

1-   1      

 1-  2 Week 1     

  1 3 Sunday     

  1 4 Monday   Sunday  

  1 5 Tuesday   Monday  

  1 6 Wednesday   Tuesday  

 1-  7 Week 2     

  1 8 Sunday   Wednesday  

 1-  9 Week 3     

  1 10 Sunday   Sunday  

   11    Sunday  

From the above table, we can see that only the values in the selected cells are cleared. 

7.3 Paste Band 

Similar to the homocell paste, there is another band paste action available in esCalc. On the 

right-click menu, you can sleet the Band paste option to execute. The band pasting will add new 

bands before the currently selected band, and put the copied data in them one by one.  

Let’s continue with the calculation cellset in the Section 7.2 Copy and paste homocells, or 

open the calculation cellset of esCalc07_2.gex directly, as shown below: 
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0 1 2  A B C D E 

1-   1      

 1-  2 Week 1     

  1 3 Sunday     

  1 4 Monday   Sunday  

  1 5 Tuesday   Monday  

  1 6 Wednesday   Tuesday  

 1-  7 Week 2     

  1 8 Sunday   Wednesday  

 1-  9 Week 3     

  1 10 Sunday   Sunday  

  1 11    Sunday  

Select both A11 and D11, and copy the homocell. You can find that all the homocells of A11 

and D11 will be copied. Then, select C4 to paste the bands. The result is as shown below: 

0 1 2  A B C D E 

1-   1      

 1-  2 Week 1     

  1 3 Sunday     

  1 4   Sunday   

  1 5   Monday Sunday  

  1 6   Tuesday Monday  

  1 7   Wednesday Tuesday  

  1 8   Sunday Wednesday  

  1 9   Sunday Sunday  

  1 10    Sunday  

  1 11 Monday   Sunday  

  1 12 Tuesday   Monday  

  1 13 Wednesday   Tuesday  

 1-  14 Week 2     

  1 15 Sunday   Wednesday  

 1-  16 Week 3     

  1 17 Sunday   Sunday  

  1 18    Sunday  

As we can see from the result, 7 bands are inserted before the cell C4 of the existing cellset 

according to the copied data, and the data is pasted one by one after the selected column.  

In esCalc, before pasting bands, you can copy the data from the cellset or external files, such 

as Txt file, Excel file, database explorer, and other data sources. 

7.4 Homocell Operation 
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In esCalc, there are other operations specific to homocells that you can select from the 

Homocell item on the right-click menu: 

  

 Insert homocell 

Insert a blank cell to the selected cell. Move down the existing cell values of the homocells in 

the work scope since this cell. Insert a new homoband after the work scope. Populate the original 

value of the last homocell in its homocell in the new homoband. During the execution, the selected 

cells should be the continuous cell of a same band at a same level. On the right-click menu, you 

can click the Homocell > Homocell insert to insert the homocells. 

 Remove homocell 

Remove the value of selected cell, and move up the existing value of continuous homocells in 

the work scope. The selected cells should be the continuous cells of a same band at a same level. 

On the right-click menu, click Homocell > Homocell delete to remove the homocells.  

 Copy to homocell 

Copy the value of selected cell to the homocell at the specified position in the work scope. 

When executing, the selected cells must be in a same band and next to each other in a 

continuously arranged cells at the same level. On the right-click menu, click Homocell > Copy to 

homocell to copy the homocells. 

Open calculation cellset esCalc07_3.gex: 
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0 1 2 3  A B C D E 

1-    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6 28 Sat. 29   

  1-  7 week 5     

   1 8 29 Sun. 30 18  

   1 9 30 Mon. 24 16  

   1 10 31 Tues. 25 0  

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 0  

   1 14 2 Thur. 38 16  

3    15      

Select A6 and B6 at the same time, and execute the homocell insertion. The result is as 

follows:  

0 1 2 3  A B C D E 

1-    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6   29 20  

  1-  7 week 5     

   1 8 28 Sat. 30 18  

   1 9 29 Sun. 24 16  

   1 10 30 Mon. 25 12  

 1-   11 February     

  1-  12 week 1     

   1 13 31 Tues. 35 11  

   1 14 1 Wed. 38 16  

   1 15 2 Thur.    

3    16      

As we can see from the above, in the homorows of the A6 since the row 6, all data in the 

column A and B have moved down for one row. The cell value in other columns remains the 

original. A homorow is added at the end of the last homorow.  

In this cellset, select A8 and B8 to perform the homocell deletion. The result is as shown 
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below:  

0 1 2 3  A B C D E 

1-    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6   29 20  

  1-  7 week 5     

   1 8 29 Sun. 30 18  

   1 9 30 Mon. 24 16  

   1 10 31 Tues. 25 12  

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 11  

   1 14 2 Thur. 38 16  

   1 15      

3    16      

As we can see from the above, since the row 8, and in the homorows 9, 10, 13, 14 and 15, 

values in the column A and B have moved up a row. The cell values in other columns remain the 

original.  

Select cell B8, and then copy to the homocell. A Forward panel will appear as shown below:  

  

On this panel, you can set the execution direction of copying the homocells. For the Upward, 

the values of selected cells will be copied to homocells before the current cell in the work scope. 

For the Downward, the value of selected cells will be copied to the homocells after the current cell. 

For All select, the value of selected cells will be copied to all the homocells. You can choose either 

direction. 

Select Downward as the direction in which to copy to the homocells, as shown below:  
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0 1 2 3  A B C D E 

1-    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6   29 20  

  1-  7 week 5     

   1 8 29 Sun. 30 18  

   1 9 30 Sun. 24 16  

   1 10 31 Sun. 25 12  

 1-   11 February     

  1-  12 week 1     

   1 13 1 Sun. 35 11  

   1 14 2 Sun. 38 16  

   1 15  Sun.    

3    16      

The value in cell B8 will be copied to each homocell below it. 

In esCalc, to paste the homocells, you can either copy the data from the cell or external file, such 

as the Txt file, Excel file, and database explorer. 

 Move Cell Left 

The selected cell and all its homocells will be interchanged with their adjacent cells on the 

left. To move cell left, you can click Homocell > Move Cell Left in the context menu. 

Open the esCalc sheet esCalc07_4.gex, the cellset is shown as below: 

0 1 2  A B C D E 

1   1 Athletes 

2-   2 ID Name Country Weight  

 1-  3 Heavyweight  

  1 4 111 Andrew Helm AUS 80.5  

  1 5 124 Larsen Johnson USA 89.7  

 1-  6 Middleweight  

  1 7 356 Wu Ye CHN 78.9  

 1-  8 Lightweight  

  1 9 86 AlessioPellegrini ITA 60.0  

3   10      

Select D5, and move cell left, as shown below: 
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0 1 2  A B C D E 

1   1 Athletes 

2-   2 ID Name Country Weight  

 1-  3 Heavyweight  

  1 4 111 Andrew Helm 80.5 AUS  

  1 5 124 Larsen Johnson 89.7 USA  

 1-  6 Middleweight  

  1 7 356 Wu Ye 78.9 AUS  

 1-  8 Lightweight  

  1 9 86 AlessioPellegrini 60.0 AUS  

3   10      

As you see, the appearance attributes of the cell migrate with it when you move the cell to the 

left, but the column width is unaffected. If the cell in column A is selected, there will be no effect 

when moving it to the left.  

To move cell left, you can use shortcut keys Alt+Left. 

 Move Cell Right 

The selected cell and all its homocells will be interchanged with their adjacent cells on the 

right. To move cell right, you can click Homocell > Move Cell Right in the context menu. If C9 

is selected in the above cellset, and move the cell to the right, you will get the original cellset.  

To move cell right, you can use shortcut keys Alt+Right. 

 Move Cell Up 

The selected cell and all its homocells will be interchanged with their adjacent cells on the 

top and in the same band. To move cell up, you can click Homocell > Move Cell Up in the 

context menu.  

Let’s continue with the calculation cellset esCalc07_4.gex, select the cells A2-E2, and then 

move up the cells, the result appears as shown below:  

0 1 2  A B C D E 

1   1 ID Name Country Weight  

2-   2 Athletes 

 1-  3 Heavyweight  

  1 4 111 Andrew Helm 80.5 AUS  

  1 5 124 Larsen Johnson 89.7 USA  

 1-  6 Middleweight  

  1 7 356 Wu Ye 78.9 AUS  

 1-  8 Lightweight  

  1 9 86 AlessioPellegrini 60.0 AUS  

3   10      

As similar with the result of moving the cell to the left, the appearance attributes of the cells 

migrate with them after the cells is moved up, but the row height is unaffected. When moving up 

the cell, you can move it only from one slave row to the other adjacent one in the same band. 
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 Move Cell Down 

The selected cell and all its homocells will be interchanged with their adjacent cells in the 

same band. To move cell down, you can click Homocell > Move Cell Down in the context menu.  

8. Data Operations 

Quite often, various raw data are required to arrange when making data statistics. In esCalc, 

you can carry out various data operations, such as expanding, filtering, and grouping. 

To process the data in the selected row of calculation cellset or cell, please right-click, and 

choose the desired data operations from the Operation item on the right-click menu. 

 

Once selected the corresponding cell, you can also click the Operation on the menu bar to 

select the desired operation. 

8.1 Expand 

Select the cell whose value is of set type. Copy several bands according to its cell value, and 

then split the cell value to distribute to each band. The homocells will be expanded synchronously. 

On the right-click menu, click Operation > Expand to expand. 

Open the calculation cellset esCalc08_1.gex, as shown below: 

0 1  A B C D E 

1-  1      

 1 2 [1,2,3] 3    

2  3      

Select and expand the A2 cell. The result is as shown below:  
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0 1  A B C D E 

1-  1      

 1 2 1 3    

 1 3 2 3    

 1 4 3 3    

2  5      

As we can see from the result, the original value of A2 is of set type, and thus you can expand 

it. The value in A2 is [1,2,3] with 3 members in total. After expanding, the row where the A2 is 

located will be duplicated and expanded to 3 rows. In each row, the corresponding cell value of A2 

will be set as a member of the set. When expanding, the properties like foreground/background 

color of each cell in the row and cell value other than A2 will be pasted.  

What if the row whose cell to be expanded has got the sub row or slave row? Let us open the 

calculation cellset esCalc08_2.gex, and check the calculation cellset below: 

0 1 2  A B C D E 

1-   1 Game Band 

 1-  2 [G1,G2]  

  1 3  1st Half    

  1 4  2nd Half    

2-   5 Students  

 1  6 Name [Jack,Tom]    

 2  7 Gender     

In the cellset, select B6 and A2 cells and expand respectively. The result is as shown below: 

0 1 2  A B C D E 

1-   1 Game Band 

 1-  2 G1  

  1 3  1st Half    

  1 4  2nd Half    

 1-  5 G2  

  1 6  1st Half    

  1 7  2nd Half    

2-   8 Students  

 1  9 Name Jack    

 2  10 Gender     

 1  11 Name Tom    

 2  12 Gender     

 

As we can see from the result, if the row whose cell to be expanded has the sub row or slave 

row at the same level, then the band in which it is located will be duplicated when being 

expanded. 
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What if multiple cells are selected at the same time? Please open the esCalc08_3.gex, and 

have a look at the calculation cellset below: 

0 1  A B C D E 

1-  1      

 1 2 [1,2,3] [a,b]    

2  3      

Select both the cell A2 and cell B2 to expand. A dialog will prompt: 

 
In this dialog, there are 3 available modes for expanding according to the minimum element 

number, the maximum element number, or the selected the cell. 

If expanding according to the minimum number of members, the result will be as shown 

below: 

0 1  A B C D E 

1-  1      

 1 2 1 a    

 1 3 2 b    

2  4      

In this example, since fewest members are located in B2 totaling 2, the expansion will reach 

2 rows according to the minimum number of elements. Each cell in the expanding row will be set 

one by one. 

If expanding according to the maximum number of members, the result is as shown below: 

0 1  A B C D E 

1-  1      

 1 2 1 a    

 1 3 2 b    

 1 4 3     

2  5      

In this example, since most members is located in A2 totaling 3, the expansion will reach 3 

rows according to the maximum number of elements. For those of which there are not enough 

members in B2, the cell value of the expanding row will be set as null. 

If cell to expand are selected, then the expansion will be based on the number of members in 



 
 

92 

 

RAQSOFT 
Innovation Makes Progress http://www.raqsoft.com 

the selected cell. 

When selecting multiple cells to expand, the cells can be in multiple columns of a same row 

or several continuous rows at the same level in a same band.  

Open the calculation cellset esCalc08_4.gex, and the cellset is as shown below: 

0 1  A B C D E 

1-  1      

 1 2 [1,2,3] a    

 1 3 4 b    

 1 4 [5,6] c    

2  5      

Select A2 to expand. The result is as shown below: 

0 1  A B C D E 

1-  1      

 1 2 1 a    

 1 3 2 a    

 1 4 3 a    

 1 5 4 b    

 1 6 5 c    

 1 7 6 c    

2  8      

As we can see from the result, when expanding a cell having homocells, then the homocells 

will be expanded at the same time.   

8.2 Locate 

Find the satisfied homocell and move the cursor on it. 

On the right-click menu, click Operation > Locate to perform the locate operation. 

The Locate operation will judge the data in all homocells and move the cursor to the first 

homocell satisfying the setting conditions. Open the calculation cellset esCalc08_5.gex, and the 

cellset is as shown below: 
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6 28 Sat. 29   

  1-  7 week 5     

   1 8 29 Sun. 30 18  

   1 9 30 Mon. 24 16  

   1 10 31 Tues. 25 0  

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 0  

   1 14 2 Thur. 38 16  

3    15      

 The regional air temperature data over a certain period is recorded in the calculation cellset. 

Select C5 to perform the locate operation. The Locate operation panel is as shown below: 

 

 

On the Locate panel, you can set the locate conditions. Of these conditions you can set the 

cell value as Equal To, Not Equal To, Greater Than, Not Great Than, Less Than, and Not Less 

Than a certain setting value. You can also set the locate conditions of cell value as the maximum 

or minimum, or directly fill in the conditional expression for locating. When using the conditional 

expression for locating, you can use @ to represent the cell value, for example, @>25 is to 

represent a locate condition of locating the cell values greater than 25. 

On the lower section of Locate panel, you can set the operation option: Select all, Wrap 

locate; and the direction of locate operation is Forward or Backward. When locating the 

homocell meeting the conditions, the set locating direction will be followed. If the Select All 
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option is selected, then all homocells meeting the condition will be selected. Otherwise, only the 

first homocell is selected, and the cursor will move to the first homocell meeting the condition. If 

Wrap Locate is not selected, then the locating will stop when reaching the topmost homocell or 

lowest homocell in the locating direction. If the option is selected, then wrap locate will be 

followed. 

If selecting Cell Value on the Locate panel, set the condition as ==24, and confirm the 

executing, then the cursor will move onto C9. If filling @==24 in the Locate expression, then we 

will get the same locating results. 

If selecting Cell Value on the Locate panel, set the conditions as Maximum, and confirm the 

execution, then the cursor will move onto C14. 

8.3 Filter 

To filter a specified cell value at its parent level: 

On the right-click menu, you can click Operation > Filter to carry out the filter operation. 

The filter operation will judge on the value in the homocells, and hide/remove the bands in 

which the homocells do not meet the condition. Let’s reopen calculation cellset esCalc08_5.gex:  

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

   1 6 28 Sat. 29   

  1-  7 week 5     

   1 8 29 Sun. 30 18  

   1 9 30 Mon. 24 16  

   1 10 31 Tues. 25 0  

 1-   11 February     

  1-  12 week 1     

   1 13 1 Wed. 35 0  

   1 14 2 Thur. 38 16  

3    15      

As we can see from the above result, of the lowest temperature data in column D, some 

entries are 0 and some are missing. We regard the data of 0 or null is the illegal data to be filtered 

out.  

To do so, select and filter on the cell D5. The Filter operation panel will prompt:  
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On the Filter panel, you can set the filter criterion. The filter criterion setting is similar to that 

of setting the locating condition, but only with one additional filter criterion for Enumeration 

option. When checking Enumeration in the filter condition, you can select more than one cell 

values required to be retained at a time. For the band not meeting the condition, you can choose 

Delete or Hide option. 

Select the cell value of filter, set the filter condition to “!=null”, and select Delete to remove 

the data not meeting the condition. Once filtered, the result will be as shown below:  

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

  1-  6 week 5     

   1 7 29 Sun. 30 18  

   1 8 30 Mon. 24 16  

   1 9 31 Tues. 25 0  

 1-   10 February     

  1-  11 week 1     

   1 12 1 Wed. 35 0  

   1 13 2 Thur. 38 16  

3    14      

As we can see from the above, the band whose lowest temperature is empty is deleted. In fact, 

the selected cells can be in any homorows when filtering. 

Then select cell D13 to filter, and set the filter conditions as the Cell value with the condition 

“!=0”. Select Delete to remove bands not meeting the condition. Once filtered, the result will be as 

shown below: 
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0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

   1 5 27 Fri. 28 21  

  1-  6 week 5     

   1 7 29 Sun. 30 18  

   1 8 30 Mon. 24 16  

 1-   9 February     

  1-  10 week 1     

   1 11 2 Thur. 38 16  

3    12      

From the above, you can see that the band of which the lowest temperature is 0 has been 

deleted too. 

Select C5 and filter. Fill out the filter expression @>28, and select Hide to hide the 

unsatisfied bands. Once filtered, the results will be as shown below: 

  

0 1 2 3  A B C D E 

1    1 Temperature in F (2012) 

2-    2 Date Day of Week Max Temp. Min Temp.  

 1-   3 January     

  1-  4 week 4     

  1-  6 week 5     

   1 7 29 Sun. 30 18  

 1-   8 February     

  1-  10 week 1     

   1 11 2 Thur. 38 16  

3    12      

As we can see from the above result, through filtering, only the bands whose values of 

highest temperature are higher than 28℉ are kept, and other bands are hidden. Then, if selecting 

the 2
nd

 row to show band, then you can show all hidden descendent rows of row 2.   

Open the calculation cellset of esCalc08_6.gex, and you will find the cellset as shown below: 
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0 1 2  A B C 

1   1 2011 Grosses 

2-   2 Title MPAA Rating Total Gross 

 1-  3 Universal 

  1 4 Fast Five  PG-13 209837675 

  1 5 Bridesmaids R 169106725 

 2  6  Total 378944400 

 1-  7 Warner Bros. 

  1 8 Harry Potter and the Deathly Hallows Part 2 PG-13 381011219 

  1 9 The Hangover Part II R 254464305 

  1 10 Sherlock Holmes: A Game of Shadows PG-13 186271351 

 2  11  Total 821746875 

 1-  12 Buena Vista 

  1 13 Pirates of the Caribbean: On Stranger Tides PG-13 241071802 

  1 14 Cars 2 G 191452396 

 2  15  Total 432524198 

The data in this cellset is about the box office of some movies in 2011. The formula in C6 is 

=={C4}.sum(). This cell and its homocells are all related calculation cells to calculate the total box 

office of movies produced by a same movie company. In this case, the data will be filtered by the 

total box office to only keep the movie companies whose total box office data is less than 

500,000,000. To do so, we select cell C6 and filter with a criteria of @<500000000. Select Delete 

option to remove the bands not meeting the condition. Once filtered, the result is as shown below:   

0 1 2  A B C 

1   1 2011 Grosses 

2-   2 Title MPAA Rating Total Gross 

 1-  3 Universal 

  1 4 Fast Five  PG-13 209837675 

  1 5 Bridesmaids R 169106725 

 2  6  Total 378944400 

 1-  7 Buena Vista 

  1 8 Pirates of the Caribbean: On Stranger Tides PG-13 241071802 

  1 9 Cars 2 G 191452396 

 2  10  Total 432524198 

 

As we can see from the above result, the box office data of movie companies whose total box 

office is less than 500,000,000 is kept, and other bands are deleted. The whole band, in which the 

deleted rows are located, will also be deleted along with its sub bands and the slave rows in a same 

band. 

8.4 Distinct  
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For every cell value, perform the distinct operation at the parent level. 

On the right-click menu, click Operation > Distinct to perform the distinct operation. 

Open the calculation cellset esCalc08_7.gex, as shown below: 

0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Grace Miller Vault 14.000 

 1 4 Kayla Rodriguez Vault 14.575 

 1 5 Kayla Rodriguez Uneven bars 14.675 

 1 6 Kayla Rodriguez Balance beam 13.975 

 1 7 Kayla Rodriguez Floor 14.400 

 1 8 Lauren Davis Vault 14.275 

 1 9 Grace Miller Floor 13.975 

 1 10 Grace Miller Uneven bars 12.875 

 1 11 Lauren Davis Floor 13.000 

 1 12 Grace Miller Balance beam 13.100 

 1 13 Daniel Smith Parallel bars 14.375 

 1 14 Lauren Davis Balance beam 15.225 

 1 15 Lauren Davis Uneven bars 14.275 

This calculation cellset is about the score of a certain women's individual All-Around for 

gymnastics. In the following procedure, the distinct operation will be carried out on name to sort 

out the scores.  

Select cell A3 and perform the distinct operation. The Distinct operation panel will prompt, 

as shown below: 

  

On the Distinct panel, you can choose 4 operation modes: Merge, Distinct, Delete, and No 

Action. In addition, you can also set the judgment will be carried out either on the values of 

Adjacent Only or Delete Unique Value.  

Select Distinct to perform the distinct operation. The result is as shown below : 
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0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Grace Miller Vault 14.000 

 1 4 Kayla Rodriguez Vault 14.575 

 1 5 Lauren Davis Vault 14.275 

 1 6 Daniel Smith Parallel bars 14.375 

By comparing it with the former calculation cellset, you will find that the bands are deleted 

except for the first band regarding each name after the distinct operation on names. 

In the calculation cellset esCalc08_7.gex, select A3 to perform the distinct operation, set the 

Distinct operation, and Adjacent only for the judgment on the same value. The result is as shown 

below after the distinct operation: 

0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Grace Miller Vault 14.000 

 1 4 Kayla Rodriguez Vault 14.575 

 1 5 Lauren Davis Vault 14.275 

 1 6 Grace Miller Floor 13.975 

 1 7 Lauren Davis Floor 13.000 

 1 8 Grace Miller Balance beam 13.100 

 1 9 Daniel Smith Parallel bars 14.375 

 1 10 Lauren Davis Balance beam 15.225 

As we can see from comparing the result with those we just get, if selecting the Adjacent 

only for the distinct judgment, only one band of the same value will be kept. The distinct 

operation will not be applied on the nonadjacent bands. 

In the calculation cellset of esCalc08_7.gex, select A3, set it to Delete, and perform the 

distinct operation. The result will be as shown below: 

0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Daniel Smith Parallel bars 14.375 

As we can see from the above result, only the bands without duplicate values are kept. The 

bands with duplicate values are all removed.  

Reopen esCalc08_7.gex calculation cellset and select A3 to perform the distinct operation. 

Select the No action option and the Delete unique value option. Once the distinct action is 

performed, the result will be as shown below: 
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0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Grace Miller Vault 14.000 

 1 4 Kayla Rodriguez Vault 14.575 

 1 5 Kayla Rodriguez Uneven bars 14.675 

 1 6 Kayla Rodriguez Balance beam 13.975 

 1 7 Kayla Rodriguez Floor 14.400 

 1 8 Lauren Davis Vault 14.275 

 1 9 Grace Miller Floor 13.975 

 1 10 Grace Miller Uneven bars 12.875 

 1 11 Lauren Davis Floor 13.000 

 1 12 Grace Miller Balance beam 13.100 

 1 13 Lauren Davis Balance beam 15.225 

 1 14 Lauren Davis Uneven bars 14.275 

As we can see from the above result, the distinct action is opposite to actions we just 

performed. Only the bands without duplicate values are deleted. If selecting the Delete unique 

value option, all bands without duplicate will be removed when performing the distinct operation. 

You can also resort to this procedure when setting the merge or distinct operations. 

Reopen calculation cellset esCalc08_7.gex, select A3, and set the No action. Select the 

Delete unique value option, and the Adjacent only option for determining the duplicate value. 

Once the distinct operation is done, the result will be as shown below: 

0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Kayla Rodriguez Vault 14.575 

 1 4 Kayla Rodriguez Uneven bars 14.675 

 1 5 Kayla Rodriguez Balance beam 13.975 

 1 6 Kayla Rodriguez Floor 14.400 

 1 7 Grace Miller Floor 13.975 

 1 8 Grace Miller Uneven bars 12.875 

 1 9 Lauren Davis Balance beam 15.225 

 1 10 Lauren Davis Uneven bars 14.275 

 

As we can see from the result, if selecting Adjacent only option to determine the duplicate 

value, then all data without the adjacent bands of the same values will be deleted once the Delete 

unique value option is enabled. 

Open the calculation cellset esCalc08_8.gex again, and you will find the cellset below:  
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0 1 2  A B C D E 

1   1 States and Cities  

2-   2 State Abbr. City Population  

 1-  3 California CA   a 

  1 4   Los Angeles 3849368 1 

 1-  5 Texas TX   b 

  1 6   Houston 2144491 2 

  1 7   San Antonio 1296682 3 

 1-  8 California CA   c 

  1 9   San Diego 1256951 4 

  1 10   San Jose 929936 5 

 1-  11 Florida FL   d 

  1 12   Jacksonville 794555 6 

 1-  13 Texas TX   e 

  1 14   Austin 709893 7 

In this calculation cellset, there are some information of cities and states. In the column E, 

every record is marked so you can differentiate them from others easily. Then, let’s carry out the 

distinct operation based on the abbreviation of states. Select B3 and enable the Merge option to 

carry out the distinct operation. The result is as shown below: 

0 1 2  A B C D E 

1   1 States and Cities  

2-   2 State Abbr. City Population  

 1-  3 California CA   a 

  1 4   Los Angeles 3849368 1 

  1 5   San Diego 1256951 4 

  1 6   San Jose 929936 5 

 1-  7 Texas TX   b 

  1 8   Houston 2144491 2 

  1 9   San Antonio 1296682 3 

  1 10   Austin 709893 7 

 1-  11 Florida FL   d 

  1 12   Jacksonville 794555 6 

As we can see from the above result, when selecting Merge to carry out the distinct operation, 

the selected band will be similar to the distinct operation, and only one band is kept. However, if 

the band has got the sub bands, then the sub bands will be merged to the first band.   

8.5 Sort 

Sort the homobands under the parent band by their value. 

On the right-click menu, click Operation > Sort. 
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Let’s open the calculation cellset of esCalc08_7.gex again, and use the calculation cellset of 

results of sports items:   

0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Grace Miller Vault 14.000 

 1 4 Kayla Rodriguez Vault 14.575 

 1 5 Kayla Rodriguez Uneven bars 14.675 

 1 6 Kayla Rodriguez Balance beam 13.975 

 1 7 Kayla Rodriguez Floor 14.400 

 1 8 Lauren Davis Vault 14.275 

 1 9 Grace Miller Floor 13.975 

 1 10 Grace Miller Uneven bars 12.875 

 1 11 Lauren Davis Floor 13.000 

 1 12 Grace Miller Balance beam 13.100 

 1 13 Daniel Smith Parallel bars 14.375 

 1 14 Lauren Davis Balance beam 15.225 

 1 15 Lauren Davis Uneven bars 14.275 

Select A3 and carry out the sort action. The Sort panel will prompt:  

  
 

On the Sort operation panel, you can check if the selected cells are sorted in ascending order. 

If there are multiple sorting conditions, then you can use Up and Down to modify the priority of 

sorting conditions.  

  If the Use Locale is checked, data will be sorted by local language.   

If sorting by A3 in ascending order, then operational result is as shown below: 
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0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Daniel Smith Parallel bars 14.375 

 1 4 Grace Miller Vault 14.000 

 1 5 Grace Miller Floor 13.975 

 1 6 Grace Miller Uneven bars 12.875 

 1 7 Grace Miller Balance beam 13.100 

 1 8 Kayla Rodriguez Vault 14.575 

 1 9 Kayla Rodriguez Uneven bars 14.675 

 1 10 Kayla Rodriguez Balance beam 13.975 

 1 11 Kayla Rodriguez Floor 14.400 

 1 12 Lauren Davis Vault 14.275 

 1 13 Lauren Davis Floor 13.000 

 1 14 Lauren Davis Balance beam 15.225 

 1 15 Lauren Davis Uneven bars 14.275 

As we can see from the above result, all homorows of the row 3 have been sorted ascendingly 

by name in alphabetical order. When sorting, the result will be the same if selecting the 

corresponding cells in any homorow. 

For the sort operation, you can select multiple cells in a same band, and allow for setting the 

priority of cell by which to sort. In the initial calculation cellset esCalc08_7.gex, you can select 

both A15 and B15 to sort, and use the Up or Down arrow key to arrange the sort order to sort by 

B15 in descending order first, and then sort by A15 in ascending order. Once set, the Sort panel is 

as shown below: 

  
Once sorted, the results are as follows: 
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0 1  A B C 

1  1 Gymnastics Artistic Women's Individual All-Around Results 

2-  2 Name Event Score 

 1 3 Grace Miller Vault 14.000 

 1 4 Kayla Rodriguez Vault 14.575 

 1 5 Lauren Davis Vault 14.275 

 1 6 Grace Miller Uneven bars 12.875 

 1 7 Kayla Rodriguez Uneven bars 14.675 

 1 8 Lauren Davis Uneven bars 14.275 

 1 9 Daniel Smith Parallel bars 14.375 

 1 10 Grace Miller Floor 13.975 

 1 11 Kayla Rodriguez Floor 14.400 

 1 12 Lauren Davis Floor 13.000 

 1 13 Grace Miller Balance beam 13.100 

 1 14 Kayla Rodriguez Balance beam 13.975 

 1 15 Lauren Davis Balance beam 15.225 

As we can see from the above, all homorows of the row 3 are sorted by event in alphabetical 

order descendingly. For those rows with the same event, sort in alphabetical order by name 

ascendingly. 

To select multiple cells that may not in continuous positions, you can hold down Ctrl and 

select.  

Open the calculation cellset esCalc08_8.gex again: 

0 1 2  A B C D E 

1   1 States and Cities  

2-   2 State Abbr. City Population  

 1-  3 California CA   a 

  1 4   Los Angeles 3849368 1 

 1-  5 Texas TX   b 

  1 6   Houston 2144491 2 

  1 7   San Antonio 1296682 3 

 1-  8 California CA   c 

  1 9   San Diego 1256951 4 

  1 10   San Jose 929936 5 

 1-  11 Florida FL   d 

  1 12   Jacksonville 794555 6 

 1-  13 Texas TX   e 

  1 14   Austin 709893 7 

Select B3, and sort in ascending order. Then, the result is as shown below:  
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0 1 2  A B C D E 

1   1 States and Cities  

2-   2 State Abbr. City Population  

 1-  3 California CA   a 

  1 4   Los Angeles 3849368 1 

 1-  5 California CA   c 

  1 6   San Diego 1256951 4 

  1 7   San Jose 929936 5 

 1-  8 Florida FL   d 

  1 9   Jacksonville 794555 6 

 1-  10 Texas TX   b 

  1 11   Houston 2144491 2 

  1 12   San Antonio 1296682 3 

 1-  13 Texas TX   e 

  1 14   Austin 709893 7 

As we can see that the respective sub bands will move along with their parent row of the 

band if sorting the abbreviation of State names in ascending order. 

Open the calculation cellset esCalc08_9.gex, as shown in the below cellset: 

0 1 2  A B C D E 

1   1 States and Cities  

2-   2 State Abbr. City Population  

 1-  3 California CA   a 

  1 4   Los Angeles 3849368 1 

  1 5   San Diego 1256951 4 

  1 6   San Jose 929936 5 

 1-  7 Texas TX   b 

  1 8   Houston 2144491 2 

  1 9   San Antonio 1296682 3 

  1 10   Austin 709893 7 

 1-  11 Florida FL   d 

  1 12   Jacksonville 794555 6 

 

This is the resulting cellset after the state band merge in the distinct operation. In this cellset, 

select C4 and set the descending, execute the sort operation. The result is as shown below: 
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0 1 2  A B C D E 

1   1 States and Cities  

2-   2 State Abbr. City Population  

 1-  3 California CA   a 

  1 4   San Jose 929936 5 

  1 5   San Diego 1256951 4 

  1 6   Los Angeles 3849368 1 

 1-  7 Texas TX   b 

  1 8   San Antonio 1296682 3 

  1 9   Houston 2144491 2 

  1 10   Austin 709893 7 

 1-  11 Florida FL   d 

  1 12   Jacksonville 794555 6 

 

From the above, we can see that all homorows will be executed the action at the same time 

when sorting. The sorting will be only done within the original parent level which will not be 

changed. 

8.6 Group 

Specify a cell to be equal-grouped, and the master cell of newly-added group band will use 

this cell value. The work scope is set to the level 0. 

On the right-click menu, click Operation > Group to perform the grouping operation.  

Open the calculation cellset esCalc08_10.gex as shown below: 

0 1  A B C D 

1  1 Liquors  

2-  2 Liquor Type Origin  

 1 3 Appleton Estate Reserve Rum Jamaica  

 1 4 Coruba Royal Rum Jamaica  

 1 5 Malibu Coconut Rum England  

 1 6 Bombay Sapphire Gin England  

 1 7 Seagers Gin England  

 1 8 Kahlua Cordials Mexico  

 1 9 Chatelle Brandy Brandy France  

 1 10 Conjure Cognac Brandy France  

 1 11 Grand Marnier Cordon Rouge Cordials France  

 1 12 Baileys Irish Cream Cordials Ireland  

In the cellset, there is some liquor information, including the liquor name, type, and the place 

of production. We can group the information by type.  

Select B3 and group. The below operation panel will prompt:  
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In the Group operation panel, you can choose whether to sort before grouping and whether 

regroup. When checking Sort before Group, you can check Use Locale when sorting. 

Firstly, uncheck the Sort before group. Then, perform the group action, as shown below: 

0 1 2  A B C D 

1   1 Liquors  

2-   2 Liquor Type Origin  

 1-  3  Rum   

  1 4 Appleton Estate Reserve Rum Jamaica  

  1 5 Coruba Royal Rum Jamaica  

  1 6 Malibu Coconut Rum England  

 1-  7  Gin   

  1 8 Bombay Sapphire Gin England  

  1 9 Seagers Gin England  

 1-  10  Cordials   

  1 11 Kahlua Cordials Mexico  

 1-  12  Brandy   

  1 13 Chatelle Brandy Brandy France  

  1 14 Conjure Cognac Brandy France  

 1-  15  Cordials   

  1 16 Grand Marnier Cordon Rouge Cordials France  

  1 17 Baileys Irish Cream Cordials Ireland  

As we can see from the above result, every homoband is grouped according to specified cell 

value. The bands, of which the specified neighboring cell values are the same, are grouped into 

one group, and a grouping level is added. The rows at the grouping level are all the newly added 

rows. The Various properties in each cell are the original. In the grouping row, for those cells in 

the same column to the selected cell, the grouping value will be filled in one by one. This cell will 

be set as the master cell.  

Select the corresponding cells in any homocell to perform the grouping operation, and we 

will get the same result. 

In the original calculation cellset of esCalc08_10.gex, select the B3 and the Sort before 

group option. The result will be as shown below after the grouping operation:  
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0 1 2  A B C D 

1   1 Liquors  

2-   2 Liquor Type Origin  

 1-  3  Brandy   

  1 4 Chatelle Brandy Brandy France  

  1 5 Conjure Cognac Brandy France  

 1-  6  Cordials   

  1 7 Kahlua Cordials Mexico  

  1 8 Grand Marnier Cordon Rouge Cordials France  

  1 9 Baileys Irish Cream Cordials Ireland  

 1-  10  Gin   

  1 11 Bombay Sapphire Gin England  

  1 12 Seagers Gin England  

 1-  13  Rum   

  1 14 Appleton Estate Reserve Rum Jamaica  

  1 15 Coruba Royal Rum Jamaica  

  1 16 Malibu Coconut Rum England  

As we can see from the above result, once the sort before group is selected, every band will 

be sorted by the selected cell values before grouping, and then the grouping operation will be 

carried out. One thing to note is that the grouping this time is based on the original calculation 

cellset. 

Let’s modify the grouping row in the above cellset, as shown below: 
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0 1 2  A B C D 

1   1 Liquors  

2-   2 Liquor Type Origin  

 1-  3 Brandy Count 2  

  1 4 Chatelle Brandy Brandy France  

  1 5 Conjure Cognac Brandy France  

 1-  6 Cordials Count 3  

  1 7 Kahlua Cordials Mexico  

  1 8 Grand Marnier Cordon Rouge Cordials France  

  1 9 Baileys Irish Cream Cordials Ireland  

 1-  10 Gin Count 2  

  1 11 Bombay Sapphire Gin England  

  1 12 Seagers Gin England  

 1-  13 Rum Count 3  

  1 14 Appleton Estate Reserve Rum Jamaica  

  1 15 Coruba Royal Rum Jamaica  

  1 16 Malibu Coconut Rum England  

Change the master cell of each grouping row to A3 and its homocell, and add the formula 

=={B4}.count() to C3 to calculate the number of bands in each group. In B3 and its homocells, the 

constant string of Count has filled in.  

Then, select C4 and prepare to regroup by the place of production. To do so, select both Sort 

before group and Regroup options on the Group panel. The result will be as shown below after 

grouping: 
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0 1 2  A B C D 

1   1 Liquors  

2-   2 Liquor Type Origin  

 1-  3   3  

  1 4 Bombay Sapphire Gin England  

  1 5 Seagers Gin England  

  1 6 Malibu Coconut Rum England  

 1-  7   3  

  1 8 Chatelle Brandy Brandy France  

  1 9 Conjure Cognac Brandy France  

  1 10 Grand Marnier Cordon Rouge Cordials France  

 1-  11   1  

  1 12 Baileys Irish Cream Cordials Ireland  

 1-  13   2  

  1 14 Appleton Estate Reserve Rum Jamaica  

  1 15 Coruba Royal Rum Jamaica  

 1-  16   1  

  1 17 Kahlua Cordials Mexico  

As we can see from the result, all homobands of the band in which the selected cell is located 

have been regrouped even if their parent level is not in a same row. All bands are regrouped by 

place of production after sorting. One thing to note is that the properties of each cell, such as the 

foreground/background color, remain the same as the original parent level in the new parent row 

of the resulting cellset and the settings of the master cell is unchanged. In the new row at parent 

level, the formula in C3 is still kept. The formula in this cell and its homocells will still be used to 

calculate the number of bands in each group. In addition, in the new parent row, the values of all 

cells are emptied, and the cell value in the related calculation cell or the instant calculation cell 

will be calculated again. 

Please note that the grouping value of each group has not been set to the parent row when 

regrouping, which differs to the grouping introduced in previous sections. When regrouping, if the 

grouping value is set as what do when grouping directly, then the formula in C3 will be overridden 

by the grouping value and the properties of parent row will be destroyed in this case. In order to 

keep the properties and formulae at the former parent level, both the grouping value at the parent 

level and the settings of master cell in the former parent row will not be set automatically when 

regrouping. You may need to modify it manually. For the direct grouping, because the parent row 

is the newly-added row, the auto-set master row and the grouping value will not bring about the 

same problem. 

 

Let’s look into this problem: a company needs to arrange the employees to have an off day by 

turn in one week. The calculation cellset of esCalc08_11.gex provides the holiday record of each 

employee: 
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0 1  A B C D 

1  1 Off Day  

2-  2 Name Gender Off Day  

 1 3 Harry Potter Male Monday  

 1 4 Ronald Weasley Male Tuesday  

 1 5 Hermione Granger Female Thursday  

 1 6 Lord Voldemort Male Wednesday  

 1 7 Albus Dumbledore Male Wednesday  

 1 8 Ginevra Weasley Female Monday  

 1 9 Rubeus Hagrid Male Tuesday  

 1 10 Luna Lovegood Female Monday  

 1 11 Severus Snape Male Wednesday  

 1 12 Draco Malfoy Male Tuesday  

Then, group the employee data by off-day. Select C3 and enable the Sort before group 

option to group. The result is as shown below:  

0 1 2  A B C D 

1   1 Off Day  

2-   2 Name Gender Off Day  

 1-  3   Monday  

  1 4 Harry Potter Male Monday  

  1 5 Ginevra Weasley Female Monday  

  1 6 Luna Lovegood Female Monday  

 1-  7   Thursday  

  1 8 Hermione Granger Female Thursday  

 1-  9   Tuesday  

  1 10 Ronald Weasley Male Tuesday  

  1 11 Rubeus Hagrid Male Tuesday  

  1 12 Draco Malfoy Male Tuesday  

 1-  13   Wednesday  

  1 14 Lord Voldemort Male Wednesday  

  1 15 Albus Dumbledore Male Wednesday  

  1 16 Severus Snape Male Wednesday  

Then, what if sort by gender? Select B4 and check the Sort before group option to carry out 

the group operation. The result will be as shown below: 



 
 

112 

 

RAQSOFT 
Innovation Makes Progress http://www.raqsoft.com 

0 1 2 3  A B C D 

1    1 Off Day  

2-    2 Name Gender Off Day  

 1-   3   Monday  

  1-  4  Female   

   1 5 Ginevra Weasley Female Monday  

   1 6 Luna Lovegood Female Monday  

  1-  7  Male   

   1 8 Harry Potter Male Monday  

 1-   9   Thursday  

  1-  10  Female   

   1 11 Hermione Granger Female Thursday  

 1-   12   Tuesday  

  1-  13  Male   

   1 14 Ronald Weasley Male Tuesday  

   1 15 Rubeus Hagrid Male Tuesday  

   1 16 Draco Malfoy Male Tuesday  

 1-   17   Wednesday  

  1-  18  Male   

   1 19 Lord Voldemort Male Wednesday  

   1 20 Albus Dumbledore Male Wednesday  

   1 21 Severus Snape Male Wednesday  

As we can see from the result, for the homobands to be grouped, if they have already grouped 

under multiple parent rows, then they will be grouped again in every group when grouping. 

8.7 Align 

For a certain cell value, align according to the specified constant sequence. For the 

multi-level sequence, categorize according to the master cell value. 

On the right-click menu, click Operation –> Align to perform the align operation. The rough 

procedure is as follows: 

1) Select one of the cells to sort. On the right-click menu, select operation and align 

2) Select the existing alignment sequence or create a new align sequence 

3) Click OK to complete the alignment action 

As for the group by off-day example in the previous section, you may notice a problem: In 

the normal group and sort operations, because you can only sort on grouping field in alphabetical 

order, the resulting order of group will be Monday, Thursday, Tuesday, and Wednesday. This is 

not the desired order. To meet the need, the align operation is provided in esCalc for you to sort 

the bands by the specified order. 

Open the calculation cellset that is grouped at two levels in the Section 8.6 Group, or open 

the calculation cellset esCalc08_12.gex directly. Select C3 to perform the align operation, and the 
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align operation panel is as shown below: 

 

  

On the Align panel, you can set the align sequence, set the name for the align sequence, or 

get the used align sequence according to its name. In the align operation, you have 3 options: 

Align with sequence, Retain all bands, and Complete with sequence. When setting the align 

sequence at multiple levels, you can also choose to use the Bottom level of align sequence when 

perform the align action.  

At first, we will follow the default settings, and then choose the Align with sequence and 

Retain all band, and set the align sequence as [Monday,Tuesday,Wednesday], as shown below: 
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When defining the Align sequence, each member will take one row. After aligning, the results 

are as given below: 
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0 1 2 3  A B C D 

1    1 Off Day  

2-    2 Name Gender Off Day  

 1-   3   Monday  

  1-  4  Female   

   1 5 Ginevra Weasley Female Monday  

   1 6 Luna Lovegood Female Monday  

  1-  7  Male   

   1 8 Harry Potter Male Monday  

 1-   9   Tuesday  

  1-  10  Male   

   1 11 Ronald Weasley Male Tuesday  

   1 12 Rubeus Hagrid Male Tuesday  

   1 13 Draco Malfoy Male Tuesday  

 1-   14   Wednesday  

  1-  15  Male   

   1 16 Lord Voldemort Male Wednesday  

   1 17 Albus Dumbledore Male Wednesday  

   1 18 Severus Snape Male Wednesday  

 1-   19   Thursday  

  1-  20  Female   

   1 21 Hermione Granger Female Thursday  

Once it is set to sort by the align sequence, the band at the selected level will be sorted by the 

align sequence. The sub band will move along with the band to which it belongs. If selecting to 

Retain all band, if the selected cell value is not in the align sequence, the bands will placed at the 

tailing position. If selecting not to Retain all band, then these bands will be deleted.  

Let’s check the case of align sequence at multiple levels. Select B4 to perform align action, 

and define the align sequence to 

[Tuesday,Male],[Tuesday,Female],[Monday,Male],[Monday,Female]]. Select Align with 

sequence and Complete with sequence, as shown below: 
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When defining the multi-level align sequence, the settings of both levels are separated with 

Tab, and each member takes up one row. We give this align sequence the name AlignGroup. After 

sorting, the result is as follows: 

0 1 2 3  A B C D 

1    1 Off Day  

2-    2 Name Gender Off Day  

 1-   3   Tuesday  

  1-  4  Male   

   1 5 Ronald Weasley Male Tuesday  

   1 6 Rubeus Hagrid Male Tuesday  

    7 Draco Malfoy Male Tuesday  

  1-  8  Female   

   1 9     

 1-   10   Monday  

  1-  11  Male   

   1 12 Harry Potter Male Monday  

  1-  13  Female   

    14 Ginevra Weasley Female Monday  

    15 Luna Lovegood Female Monday  

As we can see from the result, the bands is undergone the multi-level-align sorting according 

to the settings in the align sequence. During the process of multi-level-align, the selected cell is 

corresponding to the last level in the align sequence. Its parent levels corresponds to the previous 

levels in the align sequence. At the parent level, the cell by which the align operation is performed 
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is the master cell of each parent level.  

In case that you have not selected to Retain all band, then the values of parent level and 

band whose current cells value is not within the align sequence will all be removed. Because 

you’ve selected the Complete with sequence option, the empty group Tuesday > Female is 

completed and a blank band is created in it. 

Reopen the calculation cellset esCalc08_11.gex as shown below: 

0 1  A B C D 

1  1 Off Day  

2-  2 Name Gender Off Day  

 1 3 Harry Potter Male Monday  

 1 4 Ronald Weasley Male Tuesday  

 1 5 Hermione Granger Female Thursday  

 1 6 Lord Voldemort Male Wednesday  

 1 7 Albus Dumbledore Male Wednesday  

 1 8 Ginevra Weasley Female Monday  

 1 9 Rubeus Hagrid Male Tuesday  

 1 10 Luna Lovegood Female Monday  

 1 11 Severus Snape Male Wednesday  

 1 12 Draco Malfoy Male Tuesday  

Select C3 to perform the align operation. In the drop-down list of align sequence name, you 

can select AlignGroup to used the stored sequence. Since this is a two-level sequence, and you 

only require the value of day of week at the first level of this sequence, you can set the lowest 

level of the align sequence to 1, and select the Align with Sequence option, as shown below:  

   

After performing the Align operation, the result is as follows: 
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0 1  A B C D 

1  1 Off Day  

2-  2 Name Gender Off Day  

 1 3 Ronald Weasley Male Tuesday  

 1 4 Rubeus Hagrid Male Tuesday  

 1 5 Draco Malfoy Male Tuesday  

 1 6 Harry Potter Male Monday  

 1 7 Ginevra Weasley Female Monday  

 1 8 Luna Lovegood Female Monday  

 1 9 Hermione Granger Female Thursday  

 1 10 Lord Voldemort Male Wednesday  

 1 11 Albus Dumbledore Male Wednesday  

 1 12 Severus Snape Male Wednesday  

The align operation is usually performed along with the grouping operation. Group the bands 

according to the specified order, and sort the grouped parent band according to the specified order. 

8.8 Join 

Join the values of several homocells with the target bands according to the values of the 

master cells, and fill into the specified cell area of target bands. The data will be categorized by 

the master cell value of their parent levels.   

On the right-click menu, click Operation > Join. The rough procedure is as follows: 

1) On the source cellset, select the cells in the continuous positions at the same level of the 

same band, and then copy. 

2) On the target cellset, select any cells from the row in which the master cell to join is 

located, and then join. 

In this way, the master cell, to which the selected cells from the source cellset correspond, will 

match and join with the master cell of selected cells in the target cellset. The data copied from the 

source cellset will be pasted one by one to the target cellset, starting from the selected target cell. 

In the procedure of joining, when matching and joining the master cell of selected cells, the 

master cells of their parent cells will be matched synchronously. In the work scope of the source 

cellset, the master cells of selected cells, together with master cells at all levels above (except for 

the level 0), will be retrieved automatically starting from the row in which the selected cell is 

located. Then, these master cells will be matched and joined with the master cells at every level of 

the target cellset. Therefore, when joining, the master cells of no matter the source or target cellset 

must be set for rows at all levels except for the level 0. For the target cellset, the involved join 

scope will depend on the number of levels in the work scope of the source cellset. Suppose if there 

are altogether n levels counting from the selected cells to the topmost in the work scope of source 

cellset, then for the target cellset, the joining will start in a range of parent rows at n levels above 

the selected target cells.  
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Let’s look into these two calculation cellsets. Of esCalc08_13.gex, there are some 

information about city and state, of which the master cell at each level is the abbreviation of city 

or state, as shown below: 

0 1 2  A B C D E 

1-   1 States and Cities  

 1-  2 CA California 37253956 Sacramento  

  1 3 Los Angeles 3849368    

  1 4 San Diego 1256951    

  1 5 San Jose 929936    

 1-  6 TX Texas 25145561 Austin  

  1 7 Houston 2144491    

  1 8 San Antonio 1296682    

  1 9 Austin 709893    

 1-  10 FL Florida 18801310 Tallahassee  

  1 11 Jacksonville 794555    

In calculation cellset of esCalc08_14.gex, there are some data about the tourist attractions in some 

states. The data are grouped by state with the abbreviations of states as the master cell, as shown 

below: 

0 1 2  A B C D 

1-   1 Tourist Attractions 

 1-  2 CA    

  1 3  Hollywood   

  1 4  Disneyland   

  1 5  Seaworld   

 1-  6 HI    

  1 7  Waikiki Beach   

  1 8  Hanauma Bay   

 1-  9 TX    

  1 10  Hermann Park   

  1 11  Mountain Bonnell   

Then, let’s take a look on the procedure of join operation. In this case, we are going to paste 

the state information from esCalc08_13.gex to the corresponding calculation cellset 

esCalc08_14.gex according to the abbreviation of state. 

Firstly, select the data to be copied in the esCalc08_13.gex, by selecting both B2 and C2 cells 

and holding down Ctrl+C, or selecting Copy on the right-click menu to copy the state name and 

the population data. Then, in the esCalc08_14.gex, select the cell C2 to join the data. The Join 

panel will prompt as shown below:  
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On the Join operation panel, you can choose the join mode of Left join or Full join. 

In this case, we choose the default Left join and perform the Join operation, the result is as 

follows: 

0 1 2  A B C D 

1-   1 Tourist Attractions 

 1-  2 CA  California 37253956 

  1 3  Hollywood   

  1 4  Disneyland   

  1 5  Seaworld   

 1-  6 HI    

  1 7  Waikiki Beach   

  1 8  Hanauma Bay   

 1-  9 TX  Texas 25145561 

  1 10  Hermann Park   

  1 11  Mountain Bonnell   

As we can see from the above result, through the join of the state abbreviations in the two 

calculation cellsets, the state data in the first cellset is copied to the second cellset. When pasting, 

it will start from the cell selected to join, and the copied cells will be pasted one by one. When 

pasting, in the target calculation cellset, the foreground color, background color, and other 

properties will not be changed. When selecting the left join, no paste operation will be done since 

the Florida state in the first cellset does not have any corresponding data in the second cellset. No 

corresponding state data can be obtained for the Hawaii state in the second cellset. 

 

The below procedure will redo the join operation. In the calculation cellset esCalc08_13.gex, 

select the cell B2, C2, and D2 at the same time. Press down the Ctrl+C or choose the Copy 

option on the right-click menu to copy the name, population, and capital information. Then, in 

the calculation cellset of esCalc08_14.gex, select the cell A2 to perform the join operation. On 

the Join panel, select the Full Join to perform the join. The result is as shown below:  
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0 1 2  A B C D 

1-   1 Tourist Attractions 

 1-  2 California 37253956 Sacramento  

  1 3  Hollywood   

  1 4  Disneyland   

  1 5  Seaworld   

 1-  6 HI    

  1 7  Waikiki Beach   

  1 8  Hanauma Bay   

 1-  9 Texas 25145561 Austin  

  1 10  Hermann Park   

  1 11  Mountain Bonnell   

 1-  12 Florida 18801310 Tallahassee  

  1 13     

As we can see from the result, when performing the join operation to paste the copied 

information join to the target cellset. The paste will start from the selected cell one by one, and 

even the former data in the master cell will be overwritten. For the full join, though the Florida 

State in the first cellset has no corresponding data in the second cellset, a blank band is appended 

to the corresponding bands for you to paste the state information. The Hawaii State in the second 

cellset is still unable to acquire the corresponding state information. 

Let’s have a look on the join at multiple levels. In the calculation cellset of esCalc08_15.gex, 

the tourist attractions has been grouped by the cities and states, taking the names of cities and 

states of the tourist attractions as the master cells at respective levels, as shown below: 
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0 1 2 3  A B C D 

1-    1 Tourist Attractions 

 1-   2 CA    

  1-  3 Los Angeles    

   1 4  Hollywood   

   1 5  Disneyland   

  1-  6 San Jose    

   1 7  Seaworld   

 1-   8 HI    

  1-  9 Honolulu    

   1 10  Waikiki Beach   

   1 11  Hanauma Bay   

 1-   12 TX    

  1-  13 Houston    

   1 14  Hermann Park   

  1-  15 Austin    

   1 16  Mountain Bonnell   

In this cellset, the tourist attractions have master cells at two levels of city and state. 

Therefore, cells to be copied must have the corresponding parent level for join. In the calculation 

cellset of esCalc08_13.gex, both A3 and B3 are selected to copy the name and population data of 

city. Then, in the calculation cellset of esCalc08_15.gex, select C3 and carry out the join operation. 

If selecting the Left Join option, then the result will be as shown below: 
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0 1 2 3  A B C D 

1-    1 Tourist Attractions 

 1-   2 CA    

  1-  3 Los Angeles  Los Angeles 3849368 

   1 4  Hollywood   

   1 5  Disneyland   

  1-  6 San Jose  San Jose 929936 

   1 7  Seaworld   

 1-   8 HI    

  1-  9 Honolulu    

   1 10  Waikiki Beach   

   1 11  Hanauma Bay   

 1-   12 TX    

  1-  13 Houston  Houston 2144491 

   1 14  Hermann Park   

  1-  15 Austin  Austin 709893 

   1 16  Mountain Bonnell   

As we can see from the above result, the copied state data are pasted to the specified position 

in the state band of tourist data cellset according to the corresponding city and state level. 

The result will be as shown below if it is of the full join that just performed: 
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0 1 2 3  A B C D 

1-    1 Tourist Attractions 

 1-   2 CA    

  1-  3 Los Angeles  Los Angeles 3849368 

   1 4  Hollywood   

   1 5  Disneyland   

  1-  6 San Jose  San Jose 929936 

   1 7  Seaworld   

  1-  8 San Diego  San Diego 1256951 

   1 9     

 1-   10 HI    

  1-  11 Honolulu    

   1 12  Waikiki Beach   

   1 13  Hanauma Bay   

 1-   14 TX    

  1-  15 Houston  Houston 2144491 

   1 16  Hermann Park   

  1-  17 Austin  Austin 709893 

   1 18  Mountain Bonnell   

  1-  19 San Antonio  San Antonio 1296682 

   1 20     

 1-   21 FL    

  1-  22 Jacksonville  Jacksonville 794555 

   1 23     

Similar to the join at the single level, for the full join, all city and state data from the first 

cellset will also be pasted. If no corresponding data in the target cellset, then a blank band will be 

added at the end of the corresponding parent row band. If there is no corresponding parent row, 

then the parent band will be created along with it. In the master row each level of the newly 

created band, the corresponding master cell value will be set.  

You can join different bands in a same cellset and the procedure is similar to operate on two 

cellsets.  

8.9 Union 

Select band, and copy it to the homostructure (include sub band) target band area. For the 

union, use the values of the master cells; for the categorization, use the master values of parent 

levels. 

You can click Operation > Union on the right-click menu to perform the union operation. 

The rough procedure is as follows: 

1) On the source cellset, select and copy the cells. The value of topmost master cell in the 

copy scope will be merged with the target cellset correspondingly. 
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2) On the target cellset, select any cells from the row in which the master cell to union is 

located, and then union. 

In the procedure of unioning, when matching and unioning the master cell of selected cells, 

the master cells of their parent cells will be matched synchronously. On the source cellset, starting 

from the row of selected cells at the topmost level in the copy scope, the master cells, together 

with master cells at all levels above (except for the level 0), will be retrieved automatically . Then, 

these master cells will be matched and unioned with the master cells at every level on the target 

cellset. Therefore, when unioning, the master cells of no matter the source or target cellset must be 

set for rows at all levels except for the level 0. For the target cellset, the involved union scope will 

depend on the number of levels in the work scope of the source cellset. Suppose if there are 

altogether n levels counting from the copied cell of source cellset, then for the target cellset, the 

union will start in a range of parent rows at n levels above the selected target cells.  

For example, let’s look into the information cellset of two states and cities below:  

The data of States and Cites 1 are stored in the calculation cellset esCalc08_16.gex, as shown 

below. The abbreviations of state and city name are the master cells at the respective levels: 

 

0 1 2  A B C D E 

1-   1 States and Cities 1  

 1-  2 CA California 37253956 Sacramento  

  1 3 Los Angeles 3849368    

  1 4 San Diego 1256951    

  1 5 San Jose 929936    

 1-  6 TX Texas 25145561 Austin  

  1 7 Houston 2144491    

  1 8 San Antonio 1296682    

  1 9 Austin 709893    

 1-  10 FL Florida 18801310 Tallahassee  

  1 11 Jacksonville 794555    

The data of States and Cities 2 are stored in the calculation cellset of esCalc08_17.gex, as 

shown below. In the below cellset, the abbreviations of states and the names of cities are the 

master cells: 
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0 1 2  A B C D E 

1   1 States and Cities 2  

2-   2 State Abbr. Population Area Capital 

 1-  3 Texas TX 25145561 268820 Austin 

  1 4  El Paso 609415   

  1 5  Dallas 1232940   

 1-  6 Illinois IL 12830632 54826 Springfield 

  1 7  Chicago 2873326   

 1-  8 California CA 37253956 163700 Sacramento 

  1 9  San Jose 929936   

  1 10  San Francisco 744041   

  1 11  San Diego 1256951   

Then, union the data of state from the first cellset and the data from the second cellset. To do 

so, in the calculation cellset of the states and cities 1, select any cell like B6 in the band row of 

state to copy. In the calculation cellset of states and cities 2, select any cell in the row of state band 

to union, for example E8. A Union panel will prompt as shown below: 

  

On the Union panel, you can select the union mode of Union all or just Union. 

Select the Union mode, and perform the union operation. In this mode, the duplicate state 

data will not appear. The result is as shown below:  



 
 

127 

 

RAQSOFT 
Innovation Makes Progress http://www.raqsoft.com 

0 1 2  A B C D E 

1   1 States and Cities 2  

2-   2 State Abbr. Population Area Capital 

 1-  3 Texas TX 25145561 268820 Austin 

  1 4  El Paso 609415   

  1 5  Dallas 1232940   

 1-  6 Illinois IL 12830632 54826 Springfield 

  1 7  Chicago 2873326   

 1-  8 California CA 37253956 163700 Sacramento 

  1 9  San Jose 929936   

  1 10  San Francisco 744041   

  1 11  San Diego 1256951   

 1-  12 FL Florida 18801310 Tallahassee  

  1 13 Jacksonville 794555    

As we can see from the result, the union operation in the Union mode will merge the state 

data from the cellset 1 to the cellset 2. The existing state bands in the cellset 2 will not be affected. 

For example, the city bands of state Texas have not been affected. As for the state band not in the 

cellset 2, they will be pasted to the target cellset along with the whole band at the ending position 

of the target band, such as the data of state Florida. When pasting, the properties of each cell will 

not be copied, and the cell value will be copied one by one according to its position with the 

existing appearance attributes of target cellset. When judging the existence of bands, esCalc will 

check the value of master cells, for example, to check if the state abbreviation of master cell in 

cellset 1 and cellset 2 is the same, although they are in the different columns.  

For the union operation, if B3 is copied in the first cellse, and Union All option is selected, 

then all bands behind the selected cell in the first cellset will be copied to the ending positions of 

target band in the second cellset. The result is as shown below: 
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0 1 2  A B C D E 

1   1 States and Cities 2  

2-   2 State Abbr. Population Area Capital 

 1-  3 Texas TX 25145561 268820 Austin 

  1 4  El Paso 609415   

  1 5  Dallas 1232940   

 1-  6 Illinois IL 12830632 54826 Springfield 

  1 7  Chicago 2873326   

 1-  8 California CA 37253956 163700 Sacramento 

  1 9  San Jose 929936   

  1 10  San Francisco 744041   

  1 11  San Diego 1256951   

 1-  12 CA California 37253956 Sacramento  

  1 13 Los Angeles 3849368    

  1 14 San Diego 1256951    

  1 15 San Jose 929936    

 1-  16 TX Texas 25145561 Austin  

  1 17 Houston 2144491    

  1 18 San Antonio 1296682    

  1 19 Austin 709893    

 1-  20 FL Florida 18801310 Tallahassee  

  1 21 Jacksonville 794555    

As we can see from the result, the Union all mode will copy the state information from 

cellset 1 directly to the end of target band. The whole band will be pasted to the target cellset. In 

the Union all mode, master cells are not required in the copied bands at the bottom level.  

What if copying the cities data from cellset 1, esCalc08_16.gex to the original cellset 2, 

esCalc08_17.gex? To do so, select and copy any cell in the cities band in the cellset 1, for example 

B7. Then, in the original cellset 2, select any cell in the cities band to union, for example A4. 

Select Union mode and click OK. The result will be as shown below: 
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0 1 2  A B C D E 

1   1 States and Cities 2  

2-   2 State Abbr. Population Area Capital 

 1-  3 Texas TX 25145561 268820 Austin 

  1 4  El Paso 609415   

  1 5  Dallas 1232940   

  1 6 Houston 2144491    

  1 7 San Antonio 1296682    

  1 8 Austin 709893    

 1-  9 Illinois IL 12830632 54826 Springfield 

  1 10  Chicago 2873326   

 1-  11 California CA 37253956 163700 Sacramento 

  1 12  San Jose 929936   

  1 13  San Francisco 744041   

  1 14  San Diego 1256951   

  1 15 Los Angeles 3849368    

 1-  16  FL    

  1 17 Jacksonville 794555    

 

From the above result, we can find that the multi-level union is carried out according to the 

data in the master cells at multiple levels. While in the new parent row, the data in the master cell 

is only populated. 

8.10 Annex 

Paste the continuous slave rows and descendent rows of a certain band to the cellset and 

ultimately become the new row at the level 0. 

On the right-click menu, click Operation > Annex to perform the annex operation. 

Reopen the calculation cellset esCalc03_1.gex. The below cellset will prompt: 
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0 1 2  A B C D E 

1-   1 Employee     

 1  2 Department Finance    

 2-  3 Female     

  1 4 Ashley Wilson NY 11000   

 3-  5 Male     

  1 6 Daniel Davis FL 10000   

 4  7 Count 2 Sum 21000  

 1  8 Department R&D    

 2  9 Female     

 3-  10 Male     

  1 11 Justin Smith TX 7000   

  1 12 Jacob Davis TX 16000   

 4  13 Count 2 Sum 23000  

2   14 Count 4 Sum 44000  

In a certain band, you can select the cells of a single slave row or multiple continuous slave 

rows, and perform the annex action. The data from the selected continuous slave rows and 

descendent rows will be added to the end of the row at level 0 in the report. If the level of the last 

row is 0, then keep the last row at level 0, and place the various rows added through the annex 

operation to the place just before the last row.  

For example, select the 3 cells from B3 to B5 to annex. In this case, the selected continuous 

slave rows are the row from row 3 to row 5. The data of these rows and their sub rows are the 

data from row 3, 4, 5, and 6. Once data is annexed, the result will be as shown below:  
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0 1 2  A B C D E 

1-   1 Employee     

 1  2 Department Finance    

 2-  3 Female     

  1 4 Ashley Wilson NY 11000   

 3-  5 Male     

  1 6 Daniel Davis FL 10000   

 4  7 Count 2 Sum 21000  

 1  8 Department R&D    

 2  9 Female     

 3-  10 Male     

  1 11 Justin Smith TX 7000   

  1 12 Jacob Davis TX 16000   

 4  13 Count 2 Sum 23000  

2-   14 Female     

 1  15 Ashley Wilson NY 11000   

3-   16 Male     

 1  17 Daniel Davis FL 10000   

4   18 Count 4 Sum 44000  

From the above, you will find that the last row of the former cellset is the row at the level 0. 

Therefore, every additional row is inserted before the last row, and annexed to the band at the 

level 0, the selected upmost level slave row will be copied as the new slave row at the level 0.  

8.11 Quick Data Operation 

In esCalc, in order to perform the similar data operation, a set of quick data operations are 

available on the right-click menu: 
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Of all these convenient and rapid data process operations, you can select the Filter, Hide, 

Show, Asc, Desc, Group, or Group without sort to perform the corresponding operations.  

When selecting the prompt data operation, the settings of similar operations last time will be 

adopted: the settings of previous locating will still apply to the locating this time, the settings of 

previous filtering will still apply to the filtering, hiding, and show this time, and the settings of 

previous grouping will still apply to the grouping this time. If selecting to sort in ascending or 

descending order in the prompt data operation, then the current cell will be sorted ascendingly or 

descendingly.  

9. Register and Encrypt 

9.1 esCalc registration 

The default installer is esCalc Free edition. If you want to run other versions of esCalc, you 

will need to set the registration code. Please visit the official website for details of the difference 

between versions and how to acquire the registration code. 

Once received the registration code, you can register with the esCalc through the below 

procedure: 

1) Click the Registration button on the Help menu to open the program option dialog.  
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2) After entering the registration code, click the Scan button to validate it. If correct, then 

you can click Register to register with esCalc. 

Similarly, you can scan the registration information and register if the registration code box is 

empty, and you will register with the Free version. 

9.2 Cellset Description 

In esCalc, you can set the cellset description in the cellset file. 

On the Tool option of menu bar, click the Cellset description button. A cellset description 

window will appear. You can view or set the cellset description in this window. 

9.3 File Encryption 

9.3.1 Authority 

To prevent the unauthorized view or access to the cellset file, esCalc develops the cellset 

encryption. As given below, permissions of 4 levels are set for the encryption: 

View: This is the lowest level access to esCalc. With the access at this level, you can view the 

cellset description, but you are not allowed to modify these information. With the View access, 

you can carry out the cellset calculation to view the result of each cell, and the representation style 

of each cell. However, you are not allowed to view any properties in the cell. 

Fill in: This is the relatively low level access to esCalc. Besides the view access, you can also 

change or remove the cell value. 

Edit: This is the relatively high level access to esCalc. Besides the fill in access, you can also 

carry out various operations on the bands in the cellset, but you are not allowed to change the 

structure of band and the cell property. 

Full control: This is the right at the highest level in esCalc. You can carry out any actions on 

the cellset file. 

9.3.2 Set password 

Among the Tool options on the menu bar, click the Cellset password button. The Cellset 

Registration code here 
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Password window will prompt:  

 
Once granted with a certain access, you are only allowed to modify the cellset password for 

the user with a lower-level access. Click the button of the corresponding access to set the 

password of this access in the password setting window. 

 

Before you can change the password for a certain level access, you must nullify this 

password, and then set the new password. When canceling the password, you will have to input 

the password with the corresponding access is set correctly.  

9.3.3 Validation 

When the users have been granted the access to fill or edit, they can edit the cell value. To 

avoid inputting the invalid data, you can set the validation expression in the cell. For any invalid 

cell value entry, a corresponding text prompt will appear. 

Open the calculation cellset esCalc09_1.gex. We will get the cellset as shown below: 

0 1  A B C D E 

1  1 Students 

2-  2 Name Gender Age   

 1 3 Tom Male 12   

 1 4 Jerry Male 14   

In C3, enter the if(@>20,"Too old!",@<6,"Too young!") as the validation property. Then, the 

error message will prompt if the cell value in C3 and its homocells is greater than 20 or less than 

6. 

Reopen the calculation cellset file with edit access, and change the age to 26 in C3. The 

below error message will appear: 
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Click OK, and you will return to C3 to re-edit the cell value as required. 

One thing to note is that the validation does not work if you have the full control permission. 

9.4 User Right Description 

 Free 

For the users with free Edition, esCalc needs to be connected to the official Website while 

starting, and the data in the cellset cannot be printed. 

 Standard 

It is valid for ever. The user of the standard edition will have the right to perform the normal 

operations. 

 

10. Advanced Application of Sequence 

10.1 Sequence and Member 

 ifa(x) 

Verify if x is a sequence. 

 A.len() 

The number of members in the sequence A is the Sequence Length of A. 

 Blank sequence, n sequence 

The blank sequence is the sequence with a length of 0. The n sequence is the sequence with 

a length of n. 

 Unique member sequence and Pure Sequence 

The sequence without any duplicate member is the Unique member sequence by name; The 

Pure Sequence is a sequence whose members are of the same data type.. 

 A(i) 

Get the i
th

 member of sequence A. Please note that the expression to get member is A(i) but 

not A[i] in esCalc. 

 

 

 

 

Once the expression in the cell is calculated, the value of cell A2 is 3, and that of B2 is 2. 

 A B C D E 

1 [1,2,3]     

2 =A1.len() =A1(2)    
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 A(i)=x 

Assign value to the i
th

 member in the sequence A. 

 A B C D E 

1 [1,2,3]     

2 =A1(2)=5     

Once calculated, the cell value of A2 is 5, and the cell value of A1 will become [1,5,3]. 

 A.p(i) 

If i>0, then return the sequence number of the member i in A; If i<0, then return the sequence 

number of the i
th

 member from the bottom. If exceeding the boundary, then return the sequence 

number of 0. 

 A B C D E 

1 [a,b,c,d,e]     

2 =A1.p(3) =A1.p(-2) =A1.p(10)   

Once calculated, the cell value of A2 is 3, the cell value of B2 is 4, the cell value of C2 is 0. 

 A.m(i) 

If i>0, then return the i
th

 member of A; If i<0, then return the i
th

 member from the bottom. If 

exceeding the boundary, then return null. 

 A B C D E 

1 [a,b,c,d,e]     

2 =A1.m(3) =A1.m(-2) =A1.m(10)   

After calculating, the cell value of A2 is c, the cell value of B2 is d, and the cell value of C2 

is null. 

10.2 ISeq 

The ISeq is the sequence whose members are all integers. In esCalc, the to function is often 

used to define a continuous ascending or descending ISeq.  

10.2.1 Concept related to ISeq 

 nReplacement 

If the {n}ISeq is not only the n-sequence but also the unique member sequence, that is, 

composed of 1,2,…,n these n numbers. The ISeq without a certain order is called n-replacement. 

– The ISeq of [1,4,3,2,5], [1,2,3,4,5], and [5,4,3,2,1] can all 5-Replacement 

10.2.2 to function 

 to(a,b) 

Generate an ISeq that is composed of all integers starting from the integer a to b, including a 

and b itself, and both a>b and a<b are acceptable. 

 to(n) 

The shorten form of to(1,n). 
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 A B C D E 

1 =to(3,5) =to(5,2) =to(4)   

After calculating, the cell value of A1 is the sequence [3,4,5], the cell value of B1 is the 

sequence [5,4,3,2], and the cell value of C1 is the sequence [1,2,3,4]. 

 A. to(a,b) 

In the sequence A, the sequence composed of the members from the a
th

 to the b
th

, that is, the 

short form of A(to(a, b)). If a is omitted, then the default value is 1; If b is omitted, then the default 

value is A. len(), note that the comma cannot be omitted here at this time. 

 A.to(a) 

A sequence is made up by the members in Sequence A from the first to a
th

, which is 

equivalent to A.to(1, a ). 

 A B C D E 

1 =to(10).to(3)     

2 [a,b,c,d,e]     

3 =A2.to(-3)     

After calculating, the cell value of A1 is the sequence [1,2,3], and the cell value of A3 is the 

sequence [c,d,e]. 

10.3 Sub Sequence 

The sequence consisted of members of sequence A is the Sub-sequence of A by definition. 

10.3.1 Generate sub sequence with function 

 A(p) 

[A(p(1)),A(p(2)),…], use the location ISeq p to obtain the sub sequence of A. 

 A.p(p) 

[A(p(1)),A(p(2)),…], get the actual position of position ISeq p in A. The negative value is 

allowed in p. 

 A.m(p) 

A(A.p(p)), which use the location ISeq p to obtain the sub sequence of A. p may have 

negative number. 

 A.dup() 

A(to(A.len())), that is, duplicate the sequence A. 

 A.rvs() 

A(to(A.len(),1)), that is, reverse the sequence A. 

 A.step(m,k) 

A([k,k+m,k+2*m,…]), that is, return the subsequence of A whose location ISeq is started from 

k, and the step value m. 
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 A B C D E 

1 [a,b,c,d,e] [1,2,3,3] [1,2,-2,8]   

2 =A1(B1) =A1.p(C1) =A1.m(C1) =A1.dup() =A1.rvs() 

In A2, the expression takes ISeq B1 as the sequence number to generate the subsequence of 

sequence A1, and the resulting cell value is ["a","b","c","c"]; In B2, the expression uses the ISeq 

C1 to get the actual sequence number of sequence A1, with 0 to indicate the out-of-limit, and the 

resulting cell value is [1,2,4,0]; In C2, the expression uses ISeq C1 to retrieve the subsequence of 

ISeq A1, with the null member to indicate the sequence number out-of-limit, and the resulting cell 

value is ["a","b","d",null]; In D2, the expression copies the sequence A1, and the resulting cell 

value is the same to that of A1; In E2, the expression gets a sequence by reversing the members of 

sequence A1, and the resulting cell value is ["e","d","c","b","a"]. 

10.3.2 Options in A.p(p) and A.m(p) 

In the A.p(p) and A.m(p), you can use option @r and @0. With the @r option enabled, the 

turn-around and cyclical retrieval will be carried out when retrieving the member or actual number 

for the sequence number out-of-bounds in the ISeq. With the @0 option enabled, the out-of-bound 

sequence number of the ISeq will be ignored. The 0 or null value will not appear in the sequence 

of result. 

 A B C D E 

1 [a,b,c,d,e] [1,2,-2,8]    

2 =A1.p@r(B1) =A1.m@r(B1) =A1.p@0(B1) =A1.m@0(B1)  

In A2, the expression uses the ISeq B1 to retrieve the actual sequence number of sequence A1, 

with @r option enabled, the sequence number out-of-bounds will be cycled to retrieve, and the 

resulting cell value is [1,2,4,3]; In B2, the expression uses the ISeq B1 to get the subsequence of 

sequence A1, with @r enabled, the sequence number out of bounds will be cycled to retrieve, and 

the resulting cell value is ["a","b","d","c"]; In C2, the expression uses the ISeq B1 to retrieve the 

actual sequence number in the sequence A1, with @0 option enabled, the sequence number 

out-of-bounds will not appear, and the resulting cell value is [1,2,4] in which there is no 0 

regarding the 8 is out of bound; In D2, the expression uses ISeq B1 to retrieve the subsequence of 

sequence A1, with option @0 enabled, the null will not appear if the sequence number is 

out-of-bounds, and resulting cell value is ["a","b","d"] in which there is no null regarding the 8 as 

the sequence number is out of bound. 

10.4 Sequence and Character String 

With the s.array() and the A.string() functions, the sequence and character string can be 

converted to each other conveniently. 

 s.array(d) 

Split the string s into sequence with d as the delimiter, and recognize the data type 

automatically; d is the comma by default. 

 A.string(d) 

Concatenate the sequence A into a character string with the delimiter d, and process the data 

type automatically. By default, the d is comma. 
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 A B C D E 

1 a,1,c,2011-8-11,false    

2 =A1.array() =A2.string()    

The expression in A2 uses the comma to delimit the string, and split it into a sequence. Each 

member in the sequence will be recognized as the corresponding data type, and the resulting cell 

value is a sequence ["a",1,"c",2011-8-11,false]; In B2, the expression concatenate the sequences 

in A2 into a string. The elemental string in the sequence will be quoted, and the resulting cell 

value is "a",1,"c",2011-8-11,false. 

10.5 Basic Calculations on Sequence 

10.5.1 Binary calculation of sequence  

 A|B 

Sequence of concatenate set; Simply speaking, it is to join two sequence, in which the 

member of B will be added behind the member A. If either A or B or both of them are individual 

values instead of sequence, then it will be processed as a 1-sequence.  

 A&B 

Sequence of union of set; Get a new sequence in which the members of A are appended with 

the members from B with no duplicate. If any members from B already exist in A, then they will 

be removed. If either of A and B or both of them are individual values instead of sequence, then 

they will be processed as a 1-sequence. 

 A^B 

Sequence of intersection of sets between A and B. A sequence composed of members that 

appear in both A and B and constructed by getting these members from A one by one. 

 A\B 

Sequence of difference set, members appear in A but not in B 

 k*A 

A|A|…|A; Gather k of A to construct a sequence of sum set, that is, copy A for k times. In 

expression, the position of k and A is exchangeable.  

 A B C D E 

1 [a,b,1,2,3,4] [d,b,10,12,4,3]    

2 =A1|B1 =A1&B1 =A1^B1 =A1\B1  

3 =2*A1 =[1]*8    

In A2, the expression is to calculate the sum set of sequence A1 and B1, and the resulting cell 

value is the sequence ["a","b",1,2,3,4,"d","b",10,12,4,3]. As we can see, the members of A1 and 

B1 are concatenated together.  

In B2, the expression is to calculate the union set of sequence A1 and B1, and the resulting 

cell value is the sequence ["a","b",1,2,3,4,"d",10,12]. As we can see, no duplicate member will 

appear in the result. 

In C2, the expression is to calculate the set of intersection of sequence A1 and B1, and the 

resulting cell value is the sequence ["b",3,4]. 
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In D2, the expression is to calculate the difference set of sequence A1 and B1, and the 

resulting cell value is the sequence ["a",1,2]. 

In A3, the expression is to calculate the result of multiplying sequence A1 by the integer 2, 

that is, copy A2 twice. The resulting cell value is the sequence ["a","b",1,2,3,4,"a","b",1,2,3,4]. 

In B3, the expression is to result of multiplying sequence [1] with integer 8, and the resulting 

value is a sequence composed of 1 totaling 8: [1,1,1,1,1,1,1,1]. 

10.5.2 Align computation of sequence 

For the two sequence composed of numbers with the same length, you can perform the align 

calculation by member, and return the sequence.  

 A++B 

[A(1)+B(1),A(2)+B(2),…] 

 A--B 

[A(1)-B(1),A(2)-B(2),…] 

 A**B 

[A(1)*B(1),A(2)*B(2),…] 

 A//B 

[A(1)/B(1),A(2)/B(2),…] 

 A%%B 

[A(1)%B(1),A(2)%B(2),…], this % is the MOD calculation.  

 A\\B 

[A(1)\B(1),A(2)\B(2),…], this \ is the Integer division calculation. 

 

 A B C D E F 

1 [1,2,3] [4,1,2]     

2 =A1++B1 =A1--B1 =A1**B1 =A1//B1 =A1%%B1 =A1\\B1 

In A2, the expression is to perform the align adding on the ISeq A1 and B1. The resulting cell 

value is the ISeq [5,3,5]. 

In B2, the expression is to perform the align subtraction on the ISeq A1 and B1. The resulting 

cell value is the ISeq[-3,1,1]. 

In C2, the expression is to perform the align multiplying on the ISeq A1 and B1. The 

resulting cell value is ISeq [4,2,6]. 

In D2, the expression is to perform the align division on the ISeq A1 and B1, and the 

resulting cell value is the sequence [0.25,2,1.5]. Please note that the sequence whose members are 

all real numbers is not the ISeq. The ISeq is the sequence whose members are all integers. 

In E2, the expression is to perform the align modulo on the ISeq A1 and B1, and the resulting 

cell value is ISeq [1,0,1]. 

In F2, the expression is to perform the align integer division on the ISeq A1 and B1, and the 

resulting cell value is ISeq [0,2,1]. 

10.5.3 Compare the sequence  

Use the function cmp(x,y) to compare the results of computing the expression x and y,and use 
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the function cmp(A,B) to compare the sequence A and B. 

 cmp(x,y) 

Compare the results of x with y: if x>y, then return 1; if x<y, then return -1; if x=y, then return 

0. Error will be reported if you cannot compare x with y. 

 A B C D E 

1 =cmp("Alex","Allen") =cmp(0.4*3,1) =cmp(2+4,6)  

2 /=cmp("abc",15) /=cmp(15,"abc")  

In A1, the expression is intended to compare two strings. According to the ASCII code of 

letters, compare it one by one. Because "Alex"<"Allen", the calculated cell value is -1. 

In C1, the expression is intended to compare two numbers. Because 1.2>1, the calculated cell 

value is 1. 

In D1, the expression is intended to compare the two numbers. Because 6==6, the calculated 

cell value is 0. 

Finally, check the expressions in the A2 and C2. Because the string cannot be compared with 

the integer, error will be reported. 

 cmp(A,B) 

The sequence comparison is to perform the align comparison on the value of each member. 

When encountering the first non-equal member, return 1 or -1 respectively for A greater or less 

than B, and return 0 if A is identically equal to B. 

 A B C D E 

1 =cmp(["a","b","c"],["a","b","c"])   

2 =cmp([1,3,5,7],[1,3,7,5])   

3 =cmp([7,6,5,4],[7,6,4,10,11])   

When calculating, the cell value 0 of A1 indicates the two sequences are equal; the cell value 

-1 of A2 indicates the first sequence is relatively small; the cell value 1 of A3 indicates the first 

sequence is relatively great. 

 

This is similar to the normal value comparison. For the two sequence A and B, you can put 

them in the below shorten form according to the result of cmp(A,B): 

 A>B   cmp(A,B)>0 

 A<B   cmp(A,B)<0 

 A==B   cmp(A,B)==0  

 A!=B   cmp(A,B)!=0 

 A>=B   cmp(A,B)>=0 

 A<=B   cmp(A,B)<=0 

10.5.4 Converge calculation of sequence 

In esCalc, for the n sequence A, you can use function to carry out various converging 

calculation. 

 A.count() 

Calculate the number of non-null members in A, which differs to A.len(). 
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 A.ifn() 

Get the first non-null member in A. 

 A.sum() 

Calculate the sum of all members in A. 

 A.avg() 

Calculate the average of members in A, and the member of null value will be ignored when 

calculating. 

 A B C D E 

1 [null,4,6,,2,4,,5]    

2 =A1.count() =A1.len() =A1.ifn() =A1.sum() =A1.avg() 

In A2, the expression is to calculate the number of non-null members of sequence A1, and the 

resulting cell value is 5. Please note that the len() is a different thing.  

In B2, the expression is to calculate the number of all members of sequence A1, and the 

resulting cell value is 8. 

In C2, the expression is to return the first non-null member of sequence A1, and the resulting 

cell value is 4. 

In D2, the expression is to calculate the sum of members in the sequence A1, and the 

resulting cell value is 21. 

In E2, the expression is to calculate the average of members in the sequence A1, and the 

resulting cell value is 4.2. As we can see, the avg function will not take the null value of 

sequence into account when calculating the average of sequence. 

 A.min() 

Calculate the minimum. 

 A.max() 

Calculate the maximum. 

 A.variance() 

Calculate the variance. To calculate the variance, the member of null value will not be 

counted. 

 A.ranki(y) 

Calculate the value ranking of y in a sequence. The y is not required to be the value of 

member in the sequence.   

 A.rank() 

Calculate the ranking of each member in the sequence.  

 A B C D E 

1 [null,4,6,,2,4,,5]    

2 =A1.min() =A1.max() =A1.variance() =A1.ranki(4.5) =A1.rank() 

In A2, the expression is intended to calculate the minimum value in the sequence A1, and the 

resulting value is 2. 

In B2, the expression is intended to calculate the maximum value in the sequence A1, and the 
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resulting value is 6. 

In C2, the expression is intended to calculate the variance of the sequence A1, and the 

resulting value is 1.76. 

In D2, the expression is intended to calculate the ranking of 4.5 among the members of the 

sequence A1. The 4.5 is not necessarily in the sequence and the resulting cell value is 3. 

In E2, the expression is intended to calculate the sequence of rankings in the sequence A1, 

and the resulting cell value is the sequence [6,3,1,6,5,3,6,2]. 

 A.conj() 

Calculate the sum sequence of all members of sequence A. If a certain member of A is not the 

sequence, then it will not be processed as the 1-sequence. 

 A.union() 

Calculate the union sequence of all members in the sequence A. If any member in A is not a 

sequence, then take it as 1-sequence to process. (This is similar to the UNION operator in 

SQL, and no duplicate will appear in the resulting sequence.) 

 A.diff() 

Perform the difference sequence calculation on the member of sequence A one by one. If the 

member in A is not sequence, then it will be processed as 1-sequence. 

 A.isect() 

Calculate the intersection sequence of all members in the sequence A. If any member in the A 

is not a sequence, then it will be treated as the 1-sequence. 

 A B C D E 

1 [[1,2,3],3,[3,4],[5,6,3]]    

2 =A1.conj() =A1.union() =A1.diff() =A1.isect()  

In A2, the expression is intended to calculate the concatenation of A1, and the resulting cell 

value is the sequence [1,2,3,3,3,4,5,6,3]. 

In B2, the expression is intended to calculate the union of sequence A1, and the resulting cell 

value is the sequence [1,2,3,4,5,6]. The union results are equal to the procedure of performing 

distinct operation after the concatenation. 

In C2, the expression is intended to calculate the difference set of members in the sequence 

A1, and the resulting cell value is the sequence [1,2]. 

In D2, the expression is intended to calculate the intersection of set of members in the 

sequence A1, and the resulting cell value is the sequence [3]. 

 

10.6 Loop 

10.6.1 Convention on the expression in the sequence loop 

The sequence member can be referenced as the Loop function parameter, and the convention 

rule is: 

 ~ 

The current sequence member 

 A.# 
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Sequence number of the current member 

– A.sum(~*~)     Calculate the sum of squares of members in A. 

– A.max(if(A.#%2==0,~,0))  Seek the maximum of members in the even number 

positions. 

10.6.2 Loop function of sequence 

The function to carry out calculation on each member of sequence is the loop function by 

name, and the general form is A.f(…), for example, the function like A.sum() in the Section 

10.5.4 Converge Computation of Sequence. In fact, converge function of sequence is also a type 

of loop function.  

The calculation behavior of loop function can be determined by the function name, such as 

sum represents sum up, avg represents the average, and so on. 

 A.count(x) 

Return the number of x-condition-satisfied members in A  

– A.count(~>5)    Number of members greater than 5 

 A B C D E 

1 [1,3,5,null,7]    

2 =A1.count() =A1.sum(~*~) =A1.count(~>2)  

In A2, the expression is to calculate the number of non-null members in the sequence A1, and 

the resulting cell value is 4. 

In B2, the expression is to calculate the sum of squares of members in the sequence A1, and 

the resulting cell value is 84. 

In C2, the expression is to calculate the number of members greater than 2 in the sequence 

A1, and the resulting cell value is 3. 

Return the related sequence: 

 A.(x) 

Return a sequence that is constructed after calculating the expression x against each member 

of A 

 A B C D E 

1 [1,3,5,null,7]    

2 =A1.(A1.#) =A1.(~*~) =A1.(A1.##)   

In A2, the expression is to calculate the sequence composed of the sequence number of each 

member in the sequence A1, and the resulting cell value is the sequence [1,2,3,4,5]. 

In B2, the expression is to calculate the sequence composed of the square of each member in 

the sequence A1, and the resulting cell value is the sequence [1,9,25,null,49]. 

In C2, the expression is to calculate the length of sequence against every member in the 

sequence A1 and construct a sequence. The resulting cell value is the sequence [5,5,5,5,5]. As we 

can see from the result, A.## represent the length of sequence of A, in which the null members are 

taken into account.  

Integer loop: 

 n.f(x) 

The abbreviated form of to(n).f(x). 
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 A B C D E 

1 =10.sum() =10.avg() =5.(2*~-1)   

In A1, the expression sum from 1 to 10, and the resulting cell value is 55. 

In B1, the expression calculates the average from 1 to 10, and the resulting cell value is 4.5. 

In C1, the expression calculates the ISeq composed of the first 5 odd numbers, and the 

resulting cell value is the sequence [1,3,5,7,9]. 
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